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1.1. Introduction  

Strata�Foto�3D�is�an�efficient,�cost�effective�system�for�modeling�real�
world�objects.��Powered�by�3DSOM�s�patented�model�generation�and�
sophisticated�texturing�technology,�Foto�3D�allows�a�3D�model�to�be�
created�quickly�and�inexpensively�while�requiring�far�less�technical�skill�
or�expensive�hardware�than�similar�systems.��Working�seamlessly�with�
the�Strata�family�of�3D�products,�Foto�3D�creates�models�that�can�be�
displayed�and�used�in�a�variety�of�applications�ranging�from�online�
product�catalogs�to�3D�computer�games.��When�used�in�conjunction�with�
modeling�software�like�Strata�3D�CX,�Strata�Foto�3D�also�allows�virtual�
enhancements�to�existing�products�to�be�prototyped�quickly�and�easily.���
Creating�a�new�Foto�3D�model�involves�following�a�simple�workflow:��

1. Photograph  

� Print�and�mount�the�specially�designed�calibration�mat.��
� Place�an�object�on�a�pedestal�that�is�positioned�on�the�mat.�
� Set�in�front�of�a�plain�color�background�and�under�even�lighting.�
� Use�a�digital�camera,�preferably�mounted�on�a�tripod,�to�take�

pictures�of�the�object.��The�object�and�mat�are�turned�as�a�unit�and�
about�20�photographs�are�taken�from�various�angles.�

� Upload�the�photos�to�a�folder�in�your�computer.�
� Load�the�images�into�a�new�Foto�3D�project.�
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2. Mask

� In�each�photo,�the�silhouette�of�the�object�is�determined�by�a�
process�called�masking.��Auto�masking�wizards�and�tools�help�
separate�the�object�from�it�s�background.�

3. Model

� The�silhouettes�are�combined�to�generate�a�3D�model�
automatically�within�a�few�minutes.�

� The�model�can�be�simplified�and�made�more�compact�by�a�
process�called�decimation.��

� The�model�can�be�smoothed�using�a�tool�that�detects�hard�edges�
and�rounds�off�the�faces�between�those�edges�while�still�adhering�
to�the�shape�required�by�the�silhouettes.�

4. Texture

� The�photos�are�then�used�to�automatically�paint�the�surface�of�the�
model�with�a�U�V�mapped�baked�on�texture.�

� Several�tools�help�to�ensure�the�texture�is�seamless�and�allow�it�to�
be�changed�with�an�image�editor.�

5. Display

� The�final�model�can�be�saved�and�exported�for�display�in�a�
VRML�enabled�web�browser�that�will�rotate�the�object�and�zoom�
in�on�the�object’s�details.�

� The�model�can�also�be�imported�into�a�3D�editing�and�rendering�
software�such�as�Strata�3D�CX�for�further�enhancement�and�for�it�
to�be�used�in�scenes�and�renders.�

� Finally,�the�model�can�be�imported�into�Strata�Live�3D�for�
interactive�3D�display�either�with�a�sophisticated�Java�viewer�or�
within�PDF�documents�such�as�in�a�product�catalog.��(Displayed�
using�Adobe�s�free�Acrobat�Reader�without�a�plug�in.)�
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About this User Guide
This�User�Guide�is�laid�out�to�enhance�your�ability�to�learn�the�software�
quickly.��Foto�3D�provides�some�extremely�powerful�tools�for�modeling�
real�life�objects,�but�to�understand�how�to�use�them�well�requires�a�basic�
knowledge�of�the�entire�Foto�3D�workflow.��This�manual�has�three�parts:��

Part 1 - Getting Started  
Installing�and�getting�acquainted�with�the�software.���
� Chapter�1�will�help�you�get�the�software�loaded�and�launched.�
� Chapter�2�is�a�quick�tutorial�to�take�you�through�the�steps�of�building�

a�simple�model�using�the�automated�wizards.�

Part 2 - The Tools and Basic Workflow  
Touring�the�workspace,�explanation�of�each�tool�and�control,�and�how�to�
use�the�Wizards�that�initiate�each�of�the�three�stages�of�the�Workflow.���
� Chapter�3�gives�you�a�tour�of�the�Workspace,�followed�by�a�detailed�

explanation�of�the�menu�items�and�buttons�found�on�the�screen.�
� Chapter�4�helps�you�setup�to�photograph�your�own�objects,�

explaining�what�the�software�requires�to�be�able�to�successfully�create�
a�model�from�your�photos.�

� Chapter�5�takes�you�through�the�three�stages�of�the�workflow�used�
for�every�model���masking�images,�generating�the�wireframe�and�
texturing�the�surface.�

Part 3 - Advanced Techniques
Advanced�tools�and�techniques�for�each�stage�of�the�workflow.���
� Chapter�6�provides�recommendations�for�photographers�about�how�

to�optimize�a�photo�studio�setup�for�use�with�Foto�3D.�
� Chapter�7�describes�the�advanced�tools�for�editing�and�improving�the�

masks�and�the�wireframe�model�produced�by�those�Wizards.�
� Chapter�8�describes�the�advanced�tools�for�editing�and�improving�the�

surface�texture�produced�by�that�Wizard.�
� Chapter�9�has�suggestions�for�display,�use�and�rendering�of�the�

� finished�Foto�3D�model.�

Appendix
The�Appendix�includes�a�Glossary,�steps�for�calibrating�a�lens,�support�
and�upgrade�options,�and�a�copy�of�the�License�Agreement.�
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1.2.  Installing Foto 3D

Before�installing�Foto�3D,�please�ensure�that�the�computer�meets�the�
following�minimum�and�recommended�requirements.���

Requirements
PC�Hardware��
� CPU:�Pentium�3�or�equivalent,�minimum�733MHz;�Pentium�4�is�

recommended.�
� Physical�RAM:�128MB�minimum,�256MB�or�higher�recommended.�
� Graphics�card�capable�of�supporting�32�bit�color�(true�color�setting).�
� 12MB�free�disk�space�for�software�installation.�
� Mouse�and�Keyboard.�
� Digital�camera:�3Mp�or�higher�resolution�recommended.�
� Means�for�uploading�images�from�the�camera�(USB�or�firewire�cable,�

card�reader�or�CD/DVD).�
Monitor�resolution:��
� 1024x768�minimum�(small�system�fonts)�
� 1152x864�minimum�(large�system�fonts)�
� 1280x1024�recommended�
Operating�System��
� Microsoft�Windows�2000�(Service�Pack�4).�
� Microsoft�Windows�XP�

Licensing
In�essence,�the�software�license�allows�you�to�install�the�Foto�3D�software�
on�a�single�computer�for�use�by�the�registered�user�of�that�computer.��
Copies�are�permitted�solely�for�the�purpose�of�backing�up�the�computer.���
Please�refer�to�the�End�User�Licensing�Agreement�found�in�the�Appendix�
and�on�the�installation�screen.��If�you�do�not�understand�or�agree�with�all�
of�its�terms,�do�not�install�the�Foto�3D�software.���
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Installation

To�install�Foto�3D,�please�insert�the�CD�or�download�and�run�the�installer�
Strata Foto 3D.exe�and�follow�the�on�screen�instructions.��You�will�be�
asked�to�accept�the�End�User�Licensing�Agreement�and�enter�your�serial�
number�as�part�of�the�installation.���
You�will�be�given�a�choice�of��minimum��or��typical/complete��
installation.��The�difference�is�whether�the�approximately�24�MB�of�
example�files�are�installed,�that�are�referred�to�in�this�User�Guide.���
We�recommend�installing�these�files,�which�will�be�placed�in�the�
�Examples��folder�in�the�installation�directory.��They�can�be�deleted�at�
any�time.���
When�you�have�finished,�you�will�be�able�to�run�Foto�3D�either�by�
double�clicking�on�the�icon�installed�on�your�desktop�or�by�choosing�
Strata Foto 3D�from�the�Start�Menu.���

Uninstallation 
You�can�uninstall�Foto�3D�by�using�the�Windows�Add/Remove�Programs�
Wizard�found�in�the�Control�Panel.��If�you�have�modified�the�example�
projects�or�saved�other�projects�to�the�program�installation�directories,�
your�new�or�modified�files�will�be�left�where�you�saved�them.��All�other�
files�will�be�removed.���
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2.1.  A Tutorial for Creating Your First Model

This�tutorial�will�guide�you�through�making�your�first�model�and�trying�
out�the�basic�features�in�Foto�3D.��Some�of�the�example�photos�we�will�
use�in�this�book�are�intentionally�not�very�good.��You�will�see�that�the�
lighting�has�a�color�cast,�the�white�balance�was�not�set�correctly,�the�
images�are�under�exposed�and�lack�contrast,�and�there�are�some�strong�
reflections.��These�imperfections�in�the�photography�will�help�
demonstrate�the�power�of�the�features�and�automated�tools�found�in�
Foto�3D.��In�later�chapters,�we�will�revisit�these�examples�to�demonstrate�
some�of�the�more�sophisticated�tools�and�options.���

Figure 2.1.1.  New Installation Welcome Screen.
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Step 1 

Launch�the�Foto�3D�program.��The�Welcome�screen�will�be�displayed.���

Step 2 

These�Welcome�Screen�buttons�are�somewhat�self�explanatory.��The�first�
button�labeled��Load�the�Images�and�Build�the�Example�Project��launches�
the��Make�All��wizard,�described�below,�which�automatically�executes�all�
the�steps�of�this�tutorial.��While�it�is�a�powerful�feature,�and�may�even�be�
entertaining�to�watch,�it�won�t�teach�you�very�much.���

The�second�button�will�load�the�finished�project�so�that�you�may�try�the�
various�texture�editing�features!�

For�the�purposes�of�this�tutorial,�we�will�begin�a�project�the�usual�way.��
Click�the�third�button,��Start�using�Strata�Foto�3D�for�your�own�project��
to�close�this�Welcome�Screen�and�display�the�program�s�workspace.��

Step 3 

In�the�Main�Toolbar,�click�the�first�button,�the� �New project... button�
to�begin�a�new�model.��An�“Open”�image�files�dialog�box�will�appear.�

Figure 2.1.2.  New Project - Open Image files dialog box.
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Step 4 

The��Open��image�files�dialog�box�allows�you�to�select�the�photos�you�
want�to�use�to�create�a�new�model.��For�the�purpose�of�this�tutorial,�we�
have�included�a�set�of�photos�for�you�to�use.��Navigate�to�the�
Examples\FossilBox�directory�installed�with�the�application.��(If�you�used�
the�installation�defaults,�the�full�path�will�be�c:\Program Files\Strata\Strata 
Foto 3D\Examples\FossilBox.)�Click�on�and�select�the�first�photo,�then�
hold�down�the�Shift�key�and�click�on�the�last�photo�to�highlight�all�the�
photos�in�the�folder.��Then�click�"Open"�to�start�the�loading�process.���

Step 5 

You�should�now�see�the�following�view.���

Figure 2.1.3.  Foto 3D Main Window with the Mask Window selected.
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The�upper�half�of�the�workspace�window�includes�a�standard�Windows�
Menubar�and�the�Main�Toolbar.��The�lower�half�of�the�window�displays�
either�the�Mask Window�or�the�Model Window�and�their�associated�
palette�of�tools�and�settings.��Across�the�bottom,�a�status�bar�displays�
help�about�the�currently�selected�tool�and�information�about�the�current�
project.���

As�the�selected�photos�are�loaded,�you�will�see�a�progress�bar�as�the�
camera�angles�are�analyzed�and�thumbnails�are�added�to�the�Thumbnail 
Window.��A�warning�dialog�will�display�for�any�images�in�which�the�
Foto�3D�calibration�mat�is�not�visible�and�therefore�the�camera�angle�
cannot�be�determined.��These�images�will�be�automatically�tagged�as�
�rejected��from�the�automated�modeling�process�and�appear�marked�with�
an��X�.��This�is�normal�for�photos�taken�of�the�underside�of�an�object.���
A�later�chapter�will�tell�you�how�to�align�and�use�these�photos�to�add�
detail�to�the�model.��For�now,�simply�click��OK��for�the�process�to�
continue�until�all�of�the�images�are�loaded.���

Figure 2.1.4.  A photo with semi-transparent mask displayed in the Mask Window.
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Step 6 

We�will�now�use�Foto�3D�s�auto�masking�tool.��In�the�Main�Toolbar,�click�
the� Mask all images...  button�to�start�the�wizard�and�for�this�first�
try,�use�the�default�settings.��The�wizard�will�attempt�to�mask�each�of�the�
images�in�order�to�isolate�the�object�from�it�s�background.��At�the�
conclusion�of�the�process,�click�"Finish"�to�close�the�wizard.��Each�mask�
may�be�examined�by�clicking�image�thumbnails.��The�masked�area�will�
display�in�a�selected�mask�color�like�red�and�also�with�some�transparency�
in�the�display�window.���

Figure 2.1.5.  A generated model displayed in "flat shaded mode" in the Model Window.
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Step 7 

The�next�step�is�for�the�software�to�trace�the�outline�of�the�object�in�each�
of�the�photographs�and�construct�a�3D�wireframe�model�of�the�object.���
In�the�Main�Toolbar,�click�the� Generate Wireframe...  button�to�
start�the�Wireframe�Generation�Wizard.��Choose�the��Generate�
Wireframe��option�and,�again,�use�the�default�settings.��You�will�see�the�
resulting�triangular�mesh.��Choose�the��Optimize�Surface��option�to�
produce�a�finer�grain,�more�precise�mesh.���

At�the�conclusion�of�the�process,�click�"Finish"�to�close�the�wizard.���
As�the�wizard�closes,�a�process�called�decimation�is�initiated�to�simplify�
the�wireframe�in�order�to�reduce�memory�requirements�and�loading�time�
when�displaying�or�rendering�the�finished�model.��The�resulting�3D�

Figure 2.1.6.  A decimated wireframe model displayed in "wireframe mode"

wireframe�model�may�be�examined�and�rotated�in�the�display�window.���

 with the clipping plane being applied to trim the bottom.
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Step 8 

�automatic�masking�tool�may�not�always�identify�where�the�object�
�and�the�pedestal�it�is�sitting�upon�begins,�particularly�if�the�object�is�

�

g�

The
ends
casting�a�shadow�onto�the�pedestal.��While�the�model�s�photos�and�masks
for�this�area�can�be�refined,�it�is�easier�to�trim�off�the�excess�geometry�
using�the��Clipping�Plane��tool.��On�the�left�side�of�the�Model Window�
appears�the�Model�Palette,�a�toolbox�that�contains�buttons�in�a�groupin
called��Edit�Geometry�.��Click�on�the�middle,�� Move clip plane�
button�and�drag�the�blue�clipping�plane,�that�now�appears�in�the�main�
display�area,�up�to�the�place�where�you�want�to have�off�the�bottom�
the�mesh�that�corresponds�with�the�pedestal.��Once�the�plane�is�in�
position,�click�on�the�right,�

�s of�

Clip model�button�to�complete�the�
trimming�process.���

Figure 2.1.7.  A finished textured model (with a logo applied as a decal - Chapter 8.)
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Step

�that�we�have�a�model,�we�will�proceed�to�paint�the�surface�texture�

 9 

Now
using�the�same�photos.��In�the�Main�Toolbar,�click�the� Generate
texture map...  button�to�start�the�Texture�Generation�Wizard.���

Once�again,�use�the�default�settings.��As�each�photo�is�processed,�you�will�

Step

e�now�ready�to�save�and�export�the�finished�model.��Click�the��

see�the�painted�texture�being�updated�with�the�surface�color�detail�
obtained�from�that�photo.��At�the�conclusion�of�the�process,�click��Finish��
to�close�the�wizard.���

 10 

We�ar
Save project�button�to�give�the�project�a�name�and�save�it�in�the

folder�containing�the�photos�(optional�but�recommended).���

Click�the�

�

Export model...  button�(disabled�in�the�unlicensed�demo�
�e

�

version)�to xport�the�model�and�texture.��Use�the�default�VRML�World�
format�to�write�the�model�as�a�VRML�2�.WRL�file�with�.jpg�texture�that�is�
recognized�by�many�3D�modeling�programs,�web�browsers�and�viewers.��
If�you�have�a�VRML�viewer�installed�on�your�computer,�that�viewer�will�
be�launched�to�display�the�file.��VRML�is�also�the�preferred�format�to�
pass�the�new�model�and�it�s�texture�into�Strata�3D�CX�or�similar�3D�scene
modeling�and�rendering�software�and�to�Strata�Live�3D�for�creating�
interactive�web�displays�and�exciting�3D�PDF�files�that�can�be�displayed�
with�Adobe�s�free�Acrobat�Reader�(version�7�and�higher).���
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3.1.  Tour the Foto 3D Workspace  

A�typical�view�of�Foto�3D�is�shown�in�Figure 3.1.1.���

Figure 3.1.1.  Foto 3D workspace with the Model Window tab selected.   
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So�that�you�can�follow�along�on�your�screen,�we�have�included�a�project�
file�for�you�to�use.��In�the�Main�Toolbar,�click�the� Open project...  
button�to�open�an�existing�project.��The�Examples�folder�installed�with�
the�application�has�several�sets�of�photos�and�project�files�for�you�to�
experiment�with�to�learn�the�software.��In�this�case,�navigate�to�the�
Examples\FossilBox directory�installed�with�the�application.���
(If�you�used�the�installation�defaults,�the�full�path�will�be�c:\Program
Files\Strata\Strata Foto 3D\Examples\FossilBox.)��Click�on�and�select�the�
project�file�named�fossilbox.som�and�click��Open��to�load�the�project.��
You�should�now�see�the�same�view�as�Figure 3.1.1.���

As�described�before,�the�upper�half�of�the�screen�includes�a�standard�
Windows�Menubar,�the�Main�Toolbar�and�the�Thumbnail Window.���
The�lower�half�of�the�screen�displays�either�the�Mask Window�or�the�
Model Window�and�on�the�left�is�a�tool�palette�with�the�tools�and�settings�
associated�with�each�of�these�views.��Across�the�bottom,�a�status�bar�
displays�tips�about�the�currently�selected�tool�and�information�about�the�
project�s�status.��Each�of�these�elements�is�described�below.���

The Main Toolbar 

This�toolbar�is�used�to�perform�most�major�operations�on�a�Foto�3D�
project.��You�can�toggle�whether�it�is�displayed�or�not�using�the�
View > Toolbar�menu�item.��Each�of�the�buttons�in�the�toolbar�is�
described�in�detail�in�section�3.2,�The Main Toolbar,�later�in�this�chapter.���

The Status Bar 

The�status�bar�is�shown�across�the�bottom�of�the�Foto�3D�window.���
You�can�toggle�whether�it�is�displayed�using�the�View > Status Bar�
menu�item.���

�

TIP: To�quickly�find�out�what�a�button�does,�hover�over�the�button�
with�the�mouse�to�display�a�brief�tooltip.��Also�look�at�the�text�
displayed�at�the�left�side�of�the�status�bar�for�further�details�and�
options.�

�
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At�the�right�end�of�the�Status�Bar�are�a�series�of�information�fields�
relating�to�the�current�project,�including:��

� The�filename�of�the�photo�that�is�currently�displayed�in�the�Mask
Window�or�the�closest�photo�to�the�current�viewpoint�displayed�in�the�
Model Window.���

� How�many�images�are�currently�loaded�in�the�project�and�how�many�
of�those�are�in�use.���

� If�a�model�has�been�generated,�how�many�triangles�are�in�the�
displayed�model.���

� Whether�a�texture�map�has�been�created.���

The Thumbnail Window  

This�area�is�used�to�manage�the�photos�or�images�that�are�associated�with�
the�current�Foto�3D�Project.��By�default,�the�images�are�displayed�as�
thumbnails,�but�can�be�shown�as�a�list�with�detailed�information�about�
each�image�by�selecting�the� View image details�button.��Selecting�
the� View as icons�button�will�return�to�viewing�thumbnails.���

Click�and�drag�the�horizontal�bar�below�the�Thumbnail Window,�moving�
it�up�or�down,�to�alter�how�much�of�the�screen�height�is�used�to�display�
thumbnails.���

TIP: In�thumbnail�mode,�detailed�information�about�an�image�is�
displayed�as�a�tooltip�when�you�hover�over�it�s�thumbnail.�

Most�operations�from�the�Images�menu,�such�as�the�Images >  
Delete Images�menu�item,�are�performed�on�the�currently�selected�set�
of�thumbnails.��Images�can�be�selected�by�clicking�them�or�dragging�a�
selection�rectangle�around�them.��The�SHIFT�key�can�be�used�to�select�a�
range�of�image�files�and�the�CTRL�key�to�add�or�remove�the�clicked�file�
from�the�current�selection.���

TIP: Double�clicking�on�a�thumbnail�is�a�shortcut�for�the�
Images > Edit Mask�menu�item�and�loads�that�image��
into�the�Mask�Window.�
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All�the�operations�available�in�the�Thumbnail Window,�together�with�
descriptions�of�the�information�that�can�be�displayed�for�each�image,�are�
described�more�fully�in�The Thumbnail Window�section�that�follows.���

The Mask Window 

Click�on�the�Mask�tab�to�display�this�window�and�the�Mask�Palette�of�
tools.��Use�this�view�to�examine�and�edit�the�mask�for�a�particular�photo.��
You�can�zoom�into�a�mask�to�see�more�detail�using�tools�found�in�the�
Mask�palette.���

In�the�Mask�palette,�there�is�also�a�set�of�tools�for�automating�the�masking�
process.��These�are�described�in�detail�in�the�Fine Tuning the Auto-
Masking Process�section�of�Chapter�7.��There�is�also�a�set�of�tools�for�
manually�editing�masks.���

TIP: In�addition�to�the�buttons�on�the�Mask�palette,�you�can�right�
click�in�the�Mask Window�to�view�the�context�menu�and�access�
more�options.�

For�a�detailed�description�of�all�the�tools�and�operations�available�in�this�
window,�see�The Mask Window and Palette�section�later�in�this�Chapter.���

The Model Window 

Click�on�the�Model�tab�to�display�this�window�and�the�Model�Palette�of�
tools.��This�window�is�used�to�display�the�3D�model�that�is�being�
generated�by�Foto�3D.��You�can�use�the�tools�in�the�Model�Palette�to�
rotate�the�object�and�zoom�in�to�look�at�it�in�detail.���

TIP: Use�the� �Reset view�button�to�return�to�the�default�viewing�
position.�

Viewpoint�navigation�buttons�allow�you�to�change�how�the�model�is�
displayed.��There�are�also�controls�for�editing�the�model�s�geometry�
including�altering�the�number�of�triangles�used�to�construct�it,�clipping�
away�the�pedestal�the�model�was�sitting�upon,�and�editing�its�texture.���

TIP: In�addition�to�the�buttons�on�the�Model�palette,�you�can�right�
click�in�the�Model Window�to�view�the�context�menu�and�access�
more�options.
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For�a�detailed�description�of�all�the�tools�and�operations�available�in�this�
window,�see�The Model Window and Palette�section�later�in�this�Chapter.���

Reference Guide 

The�remainder�of�this�chapter�serves�primarily�as�a�Reference�Guide�to�
identify�each�of�the�tools�and�controls�that�are�available�on�the�screen�and�
briefly�explain�their�purpose.��Subsequent�chapters�will�discuss�how�and�
when�to�use�these�tools�effectively.���

3.2.  The Main Toolbar  

Figure 3.2.1.  Main Toolbar  

The�Main�Toolbar�is�used�to�perform�most�major�operations�on�a�Foto�3D�
project.��You�can�toggle�whether�it�is�displayed�by�using�the�View > 
 Toolbar�menu�item.��The�buttons�on�the�toolbar�are�shortcuts�to�certain�
highly�used�menu�items.��These�highly�used�menu�items�are�being�listed�
first,�in�the�order�that�their�buttons�appear�on�the�toolbar.���
In�the�section�following�this�one�is�a�list�of�the�remaining�Main�Menu�
items�and�their�functions.���

Project Operations 

The� New project... button�closes�the�current�project�and�starts�a�
new�one,�prompting�you�to�select�the�images�to�use�to�begin�the�new�
project.��You�can�select�more�than�one�image�by�dragging�a�selection�
rectangle�round�the�filenames�or�by�using�the�Shift�and�Ctrl�keys�to�add�
or�remove�files�from�the�selection.��All�the�images�should�be�in�the�same�
directory,�but�can�be�saved�in�different�formats.��You�can�always�add�
more�images�later�by�using�the�Images > Add Images...  menu�item.�

The� Open project... button�closes�the�current�project�and�opens�a�
previously�saved�project.��Foto�3D�will�try�to�find�the�images�used�in�the�
project�based�upon�the�folder�they�were�located�in�when�you�last�saved�
the�project.��If�they�are�not�found�there,�it�will�look�in�the�same�directory�
as�the�project�file�itself.��Finally,�if�they�still�can�not�be�found,�you�will�be�
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prompted�to�locate�the�images.��Canceling�this�image�loading�process�
will�allow�the�project�model�and�its�texture�to�be�loaded.��You�can�still�
generate�a�new�wireframe�or�texture,�or�perform�any�other�tasks�that�
require�accessing�the�photos�and�their�masks.�

The� Save project�button�saves�the�current�state�of�the�project.���
If�you�haven�t�previously�saved�the�project,�you�will�be�prompted�for�a�
filename.��Note�that�the�undo�information�is�not�saved�with�the�project�
and�neither�are�the�source�photos,�nor�their�masks�as�image�files�that�can�
be�used�in�another�project.��(See�Images > Masking > Save Masks)��
Unless�you�do�not�wish�to�edit�the�project�further,�the�original�photos�
should�be�retained�with�the�project�file�in�order�to�resume�working�with�
the�project�at�a�later�time.�

The� �Print mat...  button�is�used�to�print�out�the�calibration mat.��
This�will�open�a�print�dialog�so�you�can�choose�the�printer�to�use.���
You�can�change�the�size�of�the�mat�from�the�page�setup�dialog�by�
choosing�the�File > Page Setup...  menu�item.�

The� �Change settings...  button�opens�the�Strata Foto 3D Settings 
Window�where�you�can�alter�various�settings�associated�with�the�
application�and�current�project.��The�current�settings�are�saved�when�you�
close�Foto�3D�and�are�reloaded�as�defaults�the�next�time�you�start�the�
program.��Most�project�settings�are�also�saved�into�and�reloaded�from�the�
Foto�3D�Project�file.�

Editing

The� �Undo model or mask change�button�returns�either�the�
currently�displayed�mask�(when�the�Mask Window�is�active)�or�the�model�
(when�the�Model Window�is�active)�to�its�state�before�the�previous�
operation.��Recent�changes�to�a�mask�can�be�undone,�as�can�any�
operation�that�modifies�the�model�geometry�or�texture�map.���

Note:��Changes�made�directly�to�the�image�files�used�in�the�project�such�
as�changing�their�file�type�or�deleting�them�from�the�project�are�not�kept�
in�the�history�and�cannot�be�undone.�
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The� �Redo model or mask change�button�re�applies�the�last�
operation�that�has�been�undone�as�long�as�it�is�selected�right�after�using�
the�Edit Model > Undo Model Edit�menu�item.��It�will�apply�either�to�
the�currently�loaded�mask�or�the�model�depending�on�whether�the�Mask
Window�or�the�Model Window�was�active�at�the�time�of�the�Undo.�

View Controls 

The� �View as icons�button�switches�the�Thumbnail Window�to�
displaying�thumbnails�for�each�image.�

The� View image details�button�switches�the�Thumbnail Window�to�
displaying�a�columnar�list�of�the�project�s�image�files,�together�with�their�
attributes�and�details.�

Model Generation 

The� Mask all images...  button�opens�the�Generate Masks 
Wizard�to�guide�you�through�automatically�creating�masks�for�an�active�
selection�or�all�of�the�loaded�and��included��images.��See�the�section�
Masking Photographs�for�more�details.�

The� �Generate Wireframe...  button�opens�the�Generate�Wireframe�
Wizard�to�guide�you�through�creating�the�3D�Wireframe�model�of�the�
object�and�optimizing�the�surface�geometry.��See�the�section�Building the 
Wireframe Model�for�more�details.�

The� �Generate texture map...  button�opens�the�Generate�Texture�
Wizard�to�guide�you�through�generating�a�new�texture�for�the�model.��
See�the�section�Adding Surface Texture�for�more�details.�

The� Make all�button�can�be�used�to�build�a�complete�model�
automatically.��It�will�create�a�new�project,�prompting�you�to�select�
photos.��It�then�proceeds�to�open�and�run�the�three�main�wizards,�the�
Mask Generation Wizard,�the�Wireframe Generation Wizard,�and�
the�Texture Generation Wizard�in�succession,�and�then�opens�the�
Export Window�ready�for�you�to�choose�how�to�save�your�finished�model.��
You�can�interrupt�this�process�at�any�point�by�interacting�with�one�of�the�
wizards;�for�example,�clicking�a�Back�button.�
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Export

The� �Export model...  button�opens�the�Export Window�for�
exporting�the�finished�model.��The�section�Displaying and Exporting the 
Finished Model�describes�the�options�available.�

Help

The� �User Guide...  button�opens�the�help�browser�and�displays�this�
User�Guide.�

3.3.  The Main Menu  

File menu 

The�File > New�menu�item�begins�a�new�project,�the�same�as�the��
New project...  button�described�previously�in�the�preceding�

section�about�The�Main�Toolbar.���

The�File > Open...  menu�item�opens�an�existing�project,�the�same�as�
the� �Open project... button�described�in�the�preceding�section.���

The�File > Close�menu�item�closes�the�current�project.��You�will�be�
prompted�to�save�the�project�first�if�you�have�made�any�unsaved�changes.�

The�File > Save�menu�item�saves�the�current�project,�the�same�as�the��
�Save project�button�described�previously.���

The�File > Save As...  menu�item�saves�the�current�state�of�the�project�
similar�to�the�File > Save�menu�item�but�allows�a�different�file�name�to�
be�entered.�

The�File > Page Setup...  menu�item�allows�you�to�decide�how�big�to�
print�the�calibration mat.��You�can�either�set�the�diameter�of�the�mat�or�
choose�to�fit�it�onto�a�chosen�number�of�pages.��When�printing�across�
multiple�pages,�you�will�need�to�combine�the�pages�accurately�using�the�
markings�provided.�

The�File > Print Preview...  menu�item�displays�a�preview�of�the�
calibration mat�so�you�can�see�how�it�will�print�on�your�chosen�printer.�

The�File > Print Mat...  menu�item�prints�a�calibration�mat,�the�same�as�
the� �Print mat... button�described�previously.���
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The�File > Settings...  menu�item�opens�the�preference�settings�
window,�the�same�as�the� �Change settings...  button�described�
previously.���

The�File > Export...  menu�item�exports�the�finished�model,�the�same�as�
the� �Export model...  button�described�previously.���

The�File > Exit�menu�item�closes�Foto�3D�prompting�you�to�save�any�
unsaved�project�first.�

The�Main Menu > File�menu�also�contains�a�list�of�up�to�four�of�the�
most�recently�opened�files�as�a�shortcut�for�opening�these�projects.���

Edit menu 

The�Edit Model > Undo Model Edit�menu�item�will�undo�the�latest�
revision�to�the�item�displayed�in�the�work�area,�the�same�as�the��
�Undo model or mask change�button�described�previously.���

The�Edit Model > Redo Model Edit�menu�item�will�reapply�the�most�
recent�change�to�the�item�displayed�in�the�work�area�that�was�reversed�
by�the�Edit Model > Undo Model Edit�menu�item,�the�same�as�the��

Redo model or mask change�button�described�previously.���

The�Edit > Copy�menu�item�(when�the�Model Window�is�active�and�the�
texture�map�has�been�generated)�copies�the�current�view�of�the�model�
onto�the�Windows�clipboard�ready�for�texture�editing�in�an�external�
application.���

The�Edit > Paste�menu�item�(when�the�Model Window�is�active)�blends�
the�image�on�the�Windows�clipboard�back�into�the�texture�map.���
The�image�on�the�clipboard�must�be�the�same�size�as�the�other�images�in�
the�project�and�should�be�an�edited�version�of�an�image�obtained�using�
the�Texture Editing > Copy Texture�menu�item.�

View menu 

The�View > View Image Thumbnails�menu�item�will�display�the�
project�s�images�as�thumbnails�in�the�Thumbnail Window,�the�same�as�the�
�View as icons�button�described�previously.���
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The�View > View Image Details�menu�item�will�display�the�project�s�
images�as�a�detailed�list�in�the�Thumbnail Window,�the�same�as�the��
�View image details�button�described�previously.���

The�View > Mask Palette�menu�item�activates�the�Mask Window�for�
viewing�and�editing�masks,�hiding�the�Model Window.�

The�View > Model Palette�menu�item�activates�the�Model Window�for�
viewing�and�editing�the�model,�hiding�the�Mask Window.�

The�View > Toolbar�menu�item�toggles�the�display�of�the�Main�Toolbar�
at�the�top�of�the�Foto�3D�window.�

The�View > Palette�menu�item�toggles�the�display�of�the�Mask�palette�
associated�with�the�Mask Window�and�the�Model�palette�associated�with�
the�Mask Window.���

The�View > Status Bar�menu�item�toggles�the�display�of�the�Status�Bar�
at�the�bottom�of�the�Foto�3D�window.�

Processing menu 

The�Processing > Make All�menu�item�will�launch�the�Make�All�
Wizard,�the�same�as�the� �Make all�button�described�previously.���

The�Processing > Mask All Images...  menu�item�will�launch�the�
Mask�Wizard,�the�same�as�the� �Mask all images...  button�described�
previously.���

The�Processing > Generate Wireframe...  menu�item�will�launch�the�
Generate�Wireframe�Wizard,�the�same�as�the� �Generate 
Wireframe... button�described�previously.���

The�Processing > Generate Texture Map...  menu�item�will�launch�
the�Generate�Texture�Wizard,�the�same�as�the� �Generate texture 
map...  button�described�previously.���

Images menu 

This�menu�is�described�under�The Thumbnail Window�section�later�in�
this�Chapter.���
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Mask Tools menu and Model Tools menu 

These�menus�are�described�later�in�this�Chapter�under�The Mask Window 
and Palette�and�The Model Window and Palette�sections,�respectively.���

Help menu 

The�Help > User Guide...  menu�item�will�display�this�User�Guide,�the�
same�as�the� �User Guide...  button�described�previously.���

The�Help > About Strata Foto 3D ...  menu�item�opens�a�dialog�with�
information�about�the�current�version�of�the�software�and�credits.�

3.4.  The Thumbnail Window  

This�section�describes�how�to�manage�the�images�in�a�Foto�3D�Project�
using�the�Thumbnail Window�and�how�to�perform�operations�on�multiple�
images�at�once.���

The�Images�menu�can�be�accessed�either�from�the�Main�Menubar�or�by�
right�clicking�in�the�Thumbnail Window.���

TIP: If�the�project�contains�more�images�than�will�fit�on�the�screen�
and�you�are�doing�a�lot�of�work�with�the�Thumbnail Window,�
try�dragging�the�separator�below�the�Thumbnail Window�down�
so�that�the�images�are�displayed�in�more�than�one�row.

Organizing Images in Thumbnail Mode

Clicking�the� View as icons�button�will�switch�to��thumbnail�mode��
(the�default�when�a�project�is�loaded�or�created).���

Figure 3.4.1.  The Thumbnail Window in thumbnail mode with  
some images selected and some marked "rejected". 
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The�thumbnails�are�initially�shown�in�the�order�in�which�they�were�
added�to�the�project.��If�you�change�the�current�sort�order�when�viewing�
the�list�of�images�in�details�mode,�then�the�thumbnails�will�be�displayed�
sorted�in�the�same�order�(see�Organizing Images in Details Mode).��When�
multiple�rows�of�thumbnails�are�visible,�note�that�the�images�are�sorted�
down�the�rows,�then�across�the�columns.���

If�the�camera�orientation�can�be�determined�for�an�image,�the�image�will�
be�displayed�rotated�so�that�the�object�is�displayed�upright���this�may�be�
a�different�orientation�than�the�original�image�file�in�the�project�folder.���

You�can�select�one�or�more�thumbnails�using�the�mouse�or�keyboard.��
Clicking�on�an�image�selects�it.��Dragging�a�selection�marquee�around�a�
region�of�thumbnails�will�select�the�group.��Holding�down�SHIFT�key�
will�add�or�remove�the�range�of�images�between�the�last�selected�image�
and�the�current�one.��Holding�down�the�CTRL�key�will�add�or�remove�
clicked�files�from�the�current�selection.��The�cursor�keys�can�also�be�used�
to�navigate�around�the�thumbnails.���

Hovering�over�one�of�the�thumbnails�will�bring�up�a�tooltip�with�the�
details�for�that�image.��These�details�are�described�in�the�Image 
Properties�section.���

TIP: When�you�load�a�saved�project�with�lots�of�images,�you�can�
cancel�the�thumbnail�loading�if�you�are�not�interested�in�seeing�
them.��You�will�still�be�able�to�perform�operations�on�these�
images.���

You�can�load�a�single�thumbnail�when�the�Mask�Window�is�
displayed�by�double�clicking�on�it�or�dragging�it�into�the�Mask�
Window�for�editing.���

You�can�load�(or�reload)�the�thumbnails�at�any�time�by�using�
the�Images > Load Thumbnails�menu�item.���

Organizing Images in Details Mode  

Clicking�the� View image details�button�will�switch�to��details�
mode�.��Each�image�is�displayed�as�a�row�in�this�mode�with�the�various�
information�associated�with�it�in�columns�to�the�right�of�the�image�file�
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name�as�shown�in�Figure 3.4.2.��The�contents�of�the�columns�are�
described�under�Image Properties,�below.���

Figure 3.4.2.  The Thumbnail Window in details mode. 

You�can�sort�the�images�by�any�column�by�clicking�on�the�column�header.��
Clicking�a�second�time�reverses�the�sort�order�and�a�third�time�returns�to�
project�order.��An�arrow�in�the�column�header�shows�which�column,�if�
any,�is�determining�the�sort�order.��The�sort�order�also�affects�the�order�
thumbnails�are�displayed�when�switched�to�thumbnail�mode.���

You�can�also�change�the�display�order�of�the�columns�by�dragging�the�
column�headers�to�a�new�position.��You�can�change�the�display�width�of�
a�column�by�dragging�the�separator�between�the�column�headers.���

Image Properties  

This�section�describes�the�properties�that�are�associated�with�each�image�
and�how�they�can�be�changed.��You�can�see�the�properties�for�an�image�
by�hovering�the�mouse�over�it�in�thumbnail�mode�or�by�switching�to�
details�mode�using�the� View image details�button.���

"Name"

By�default�this�is�the�filename�of�the�image�(without�the�path�or�
extension),�but�if�you�wish,�you�can�edit�this�to�be�more�meaningful.���
This�is�useful�in�the�thumbnail�view�where�this�is�the�only�information�
displayed�next�to�an�image.���
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Changing�this�image�name�only�affects�how�it�is�displayed,�it�will�not�
rename�the�associated�image�file�in�the�project�folder.���

"Type"

Most�images�are�described�as�"normal",�which�means�that�the�mask�
associated�with�the�image�will�be�used�to�generate�the�geometry�and�the�
color�information�in�the�image�will�be�used�to�generate�the�texture.���

You�can�change�how�selected�images�are�used�by�the�software�with�the�
Images > Image Type�menu�(found�on�the�Main�Menu�or�the�right�
click�context�menu).��Selecting�the�Image Type > Geometry Only�
menu�item�changes�the�type�to�"silhouette"�while�selecting�the��
Image Type > Texture Only�menu�item�changes�the�type�to�
"texture".��Finally,�if�the�image�has�been�created�by�the��
Geometry Editing > Create Silhouette�menu�item,�then�the�type��
will�be�"synthetic".���

"Status"

Images�can�be�marked�as�"rejected"�by�selecting�them�and�then�
choosing�the�Images > Reject Images�menu�item�or�right�clicking�in�
the�Thumbnail�Viewer�and�selecting�the�Reject Images�menu�item.��
Being�marked�"rejected"�means�that�subsequent�operations�will�ignore�
the�image.��In�thumbnail mode,�an��X��is�drawn�over�the�image;�in�details 
mode�the��X��is�over�the�icon�at�the�beginning�of�the�line.��By�default,�all�
images�with�a�visible�calibration�mat�will�be�"included".���

This�field�will�display�"aligning"�if�this�image�is�currently�being�aligned�
with�the�Align Wizard.���

"Camera"

When�an�image�is�loaded�into�Foto�3D�for�the�first�time,�the�software�
automatically�attempts�to�determine�the�camera�s�position�relative�to�the�
object.��It�does�this�by�locating�and�analyzing�how�the�calibration mat�
appears�in�the�image.��The�camera�elevation�and�rotation�angles�are�
displayed�in�this�field�(to�the�nearest�degree)�as�well�as�a�number�
representing�a�relative�distance�to�the�object.���

�
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In�some�cases,�this�field�will�indicate�that�the�camera�location�is�not�
known�for�an�image.��Such�an�image�will�initially�be�marked�as�rejected�
since,�without�knowing�the�camera�position,�it�cannot�be�used.��
To�manually�specify�the�camera�position,�use�the�Images >  
Align Image...  menu�item�as�described�in�the�section�Adding Texture 
to the Bottom of an Object�found�in�Chapter�8.���

"Mask Status"

This�field�displays�"mask created"�if�a�mask�exists�for�this�image.���

"Order"

This�field�displays�the�ordering�and�importance�weighting�of�the�images�
according�to�which�images�contribute�the�most�information�to�the�final�
shape�and�texture.��There�are�several�operations�that�process�images�
using�this�order,�such�as�surface�optimization�and�texture�generation.���

Advanced�users�can�override�the�automatic�ordering�by�using�your�own�
knowledge�of�the�object�to�mark�selected�images�as�higher�priority�by�
using�the�Images > Image Order�menu�item.���

"Size"

This�field�displays�the�size�of�the�source�image�in�pixels.���

"Full path"  

This�field�displays�the�full�path�and�file�name�of�the�image�file.���
If�the�thumbnail�image�has�not�been�loaded,�this�will�be�the�last�known�
location�of�the�image.��When�a�saved�project�is�reopened,�Foto�3D�will�
look�for�the�image�in�its�last�known�location.��If�it�can�t�be�found,�it�will�
look�in�the�same�directory�as�the�project�file,�and�if�it�still�can�t�be�found�
there,�the�user�will�be�prompted�to�locate�the�file.���
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The Images Menu  

Figure 3.4.3.  The right-click context menu for the Thumbnail Viewer.   

Managing Images 

The�Images > Select All�menu�item�and�the�Images > Select None�
menu�item�can�be�used�as�shortcuts�for�selecting�images.��Operations�that�
usually�work�on�a�selection�of�image�thumbnails�will,�by�default,�be�
applied�to�all images�if�none�are�selected.���

Choosing�the�Images > Load Thumbnails�menu�item�will�select�any�
unloaded�thumbnails�from�the�currently�selected�images�and�attempt�to�
load�them�from�the�source�image�files�on�disk.��If�all�the�selected�images�
have�already�had�their�thumbnails�loaded,�then�they�will�all�be�refreshed�
from�the�source�image�files�(in�the�event�the�files�were�edited�externally).���

Use�the�Images > Add Images...  menu�item�to�add�new�images�to�
the�project.��You�will�be�prompted�to�select�one�or�more�files�from�the�
hard�drive�and�then�each�will�be�added�in�turn.��As�the�images�are�added,�
the�camera�position�is�calculated.��If�this�fails�(usually�because�the�
calibration�mat�isn�t�in�the�photograph)�you�will�be�notified�and�the�
image�will�be�rejected.��As�will�be�explained�in�Chapter�8,�you�will�need�
to�align�these�images�by�hand�using�the�Align Wizard.���
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A�photo�may�be�added�more�than�once�to�the�same�project.��As�will�be�
described�in�Chapter�8,�this�is�useful�for�having�one�instance�of�a�photo�
that�is�set�to��geometry�only��and�masked�to�define�the�object�s�silhouette,�
and�another�instance�that�is�set�to��texture�only��and�is�masked�to�exclude�
reflections�that�you�do�not�want�to�appear�in�the�model�s�texture�map.���

Note: Foto�3D�will�only�operate�with�images�that�are�all�the�same�size�
(dimensions�in�pixels)�and�orientation.��Images�of�different�sizes�can�be�
added�to�the�project�for�convenience,�but�will�be�marked�as�rejected.�

To�remove�images�from�the�project,�select�them�and�then�choose�the�
Images > Delete Images�menu�item.��This�will�leave�the�image�intact�
in�the�project�folder,�but�will�destroy�any�unsaved�mask�created�in�
Foto�3D�and�remove�the�image�from�the�project�database.���
Note:��An�image�deletion�cannot�be�undone;�an�accidentally�deleted�
image�would�have�to�be�re�added�to�the�project.���

Using images 

Choosing�the�Images > Edit Mask�menu�item,�or�simply�double�
clicking�on�a�thumbnail�when�the�Mask�Window�is�displayed�or�
dragging�that�thumbnail�onto�the�display�area�will�load�the�selected�
image�into�the�Mask Window�for�viewing�or�editing�the�mask.���

Choosing�the�Images > View Camera�menu�item,�or�simply�double�
clicking�on�a�thumbnail�with�the�Model�Window�displayed�or�dragging�
that�thumbnail�onto�the�display�area,�will�change�the�camera�viewpoint�
in�the�Model Window�to�match�the�camera�position�used�to�take�the�
selected�image.���

Choosing�the�Images > Copy Image�menu�item�places�a�copy�of�the�
selected�image�in�the�Windows�clipboard�so�that�it�can�easily�be�pasted�
into�an�external�image�editor�like�Photoshop.��The�image�will�have�been�
subsampled�and�color�adjusted,�if�these�options�are�chosen,�so�it�will�
blend�with�the�other�images�used�to�make�the�texture�map.��(Making�a�
duplicate�of�an�image�in�order�to�apply�a�different�mask�is�accomplished�
by�loading�a�second�instance�of�the�photo�by�using�the�Images >  
Add Images...  menu�item.)��
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Once�the�model�geometry�has�been�generated,�you�can�choose�the�
Images > Paste Into Model�menu�item�to�blend�a�selected�image��
into�the�texture�map.���

Operations on Images 

The�Images > Include Images�menu�item�works�to��unreject��any�
images�you�previously�chose�to�reject.��It�will�mark�the�selected�images�as�
"included"�(no�longer�rejected)�so�that�they�are�used�in�subsequent�
operations.��To�be�"included",�images�must�be�the�same�size�and�have�a�
defined�camera�position���if�the�camera�position�wizard�rejected�the�
images,�you�will�be�unable�to�change�their�status�using�this�command.��
(Use�the�Images > Align Image...  menu�item)��

The�Images > Reject Images�menu�item�will�mark�the�selected�
images�as��rejected��so�that�they�are�ignored�for�subsequent�operations�
including�masking,�wireframe�model�generation�and�texture�generation.��
Images�that�are�rejected�can�be�left�as�is�and�ignored,�deleted�from�the�
project,�or�aligned�manually�and�then�"included".���

The�Images > Image Type�menu�allows�the�image�s�type�or�purpose�
(such�as��geometry�only��or��texture�only�)to�be�altered�as�described�in�
the�Image Properties�section.���

Figure 3.4.4.  Changing image to Highest Importance using the Image Order menu.   
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The�Images > Image Order�menu�allows�the�order�of�the�images�to�be�
altered.��Images�are�often�processed�in�the�default��project�order��as�
described�in�the�Image Properties�section,�but�you�can�use�this�menu�to�
mark�selected�images�as�high�priority�and�emphasize�these�images�by�
selecting�"Image Boosting"�in�the�Texture Generation Wizard.���

The�Images > Masking�menu�allows�you�to�work�on�the�masks�
associated�with�the�selected�image�thumbnails.���

The�Images > Align Image...  menu�item�allows�you�to�align�
additional�photographs�taken�without�the�calibration mat�or�taken�after�
the�object�has�been�moved.��See�the�section�Adding Texture to the 
Bottom of an Object�in�Chapter�8�for�details.���

3.5.  The Mask Window and Palette  

Figure 3.5.1.  The Mask Window containing the Mask Palette and Mask Display Area. 
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This�section�on�the�Mask Window and Palette�describes�the�tools�
available�for�examining�and�editing�the�mask�associated�with�each�image�
in�the�project.��Please�read�Chapter�7�to�understand�when�and�why�you�
might�want�to�do�this�plus�tips�for�using�the�tools�effectively.���

Except�for�the�interactive�masking�slider,�all�the�masking�tools�available�
from�the�Mask�palette�can�also�be�accessed�from�the�Main Menu >
Mask Tools�menu�or�by�right�clicking�in�the�Mask Window�Display�Area.���
This�Palette�of�masking�tools�can�be�displayed�either�from�the�Main�
Menu�by�selecting�the�View > Mask Palette�menu�item,�or�by�clicking�
on�the�Mask�tab.���

How Masks Affect the 3D Model  

This�brief�conceptual�explanation�is�to�help�you�understand�the�purpose�
of�the�mask�tools�and�how�to�get�the�most�out�of�them.��A�more�detailed�
and�illustrated�explanation�is�provided�in�Chapter�6.���

Figure 3.5.2.  Photo -> Masked Photo -> Silhouette -> Wireframe and Shaded Mesh 
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A�mask�is�created�to�identify�the�outline�or�silhouette�of�the�object,�as�
seen�from�the�camera�s�viewpoint.��The�Generate Wireframe�process�
which�constructs�the�3D�model�can�be�visualized�as�a�sculptor�taking�a�
block�of�clay�and�projecting�each�image�mask�onto�it�from�the�viewpoint�
of�the�camera.��Wherever�the�projected�mask�appears�on�the�clay,�the�clay�
is�sliced�away�until�the�model�s�silhouette�matches�the�masked�silhouette�
obtained�from�the�object�s�photo�taken�from�that�perspective.���

Because�previously�processed�masks�may�have�fully�cut�away�a�
particular�area�of�clay,�some�masks�may�have�little�or�no�effect,�especially�
if�the�mask�is�not�set�tight�to�the�object�in�that�view.��For�this�reason,�not�
every�image�needs�to�be�masked.��Sometimes�only�portions�of�images�
that�clearly�show�an�important�profile�or�areas�of�needed�detail�need�to�
be�precisely�masked�to�improve�the�precision�of�the�model.���

This�also�explains�why�none�of�the�masks�can�cut�into�the�object�as�once�
the�clay�is�removed;�the�model�is�deformed�and�will�only�be�restored�by�
correcting�the�mask�and�generating�the�wireframe�model�over�again.���

There�are�two�primary�mechanisms�that�cause�the�auto�masking�tools�to�
produce�inferior�models.��One�is�that�a�shiny�surface�can�reflect�the�
background�and,�especially�if�the�allow�"Holes" feature�is�checked,�these�
regions�can�be�mistakenly�perceived�as�holes�in�the�object.��It�only�takes�
one�image�with�these�reflections�masked�as��background��to�deform�the�
resulting�model.���

The�other�mechanism�is�when�areas�of�the�model�do�not�have�enough�
contrast�or�color�difference�from�the�background�and�the�mask�penetrates�
into�the�object.��This�is�best�solved�by�improving�the�lighting�or�choice�of�
background.��It�is�also�improved�by�adjusting�the��background�threshold��
setting�described�below.���

Viewing an Image and it's Mask  

Click�on�the�Mask�tab�to�display�the�Mask�Window.��Whenever�the�Mask�
Window�is�displayed,�you�can�load�a�photo�and�its�mask�into�the�display�
area�for�editing�by�either�double�clicking�on�a�thumbnail�in�the�
Thumbnail Window,�dragging�and�dropping�a�thumbnail�onto�the�Mask
Window's�display�area,�or�selecting�an�image�and�choosing�the�
Images > Edit Mask�menu�item.���
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The�mask�is�displayed�as�a�semi�transparent�overlay�over�the�color�photo.��
The�masked�region�defines�the�parts�of�this�view�that�are�definitely�not�
part�of�the�object�(in�other�words,�the�background).��It�is�important�not�to�
over�mask�the�object,�but�it�does�not�necessarily�matter�if�you�do�not�
mask�all�of�the�background.��In�particular,�the�stand�can�be�fully�cut�away�
using�the�Clipping�Plane�tool,�described�later,�and�so�masking�areas�
below�the�bottom�of�the�object�is�not�necessary.���

TIP: It�is�perfectly�acceptable�to�set�the�thresholds�described�
below�to�produce�a�few�pixels�of�anti�alias��fringe��around�
the�object�where�the�edge�of�the�object�blends�with�the�
background�color.��As�illustrated�in�Figure 3.5.3,�a�
consistent�width�fringe�with�a�smoother�edge�will�produce�a�
better�model�than�either�a�jagged�edge�that�produces�
artifacts�in�the�mesh�or�risking�part�of�the�object�being�
inadvertently�masked�as�background�and�therefore�being�
cut�away�from�the�model�by�setting�the�background�
threshold�too�close�to�the�object�s�color�range.���

Figure 3.5.3.  Slight Under-mask with Smooth Fringe produces a smoother model surface. 

You�can�change�how�the�mask�is�displayed,�choosing�from�solid�color,�
semi�transparent,�or�hidden,�using�the�Mask Tools > Display Mask …�
menu.��In�The Strata Foto 3D Settings Window�you�can�change�the�color�
used�to�identify�masked�areas�so�they�show�up�well�against�your�images.���
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With�the� �Zoom in�button�or�the� �Zoom out�button�selected,�you�
can�zoom�into�or�out�from�the�image�by�a�single�click�of�the�left�mouse�
button.��You�can�zoom�into�a�particular�region�by�selecting�the� �Zoom 
in�button�and�using�the�mouse�to�drag�out�a�rectangular�marquee�around�
the�area�of�interest.��Alternatively,�you�can�select�the�zoom�value�using�
the�zoom�level�drop�down�box�or�the�Mask Tools > Zoom to...  menu.���

When�you�are�zoomed�into�the�image,�you�can�scroll�around�freely�in�
two�dimensions�by�selecting�the� Pan image�button.��Alternatively,�
you�can�use�the�scrollbars�around�the�window�to�scroll�vertically�or�
horizontally.���

TIP: As�a�shortcut,�holding�down�the�SPACEBAR�temporarily�
switches�to�the�Pan image�tool.���Releasing�it�restores�the�
previously�selected�tool.

The� Zoom to fit�button�changes�the�magnification�and�re�centers�the�
display�so�that�the�entire�unmasked�region�fits�within�the�window.���

Undoing Mask Changes  

A�short�undo�history�is�kept�for�all�changes�to�the�masks�for�each�image.��
You�can�only�undo�changes�to�the�image�that�is�currently�displayed�in�
the�Mask Window,�but�the�history�is�kept�separately�for�each�image,�even�
while�you�have�a�different�image�displayed�in�the�Mask Window.���
Even�changes�made�by�using�the�Mask Wizard�can�be�undone.��This�can�
be�particularly�useful�for�seeing�whether�automatic�masking�with�
different�parameters�has�made�an�improvement�or�not.��Note�that�this�
undo�information�is�not�saved�in�the�project�file�and�is�only�available�for�
the�current�session.���

Use�the� �Undo model or mask change�button�in�the�Main�Toolbar�
to�return�to�the�previous�mask�for�the�displayed�image�and�the��
�Redo model or mask change�button�to�re�apply�the�change.���
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Automatic Masking Tools

The�automatic�masking�tools�in�the�Mask Palette�enable�you�to�perform�
automatic�masking�interactively,�allowing�you�to�adjust�the�parameters�
to�improve�the�mask�and�to�apply�the�tools�to�only�selected�regions�of�the�
image.��See�the�sections�on�Fine Tuning the Auto-Masking Process�and�
Masking with the Shrink-Wrap tool�in�Chapter�7�for�a�description�of�how�
to�use�these�tools�effectively.���

The� Regenerate mask�button�sets�up�interactive�masking�for�the�
current�image.��After�this�has�been�run,�the�threshold�for�the�image�can�
be�varied�interactively�by�adjusting�the�slider�that�appears�below�this�
button.��Changing�this�slider�also�adjusts�the�background�threshold�
setting�that�will�be�used�as�the�default�for�automatically�masking�images�
using�the�Mask Wizard.���

The� Shrink-Wrap Mask�button�sets�up�an�alternative�interactive�
masking�technique.��Unlike�Regenerate mask�this�technique�uses�the�
current�mask�as�a�starting�point�and�then�shrinks�the�unmasked�region�
by�selecting�adjacent�areas�of�similar�color.��Again,�moving�the�slider�
adjusts�the�tolerance�and�determines�the�extent�that�the�unmasked�
regions�are�shrunk.��This�tool�can�be�applied�to�just�a�portion�of�an�image�
if�an�area�has�been�selected�with�the�selection�tool.���

The� �Unmask image�button�is�a�quick�way�of�removing�the�entire�
mask�for�the�displayed�image.���

The� Clean Mask�button�is�only�available�once�a�wireframe�model�
has�been�generated.��Clicking�on�it�uses�the�shape�of�the�current�model�to�
clean�up�the�mask�so�that�all�parts�of�the�image�that�fall�outside�the�
model�when�viewed�from�this�viewpoint�are�masked�out.��It�is�a�quick�
way�to�create�a�mask�as�a�safe�starting�point�to�use�with�the�other�
masking�tools.��It�can�also�be�used�for�generating�an�initial�mask�for�new�
images�added�to�the�project.���

The�"Shadows"�checkbox�toggles�whether�color�normalization�is�used�
by�the�automatic�masking�algorithms�to�attempt�to�identify�and�
compensate�for�shadows�on�the�backdrop.��Changing�this�option�does�not�
have�an�effect�on�an�existing�mask;�only�on�newly�generated�masks.���
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If�the�allow�"Holes"�checkbox�is�selected,�the�automatic�masking�tools�
will�locate�and�mask�any�areas�within�the�object�s�outline�boundaries�that�
are�truly�holes�where�the�background�can�be�seen.��It�may�also�create�
isolated�patches�of�mask,�such�as�on�surfaces�in�the�middle�of�the�object�
that�are�reflecting�the�background�or�that�are�transparent.��If�your�object�
is�made�of�a�single�structure�without�any�holes,�it�is�worth�keeping�this�
option�deselected�to�avoid�holes�being�made�in�the�object,�particularly�if�
the�object�has�glossy�surfaces�or�specular�highlights.��The�option�can�be�
interactively�changed�for�just�one�image�or�just�a�region�within�an�image,�
as�described�below.���

Manual Masking Tools  

The�manual�masking�tools�allow�you�to�modify�the�mask�by�hand.���
The�process�is�time�consuming�and�we�recommend�that�wherever�
possible�you�avoid�manual�masking�by�using�the�automatic�masking�
tools,�improving�the�lighting�in�your�photo,�or�using�the�semi�automatic�
tools�for�refining�a�mask.��In�addition,�the�section�on�Editing Masks with 
an External Application�found�in�Chapter�7�explains�how�to�use�your�
favorite�third�party�image�editing�software�to�perform�masking.���

Each�tool�can�be�used�either�with�the� �Paint mask�button�selected�to�
add�to�the�masked�region�or�with�the� �Unpaint mask�button�selected�
to�add�to�the�unmasked�region.���

TIP: While�using�any�of�the�manual�masking�tools,�you�can�
temporarily�switch�between�Paint mask�and�Unpaint mask�
by�holding�the�Ctrl�key.

There�are�two�brush�tools�for�freehand�mask�painting.��Click�on�either�the�
�Round Brush�button�or�the� �Square Brush�button�to�select�them.��

The�size�of�the�brush�is�adjusted�using�the�slider�above�these�tools.���
The�cursor�changes�to�show�the�shape�and�size�of�the�brush�(except�when�
fully�zoomed�in).���

TIP: You�can�also�use�the�<�and�>�keys�to�change�the�brush�size�in�
large�steps�or�the�,�and�.�keys�to�change�the�brush�size�in�single�
pixel�steps.
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Note: If�you�are�zoomed�in,�as�you�paint�near�the�edge�of�the�window,�
the�window�will�automatically�scroll�to�keep�the�brush�visible.��If�you�
don�t�like�this�behavior�or�it�is�too�slow�on�your�graphics�card,�you�can�
switch�it�off�by�de�selecting�the�"Automatically scroll canvas when 
painting"�option�in�the�Strata Foto 3D Settings Window.�

The� Fill mask�button�selects�a�simple�fill�tool.��Clicking�within�a�
region�of�unmasked�pixels�will�mask�them�(or�vice�versa�depending�on�
the�current�painting�mode).���

The� Fill Polygon�button�enables�a�polygon�drawing�mode.���
Click�once�to�place�each�vertex�of�the�polygon�you�want�to�fill,�and�then�
double�click�on�the�last�vertex�to�complete�the�polygon�and�perform�the�
fill.��As�you�click�each�vertex,�you�can�drag�the�vertex�to�adjust�the�
position�of�the�line�before�releasing�the�mouse�button.��To�abort�without�
performing�the�polygon�fill,�simply�select�a�different�tool.���

Figure 3.5.4.  The Polygon Tool being used to trim the mask to restore the straight  
side of a cylindrical bottle where the label was overmasked due to having a color  

very similar to the background. 

Figure 3.5.5.  The Polygon Tool being used to trim the object (add to the mask) and 
define a smooth curve for the object's silhouette at a place where deep shadows make 

interactive masking ineffective because of their similarity in color to the object. 
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TIP: The�polygon�tool�is�a�quick�and�powerful�way�to�smooth�out�
rough�edges�on�a�mask.��Click�once�to�set�an�anchor�near�a�
curved�edge�that�needs�trimming.��Click�and�hold�at�a�second�
point�and�move�your�mouse,�adjusting�how�the�line�segment�
will�trim�off�the�edge�like�a�knife.��When�you�are�satisfied,�
release�the�mouse�and�double�click�on�the�side�of�the�line�that�
you�want�trimmed�to�complete�the�process.��(This�technique�will�
trim�from�the�object�by�adding�to�the�mask�or�trim�from�the�
mask�by�adding�to�the�unmasked�area,�depending�on�which�
paint�mode�button�is�active.)�

3.6.  The Model Window and Palette  

Figure 3.6.1.  The Model Window containing the Model Palette and  
Model Display Area (Wireframe display mode.) 
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This�section�describes�the�tools�available�for�viewing�and�modifying�the�
3D�model�displayed�in�the�Model Window.��Please�read�about�Surface
Optimization�in�Chapter�7�and�Texturing�in�Chapter�8�to�learn�more�
about�why�and�when�to�use�these�tools�and�for�tips�on�making�the�most�
of�the�tools�available.���

This�Palette�of�modeling�tools�can�be�accessed�either�from�the�Main�Menu�
by�selecting�the�View > Model Palette�menu�item,�or�by�clicking�on�the�
Model�tab.��Except�for�the�"Number of Triangles" Decimation Slider,�all�
the�modeling�tools�available�from�the�Model�palette�can�also�be�accessed�
from�the�Main Menu > Model Tools�menu�or�by�right�clicking�in�the�
Model Window�display�area.�����

Viewpoint Tools  

There�are�several�tools�for�moving�the�model�around�in�3D�space�to�look�
at�it�from�different�viewpoints.��These�all�operate�using�click�and�drag�
with�the�left�mouse�button.���

With�the� Rotate model�button�selected,�dragging�the�mouse�rotates�
the�object�in�all�directions�about�its�center�in�3D�space.���

With�the� �Move model�button�selected,�dragging�the�mouse�moves�
the�object�left,�right,�up�or�down.���

The� Spin model�button�causes�the�mouse�to�rotate�the�object�on�the�
screen�around�the�object�s�center.���

Using�the� Zoom model�button,�dragging�up�and�down�the�screen�
moves�the�object�forwards�and�backwards,�making�it�appear�larger�or�
smaller.��The�mouse�wheel�can�also�be�used�to�do�this.���

TIP: Holding�down�Ctrl�will�temporarily�swap�between�pairs�of�
these�tools�(swapping�rotate�and�spin�or�zoom�and�move),�
returning�to�the�original�tool�when�the�key�is�released.

Clicking�the� Reset view�button�will�return�the�model�to�its�default�
position.��This�zooms�out�to�make�the�whole�object�visible�in�the�window�
and�rotates�it�to�be�viewed�from�the�direction�of�the��tick�mark��found�on�
the�calibration�mat.���
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Clicking�the� �Last view�button�will�return�the�viewpoint�to�a�
previous�position.���

Clicking�the� �Next view�button�after�Last view�will�move�forward�in�
the�viewpoint�history.���

Display Options

These�options�affect�what�is�seen�in�the�Model window;�and,�in�
particular,�how�the�model�is�drawn.��Depending�on�the�features�that�have�
been�generated�for�the�model,�not�all�of�these�options�will�be�available.���

TIP: It�is�sometimes�helpful�to�hide�the�texture�to,�for�example,�look�
for�deformities�in�the�shape.��You�can�also�change�the�colors�
used�for�the�window�background�and�the�wireframe�by�opening�
The Strata Foto 3D Settings Window�using�the�
File > Settings...  menu�item�or�by�clicking�the��

Change settings...  button.

The� View wireframe model�button�displays�the�model�as�a�mesh�
with�outlines�around�the�edge�of�each�triangle.��This�can�be�used�to�get�a�
feel�for�how�many�triangles�are�currently�being�used�in�the�mesh�and�
where�they�are�dense�or�sparse.���

The� View flat shaded model�button�displays�the�model�as�a�solid�
object�but�without�texture.��This�is�a�good�display�mode�to�use�when�
reducing�the�number�of�triangles�in�the�mesh�using�the�Decimation�Slider�
(in�order�to�reduce�file�size�and�loading�time)�since�you�can�more�easily�
see�when�the�shape�of�the�object�starts�to�deform�due�to�over�
simplification�(excessive�decimation).���

The� �View textured model�button�displays�the�final�model�with�a�
texture�map�generated�from�the�photos.���

TIP: You�can�use�keyboard�shortcuts�to�swap�between�display�
modes:�View wireframe model�(F5),�View flat shaded 
model�(F6)�and�View textured model�(F7).��

The�Show Mat�checkbox�toggles�the�display�of�a�virtual�calibration�mat.��
This�can�be�useful�to�understand�the�object�s�orientation,�particularly�
during�and�after�alignment�operations.���
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When�the�textured�model�is�displayed,�the�Light Source�checkbox�
toggles�a�virtual�light�source.��This�is�a�useful�preview�if�you�are�
intending�to�export�the�model�to�a�3D�editing�package�where�you�might�
relight�it.���

The�Display Mode > Display Cameras�menu�item�toggles�the�display�
of�all�of�the�camera�positions�for�the�images�used�in�the�project.��This�is�
helpful�for�examining�the�pattern�of�photographs�being�used�to�model�an�
object�to�determine�if�any�key�angles�were�missed,�as�opposed�to�
inadequately�masked.���

Alignment Window Tools  

Alignment�is�explained�in�the�section�Adding Texture to the Bottom of 
an Object�in�Chapter�8.��During�alignment�operations,�the�image�being�
aligned�is�displayed�as�a�backdrop�behind�the�model�so�that�the�model�
can�be�positioned�to�match�the�image.��To�help�do�this�more�accurately,�
there�is�a�set�of�tools�that�are�enabled�only�during�alignment�operations.���

With�the� Magnify View�button�selected,�dragging�the�mouse�up�and�
down�the�screen�zooms�into�or�out�of�the�current�image,�allowing�more�
or�less�detail�to�be�seen.��This�differs�from�Zoom model�which�moves�
the�object�closer�to�the�camera,�thereby�altering�the�perspective;�instead,�
this�tool�keeps�the�object�fixed�relative�to�the�background�image.���

With�the� Pan View�button�selected,�dragging�the�mouse�scrolls�
around�the�image,�moving�the�object�and�the�background�image�as�a�unit.��
Again�this�differs�from�Move model�which�would�move�the�object�
relative�to�the�background�image.���

TIP: Holding�down�the�Ctrl�key�will�temporarily�swap�between�
these�two�tools,�returning�to�the�original�tool�when�the�key�is�
released.

Clicking�on�the� Full Image�button�will�reset�the�magnification�so�
that�the�whole�image�fits�in�the�window.���
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Decimation Slider  

The�model�is�generated�as�a�highly�detailed�triangle mesh�and�a�
technique�known�as�decimation�is�used�to�allow�the�number�of�triangles�
used�to�form�the�exported�model�s�mesh�to�be�varied�interactively.��
Reducing�the�number�of�triangle�is�usually�desirable�as�it�reduces�the�
model�s�complexity,�which�therefore�reduces�it�s�file�size,�loading�time�
and�the�memory�and�processing�power�needed�by�3D�modeling�software�
to�render�it.��As�the�number�of�triangles�is�reduced,�the�vertices�that�
contribute�least�to�the�shape�of�the�object�are�successively�removed,�
resulting�in�a�simpler�mesh�with�fewer�triangles.���

The�number�of�triangles�used�to�form�the�currently�displayed�mesh�is�
shown�in�the�Model�palette.��Below�it,�there�is�a�slider�that�can�be�used�to�
interactively�change�the�number�of�triangles.��Alternatively,�you�can�type�
a�number�directly�into�the�number�of�triangles�textbox.���

Note: If�the�slider�is�replaced�with�a�Decimate�button,�then�you�have�
probably�canceled�the��initializing�decimation��process.��Click�this�button�
to�setup�the�model�for�decimation�and�re�display�the�slider.�

You�can�change�the�number�of�triangles�even�after�the�model�has�been�
textured,�but�it�may�be�worth�re�generating�the�texture�once�the�final�
number�of�triangles�has�been�selected,�to�best�match�the�texture�to�the�
new�mesh.��See�the�section�on�Adjusting�Decimation�in�the�section�
Building the Wireframe Model�in�Chapter�5�for�more�on�choosing�an�
appropriate�number�of�triangles.���

Note: The�Sub�Division�Surface�(SDS)�tools�for�smoothing�a�mesh�in�
Strata�3D�CX,�Silo�and�similar�modeling�software�will�further�smooth�the�
tri�mesh�produced�by�Foto�3D.��If�you�intend�to�apply�subdivision�
smoothing,�it�is�advantageous�to�view�the�model�in�wireframe�mode��
and�use�this�decimation�tool�to�simplify�the�mesh�to�its�minimum�
essential�structure.�
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Geometry Editing Tools  

The�buttons�in�this�group�are�used�to�modify�the�shape�of�the�existing�
model�and�are�enabled�only�after�a�3D�wireframe�model�has�been�
generated.���

The� Create silhouette�button�will�create�a�new�image�in�the�project�
from�the�current�viewpoint,�using�the�current�geometry�to�define�the�
mask�for�the�image.��This�mask�can�then�be�edited�and�will�modify�the�
geometry�next�time�the�surface�is�generated.��If�texture�has�also�been�
generated,�you�will�be�offered�the�chance�to�save�a�rendering�of�the�
model�as�a�new�image�file�in�the�project�folder.��The�section�on��
Improving the Model By Adding Silhouettes�in�Chapter�7�explains�how�
to�use�this�feature.���

When�the� Move clip plane�button�is�selected�the�clipping�plane�is�
shown�in�the�window.��Dragging�the�mouse�up�and�down�moves�the�
plane�up�and�down.��Because�photos�are�usually�taken�from�above�the�
object,�there�is�usually�a�slight��dome��remaining�under�the�base�of�the�
object.��Clipping�is�used�to�remove�any�wireframe�structure�associated�
with�the�stand�that�the�object�was�placed�on.��To�hide�the�clipping�plane�
without�applying�it,�simply�drag�it�down�below�the�base�of�the�model.���

Clicking�the� Clip model�button�causes�wireframe�geometry�below�
the�current�position�of�the�clipping�plane�to�be�cut�off.��You�can�undo�this�
operation�by�selecting�the�Edit Model > Undo Model Edit�menu�item.���
See�“clipping�away�the�stand”�in�the�section�on�Building the Wireframe 
Model�in�Chapter�5�for�more�details.���

Texture Editing Tools  

Once�a�texture�map�has�been�generated,�it�can�be�edited�using�an�
intuitive�2D�interface�by�taking�a�snapshot�of�the�rendered�model�from�a�
particular�viewpoint,�modifying�it�in�a�separate�image�editing�software�
package,�and�then�pasting�it�back�into�the�model.��The�sections�on�texture�
editing�in�Chapter�8�describe�different�ways�in�which�this�technique�can�
be�used��
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Clicking�the� Copy View�button�renders�a�snapshot�of�the�model�
from�the�current�viewpoint�and�places�it�on�the�clipboard.��This�is�the�
preferred�method�for�editing�the�texture�with�an�image�editor�such�as�
Adobe�Photoshop�or�Corel�Paint�Shop�Pro.���

Clicking�the� Paste View�button�blends�the�image�on�the�clipboard�
into�the�current�texture�map.��This�is�the�preferred�method�of�overlaying�
an�edited�texture�image�from�a�photo�editor�such�as�Adobe�Photoshop�in�
place�of�the�original.��The�image�dimensions�must�be�left�unchanged�so�
that�the�returned�image�has�the�same�dimensions�as�the�other�images�in�
the�project.��You�can�undo�this�operation�by�selecting�the��
Edit Model > Undo Model Edit�menu�item.���

3.7.  The Strata Foto 3D Settings Window  

The�Strata Foto 3D Settings Window�is�shown�in�Figure 3.7.1.���
It�can�be�opened�by�clicking�the� �Change settings...  button�or�
choosing�the�File > Settings...  menu�item.���

Figure 3.7.1.  The Strata Foto 3D Settings Window with default options. 
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All�settings�are�saved�with�and�loaded�from�the�Foto�3D�Project�file�
except�for�the�"Automatically scroll canvas when painting"�option.��
These�settings�will�be�restored�as�the�defaults�the�next�time�you�load�the�
project.��To�return�to�the�default�values�for�all�settings,�select�the�
Defaults�button.��Click�the�OK�button�to�keep�any�changes�you�have�
made�and�close�the�window.��If�you�click�the�Cancel�button,�the�Settings 
Window�will�close�and�any�changes�you�have�made�will�be�discarded.���

Most�of�the�settings�can�be�adjusted�when�doing�individual�processing�
steps,�however�it�can�be�useful�to�set�up�default�values�so�that�operations�
such�as�the�Processing > Make All�menu�item�can�run�without�
interruption.���

"Mask Generation Settings"  

These�settings�affect�the�automatic�mask�generation�process�initiated�by�
the�Mask Generation Wizard�and�initial�position�for�the�mask slider�for�
the� Regenerate mask�button�and� Shrink-Wrap Mask�button.���

The�"Background detection threshold"�controls�how�much�of�the�
image�is�treated�as�background�when�it�is�masked.��A�higher�value�causes�
more�of�each�image�to�be�masked.��Adjust�this�value�if�you�generally�find�
too�much�or�too�little�of�each�image�is�included�in�the�mask.���

When�the�"Use color normalization"�option�(visible�on�the�Mask�
palette�as�the�"Shadows"�option)�is�selected�the�auto�masking�process�
tries�to�compensate�for�shadows�falling�on�the�backdrop.��If�you�have�a�
controlled�lighting�setup,�it�is�best�to�deselect�this�option.���

When�the�"Use sub-sampled images"�option�is�enabled,�in�order�to�
speed�up�the�masking�and�texturing�processes,�Foto�3D�will�resample�
photos�to�create�lower�resolution�versions�whenever�the�source�photos�
are�more�than�roughly�3.5�megapixels�in�resolution�(triggered�by�being�
over�1,500�pixels�on�the�short�dimension).���

Note: If�you�wish�to�create�the�highest�possible�quality�model,�deselect�
this�option;�but,�realize�that�the�maximum�size�of�the�final�texture�map�
covering�all�sides�of�the�object�is�1600x1600�pixels�and�so�any�additional�
detail�retained�in�source�images�may�nevertheless�be�lost�in�the�final�
texture�map.�
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"Wireframe Generation Properties"  

These�settings�affect�the�wireframe�generation�process�initiated�by�using�
the�Wireframe�Generation�Wizard.���

The�"Silhouette decimation threshold"�is�used�to�remove�unwanted�
detail�in�the�silhouettes�before�generating�the�surface.��A�higher�number�
has�the�effect�of�smoothing�the�silhouette�outlines�before�the�wireframe�
model�is�constructed.��This�will�avoid�too�many�unwanted�triangles�
being�created�and�speed�up�the�process.��If�you�want�to�capture�every�last�
detail�in�your�silhouettes,�reduce�this�value.���

The�"Default number of triangles"�determines�the�initial�number�of�
triangles�used�to�display�the�model�when�it�is�created.��The�number�of�
triangles�can�also�be�changed�interactively�after�the�wireframe�model�has�
been�generated.���

"Texture Generation Properties"  

These�settings�affect�the�texture�generation�process�initiated�by�the�
Texture Wizard.���

The�"Texture map size"�sets�the�size�in�pixels�of�the�resulting�texture 
map.��The�texture�map�is�always�square�and�the�size�determines�the�
tradeoff�between�the�detail�in�the�texture�and�the�amount�of�storage�
required�for�the�texture�map�and�loading�time�when�viewing�the�model�
online.��Generally,�values�such�as�512,�768�or�1024�pixels�tend�to�be�
adequate�for�most�uses.��For�Foto�3D,�the�maximum�texture�size�is�1600�
pixels.��(For�the�Professional�version�the�maximum�is�4096�pixels.)��

When�the�"Tone correct textures"�for�shadows�flag�is�enabled,�
Foto�3D�will�try�to�compensate�for�variations�in�exposure�between�the�
images�which�would�otherwise�cause�the�surface�texture�to�have�
unwanted�variations�in�intensity.��If�you�are�using�controlled�lighting�
conditions�or�are�experiencing�unwanted�color�shifts�in�the�textures,�you�
may�prefer�to�turn�this�option�off.���

When�the�"Texture boosting"�option�is�enabled,�Foto�3D�automatically�
picks�a�set�of�about�6�key�views�and�uses�these�to�add�detail�to�the�
texture map.��Otherwise,�Foto�3D�will�attempt�to�blend�together�
information�from�all�the�images,�which�can�result�in�unwanted�blurring�
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or�shadowing�of�details,�particularly�if�there�is�any�slight�mis�registration�
of�images�due�to�errors�in�the�lens�calibration,�inaccuracies�in�the�mesh�
geometry,�or�movement�of�the�object�during�photography.��Images�can�be�
manually�selected�for�boosting�by�revising�the�processing�order�using�the�
Images > Image Order�menu�item�in�the�Thumbnail�Viewer.���

"Export Properties"  

This�setting�affects�the�default�value�that�appears�in�the�Export Window.��
The�"Texture quality"�compression�setting�reduces�the�size�of�the�
texture map�image�file�by�increasing�the�compression�at�the�risk�of�
producing�compression�artifacts�that�reduce�texture�quality.���
This�value�is�set�between�1�(lowest�quality)�and�100�(highest�quality).���

"Workspace Properties"  

These�settings�control�how�masks�and�models�are�displayed�in�the��
Mask Window�and�Model Window.���

Various�colors�are�used�in�the�interface�and�can�be�altered�to�suit�the�
images�and�object�being�modeled.��Altering�the�displayed�mask�color�can�
be�very�helpful�during�mask�editing.��Similarly,�when�aligning�images,�
changing�the�wireframe�or�solid�colors�can�make�it�easier�to�see�fine�
detail.��Clicking�on�any�of�the�colors�opens�a�standard�color�selection�
dialog.���

The�"Automatically scroll canvas when painting"�option�can�be�
disabled�to�stop�the�Display�Window�from�automatically�scrolling�when�
painting�a�mask�area�that�falls�near�the�edge�of�the�display�window.��
With�certain�graphics�cards�or�alternative�mouse�hardware,�such�as�a�
graphics�tablet,�this�feature�may�make�painting�difficult.���

�
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4.1.  What You Will Need  

�

You�will�need�the�following�items:��

� The�object�you�want�to�model��

� A�stand�or�pedestal�for�the�object��

� A�smooth�plain�color�backdrop��

� A�Foto�3D�calibration mat��

� Optional���a�turntable�

�
�

Figure 4.1.1.  An object, on a stand,  
with a backdrop. 

TIP: Adhere�the�mat�and�pedestal�to�a�turntable�or��lazy�susan��to�
allow�the�object,�pedestal�and�mat�to�be�easily�rotated�as�a�unit.�

The Object 

Foto�3D�works�well�with�many�kinds�of�objects�but�may�have�trouble�
modeling�transparent�objects�such�as�items�made�of�non�colored�glass,�
extremely�complicated�shapes�like�a�hairbrush,�or�highly�reflective�
objects�like�mirrors�or�chrome,�and�objects�with�deep�recesses�like�a�
coffee�cup.���
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Figure 4.1.2.  The Foto 3D calibration mat

The Mat The Mat 

The�Foto�3D�calibration mat�is�a�flat�sheet�of�paper�or�card�stock�printed�
with�special�markings�that�Foto�3D�uses�to�determine�the�angle�from�
which�each�photograph�was�taken.��The�mat�has�a�small�tick�mark�that�
the�software�associates�with�the��front�view��of�the�object.��While�aligning�
the�object�to�the�tick�is�not�necessary�and�the�default��front�view��can�be�
changed�at�export;�it�is�a�bit�more�convenient�if�they�are�aligned��

The�Foto�3D�calibration mat�is�a�flat�sheet�of�paper�or�card�stock�printed�
with�special�markings�that�Foto�3D�uses�to�determine�the�angle�from�
which�each�photograph�was�taken.��The�mat�has�a�small�tick�mark�that�
the�software�associates�with�the��front�view��of�the�object.��While�aligning�
the�object�to�the�tick�is�not�necessary�and�the�default��front�view��can�be�
changed�at�export;�it�is�a�bit�more�convenient�if�they�are�aligned��

The�Foto�3D�calibration mat�can�be�printed�from�within�the�Foto�3D�
software,�using�the�
The�Foto�3D�calibration mat�can�be�printed�from�within�the�Foto�3D�
software,�using�the� �Print mat...  button�on�the�Main Window�toolbar.���
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The�mat�must�be�perfectly�flat�and�it�is�recommended�that�the�calibration�
mat�be�firmly�adhered�onto�a�rigid�flat�surface.���

For�smaller�objects,�a�mat�may�be�printed�on�a�sheet�of�letter�size�white�
card�stock�or�heavyweight�paper.��You�can�select�the�paper�size�and�mat�
diameter�by�choosing�the�File > Page Setup...  menu�item.��All�of�the�
important�calibration�mat�features�lie�within�the�outer�circle�and�the�mat�
must�be�large�enough�for�the�dot�pattern�to�be�visible�when�viewed�from�
the�top.��(See�Figure 4.1.2.)��Printing�the�mat�with�a�diameter�2.2���2.5�
times�wider�than�the�object�is�usually�ideal.��For�example,�a�12�inch�
diameter�mat�printed�on�Super�B�(13�x19�)�card�stock�fits�an�object�up�to�
about�5.5�inches�in�diameter.���

TIP: The�mat�may�be�trimmed�to�the�outer�circle.��If�you�do�trim�the�
mat,�make�sure�it�lies�flat�(not�curling�up�at�the�edges),�and,�if�
necessary,�adhere�it�to�a�flat�rigid�surface�such�as�foam�core�or�
gator�board.��Even�the�slightest�bending�or�curling�of�the�
calibration�mat�will�distort�your�models.

The Stand 

A�stand�or�pedestal�is�useful�for�raising�the�object�away�from�the�
markings�on�the�mat�and�reducing�shadows�cast�onto�the�mat.��It�also�
helps�to�better�shape�the�bottom�edges�of�models�by�completely�
surrounding�the�object�s�bottom�edge�with�backdrop�by�using�a�pedestal�
that�is�narrower�than�the�object.���

The�ideal�stand�is::��
� Able�to�support�the�object.���
� Narrower�than�the�object�s�base.���
� Opaque�and�non�reflective.���
� The�same�color�as�the�backdrop�(for�automatic�masking).���
� Stable�enough�to�keep�the�object�from�moving�relative�to�the�mat�

when�rotated.��(Adhere�it�to�the�mat�if�necessary).���

TIP: If�the�stand�and/or�object�is�too�large�and�excessively�overlaps�
the�markings�on�the�calibration mat,�you�will�need�to�use�a�
larger�mat.�
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The Backdrop 

The�ideal�backdrop�is�an�untextured,�uncreased,�solid�color�matte�surface�
that�will�provide�a�consistent�contrasting�background�behind�the�object.��
This�will�allow�Foto�3D�to�automatically�determine�which�parts�of�the�
image�correspond�to�the�object�during�masking.��If�you�are�unable�to�use�
a�suitable�backdrop,�you�will�spend�more�time�manually�masking�the�
photographs.��(See�the�section�on�Masking Photographs�in�Chapter�5.)��

The�backdrop�should�be:�

� plain�colored�or�white�with�a�non�reflective�matte�finish.���

� smooth�and�free�from�marks�or�creases.���

� able�to�fully�surround�the�object�from�the�camera’s�viewpoint.���

When�possible,�choose�a�color�that�is�not�present�in�the�object�and�
generally�contrasts�with�the�object.��Light�colors�work�better�than�dark�
colors.��Avoid�large�backgrounds�with�strong�colors,�including�chroma�
tint�green�or�blue,�as�they�can�add�a�color�cast�to�reflective�sides�of�the�
model.��Light�neutral�gray�is�best�for�objects�with�shiny�or�reflective�
surfaces.���

TIP: A�large�sheet�of�white��foam�core��posterboard�works�as�a�quick,�
inexpensive�and�effective�backdrop.��Also,�making�an�
�enclosure��of�additional�sheets�of�white�foam�core�placed�on�
the�sides�and�tilted�at�45�degrees�will�help�diffuse�and�bounce�
light�coming�from�above�to�the�sides�of�an�object.�

The�Foto�3D�software�assumes�that�any��features��it�finds�as�it�traces�
around�the�outline�of�the�object�belong�to�the�object.��If�Foto�3D�is�unable�
to�separate�object�from�background�automatically,�you�may�need�to�mask�
the�images�by�hand�using�the�masking�tools.���
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4.2.  Lighting and Camera Setup

Lighting Setup  

Foto�3D�can�handle�photographs�taken�under�a�variety�of�conditions�and�
will�correct�for�many�lighting�problems.��Two�typical�studio�style�setups�
are�shown�below,�one�a�beginning�low�budget�desktop�arrangement�and�
the�other�a�typical�professional�studio�setup.��This�chapter�is�a�basic�
overview�of�the�process.��Advanced�tips�for�achieving�more�professional�
results�and�using�the�software�more�efficiently�are�outlined�in�Chapter�6.���

Figure 4.2.1.  Basic setup. Figure 4.2.2.  Professional studio setup.

Observe�the�following�points:��

� Avoid�strong�shadows�on�the�backdrop,�calibration mat�or�object.���

� Make�sure�there�is�enough�light�to�take�pictures�without�having�
to�use�the�on�camera�flash.���

� Light�both�sides�of�the�object�with�the�same�color�lights.��
(Avoid�working�near�a�window.)��

Camera Setup  

A�high�quality�camera�will�produce�the�best�results;�however�the�camera�
does�not�need�to�be�high�resolution.��The�detail�obtainable�with�images�in�
excess�of�about�3.5���5.0�megapixels�is�lost.���

� Use�a�digital�camera.���

� Use�a�high�quality�setting�to�minimize�JPEG�compression�artifacts.���
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� Mount�the�camera�on�a�rigid�tripod.���

� Disable�the�built�in�flash�to�prevent�strong�shadows�and�
speculars.���

� If�the�camera�has�digital�zoom,�disable�it.���

� If�the�camera�has�spot�focus,�use�it�to�focus�on�the�object�and�mat.���

� Verify�the�lens�is�free�of�dust,�smudges�and�fingerprints.���

� Best�results�are�obtained�by�locking�the�exposure�or�shooting�
manual�exposure�and�reducing�the�aperture�to�increase�the�depth�
of�field�(area�in�focus)�as�much�as�possible.���

4.3.  Taking Photographs  

Foto�3D�requires�around�20�photographs,�taken�from�various�angles,�to�
create�a�3D�model�of�an�object.���

Before you begin...   

� Check�that�the�stand�and�the�object�are�stable,�and�will�not�
wobble�or�fall�over�when�the�mat�is�turned�(adhere�them�together�
if�necessary�and/or�use�a�turntable).���

� Setup�the�camera�and�tripod�so�that�the�object�and�mat�
completely�fill�the�frame�by�getting�in�close�or�using�a�zoom�lens,�
but�they�must�not�go�off�the�edge�of�the�frame�in�any�photo.���

� If�you�use�a�zoom�lens,�you�should�keep�the�same�setting�for�all�
of�the�pictures�you�need�to�take.��While�the�Foto�3D�software�can�
recognize�and�usually�accommodate�a�change�in�the�zoom�setting�
of�the�lens,�it�is�best�to�find�an�optimum�setting�to�use�for�all�shots�
and�leave�it�unchanged�for�the�duration�of�the�project.���

� If�the�software�does�not�recognize�the�lens�settings�of�your�
camera,�you�may�be�asked�to�calibrate�the�lens.��If�so,�try�to�do�so�
at�the�same�zoom�setting�that�you�used�to�shoot�the�project.��(The�
calibration�process�is�described�in�Calibrating the Lens�in�the�
Appendix.)��
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� If�using�a�turntable�and�your�camera�is�on�a�tripod,�fully�rotate�
the�object�and�mat�prior�to�shooting�to�ensure�the�object�remains�
in�the�frame�at�all�rotation�angles.���

� If�the�camera�allows�you�to�lock�the�exposure�settings�or�
manually�set�exposure,�do�so.���

� Before�shooting,�it�is�recommended�that�you�upload�a�sample�
photo�to�the�software�and�check�it�for�lighting�issues�that�may�
affect�the�efficiency�of�the�auto�masking�function�(described�later).���

It�does�not�matter�if�the�backdrop�obscures�some�of�the�markings�on�the�
calibration�mat�as�long�as�the�front�half�of�the�mat�is�fully�visible.���

Once�you�begin�taking�photographs,�do�not�shift�the�object�s�position�on�
the�stand�or�the�stand�relative�to�the�calibration�mat.��If�the�object�is�
accidentally�moved�relative�to�the�mat,�discard�the�previous�photos�and�
shoot�again.���

After�you�have�taken�your�photographs,�do�not�crop�or�resize�the�images�
in�any�way.��All�the�images�must�be�the�same�size�as�one�another�or�
Foto�3D�will�refuse�to�accept�them�as�input.���

Taking Side Views 

For�this�first�set,�take�about�15�photographs�of�the�sides�of�the�object�from�
different�angles.��The�mat�has�15�rows�of�dots�that�can�conveniently�be�
used�to�line�up�each�rotation.��You�will�discover�in�later�chapters�that�up�
to�30�or�more�side�view�shots�may�be�preferred�for�creating�a�very�precise�
model�of�a�rounded,�smooth,�unusually�shaped�object;�while�only�4�or�8�
shots�may�be�all�that�s�really�needed�to�fully�model�a�box.���

Figure 4.3.1.  A set of side views of an object rotated through a full revolution 
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Frame�these�views�so�that�the�calibration mat�takes�up�about�one�third�of�
the�total�image.��The�camera�should�be�at�the�midline�of�the�object,�
looking�slightly�downwards�to�ensure�the�mat�is�clearly�visible�as�shown�
in�Figure 4.3.2.��Make�sure�for�these�side�view�photos�that�the�bottom�of�
the�backdrop�fully�surrounds�the�object�and��cuts�through��the�stand.���

Figure 4.3.2.  Correct camera position for the first set of photos. 

TIP: Use�a�turntable�or�rotate�the�mat�either�clockwise�or�counter�
clockwise�so�that�each�of�the�15�sets�of�calibration�dots�aligns�
with�the�camera.�

Taking High-Angle Photographs 

Take�an�additional�three�to�seven�photographs�from�a�higher�angle�
looking�downward�on�the�object,�as�shown�in�Figure 4.3.3.���
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Figure 4.3.3.  Correct camera position for high-angle photographs. 

The�elevation�of�the�camera�should�be�high�enough�to�look�downward�on�
the�object,�without�actually�being�a�top�down�photograph;�about�a�60�
degree�angle�above�the�midline.���

A�minimum�of�three�photographs�should�be�taken�from�different�
viewpoints�by�rotating�the�calibration mat�and�object�to�three�positions,�
roughly�120�degrees�apart.��If�more�photos�are�needed�to�capture�surface�
texture�and�silhouette�details,�adjust�the�spacing�accordingly.���
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Taking a Top-Down Photograph 

Figure 4.3.4.  Top-down view of the object. 

Take�a�single��top�down��(i.e.,�bird�s�eye�view)�photograph�of�the�object,�
as�shown.���

It�is�important�to�ensure�that�the�object�does�not�excessively�overlap�too�
many�of�the�mat�markings.��If�this�happens�then�it�is�possible�to�take�the�
photo�from�a�slight�angle�to�ensure�that�more�of�the�markings�are�fully�
visible�in�the�photograph.��If�the�object�is�large�for�the�mat,�take�a�set�of�
two�or�three�photos�from�as�high�an�angle�as�you�can�while�still�being�
able�to�see�the�inside�row�of�dots�on�at�least�half�of�the�mat.���
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Figure 4.3.5.  Generated Model with "Camera View" turned "on",  
showing the camera positions and angles of the "included" project photos. 

This��Camera�View��display�(activated�by�selecting�the�Images >  
View Camera�menu�item)�shows�the�pattern�of�photos�described�in�this�
section:�15�side�views,�in�this�case�5�high�angle�views�and�a�top�down�
view.���

TIP: After�generating�a�wireframe�(described�later)�that�appears�to�
have�irregularities�in�it�s�shape,�it�may�be�convenient�to�turn�on�
�Camera�View��to�see�if�any�important�photo�angles�were�
missed�so�that�you�may�shoot�any�missing�shots,�add�them�to�
the�project,�and�regenerate�the�initial�wireframe.�

4.4.  Saving and Uploading Photographs  

Once�the�set�of�photographs�have�been�taken,�they�should�be�uploaded�
onto�your�computer�and�saved�in�a�separate�(new)�directory�for�use�with�
Foto�3D.��Be�sure�that�your�upload�software�does�not�attempt�to�crop�or�
resize�the�images.��You�do�not�need�to�rotate�portrait�orientation�images�
to�face��up�;�the�Foto�3D�software�will�detect�and�rotate�them�for�you.���

Foto�3D�accepts�images�in�TIFF,�JPEG,�PNG,�or�BMP�format.���
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It�is�recommended�that�all�photographs�of�a�particular�object�be�saved�in�
the�same�directory:�this�will�make�it�easier�to�select�them�when�creating�a�
Foto�3D�Project.���

After�photos�are�added�to�a�project,�Foto�3D�immediately�begins�to�
prepare�thumbnails�and�analyze�them�to�determine�the�orientation�of�the�
camera�and�calibration�mat,�and�whether�lens�distortion�can�be�corrected�
using�the�EXIF�data�provided�in�the�image�or�using�a�lens�calibration�
profile�that�has�been�created�and�saved.��If�EXIF�data�is�missing�and�a�
lens�profile�has�not�been�loaded,�then�Foto�3D�will�report�the�problem�
and�suggest�launching�the�Lens�Calibration�Wizard.���

With�newer�cameras,�most�users�will�never�have�to�use�the�Lens�
Calibration�Wizard�and�so�the�steps�for�using�the�wizard�to�create�and�
load�a�lens�profile�are�described�in�the�Appendix.���

TIP: If�your�camera�is�newer�than�the�current�edition�of�the�software,�
visit�the�Strata�Foto�3D�Support�page�on�the�www.Strata.com�
website�(find�the�link�in�the�Help�menu)�to�download�the�latest�
version�of�the�file�camera.txt,�the�database�of�camera�lenses�that�
have�been�carefully�tested�and�profiled�for�use�with�Foto�3D.��
The�new�file�simply�replaces�the�current�one�in�the�program�
installation�directory.��Close�and�reopen�the�Foto�3D�software�
for�the�new�file�to�take�effect.

Additional Photos 

For�some�models�there�may�be�a�need�to�take�additional�photographs.��
For�example,�a�photograph�taken�of�the�underside�of�an�object�can�be�
used�to�add�texture�detail�to�the�bottom�surface�of�a�model.��These�photos�
can�either�be�included�in�the�project�from�the�outset�or�added�later�(in�
which�case�it�is�useful�to�make�their�names�easily�distinguishable).��Use�
the�Images > Add Images�menu�item�to�add�photos�to�an�existing�
project.���

It�is�sometimes�helpful�to�shoot�additional�photos�of�the�object,�such�as�
the�bottom,�with�the�object�sitting�on�the�pedestal�with�the�mat�included.��
An�advantage�is�that�a�carefully�selected�Background�Threshold�setting�
might�mask�this�photo�as�well�as�it�masks�others�without�any�additional�
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effort.��In�order�to�make�auto�masking�available�for�these�photos,�either�
interactively�or�using�Mask All�and�the�Mask�Generation�Wizard,�the�
software�needs�to�have�the�mat�visible�in�the�image�to�help�identify�the�
object�s�position�and�which�areas�are�to�be�treated�as�object�and�which�are�
background.��Without�a�mat,�the�only�interactive�tool�available�is��
Shrink�Wrap.��(Both�tools�are�described�in�Chapter�7.)��

TIP: IMPORTANT���If�you�happened�to�take�a�photo�of�the�bottom�
of�the�object�with�the�calibration�mat�visible�in�the�frame,�or�
additional�photos�of�the�object�in�a�different�position�on�the�mat�
than�the�rest�of�the�photo�set,�you�must�be�sure�to�mark�these�
images�"rejected"�before�trying�to�generate�an�initial�
wireframe�model.��If�not,�either�the�software�will�report�that�it�is�
unable�to�generate�a�wireframe,�or�the�resulting�wireframe�will�
be�totally�corrupted.

See�the�section�called�Adding Texture to the Bottom of an Object�in�
Chapter�8�for�details�about�how�additional�photographs�taken�without�
the�mat�may�be�aligned�and�used�to�add�in�additional�texture�to�a�model.���

�
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5.1.  The Sequence of Events in Foto 3D

As�described�in�the�Introduction,�there�are�five�major�steps�to�creating��
a�Foto�3D�model:�Photograph,�Mask,�Model,�Texture�and�Export.���
The�heart�of�the�modeling�process�itself�involves�the�three�stages;�
Masking,�Modeling,�and�Texturing.��These�stages�are�repeated�and�
refined�as�necessary�until�the�desired�result�has�been�achieved.���
The�following�diagram�illustrates�the�process.���

Figure 5.1.1.  Basic Foto 3D process. 
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The�process�starts�with�a�set�of�photographs.���

� Masking���Through�a�process�called�masking,�the�outline�of�the�object�
is�determined�from�the�viewpoint�of�each�photo�to�create�a�silhouette�
of�the�object.��The�same�mask�is�usually�used�to�also�identify�the�
usable�areas�of�each�photo�for�painting�the�model�s�surface.���

� Modeling���The�silhouettes�from�all�of�the�photos�are�combined�to�
create�a�3D�wireframe�mesh,�a�mathematical�model�that�defines�the�
object�s�shape�in�3D�space.��The�surface�of�that�mesh�is�refined�and�
smoothed�through�a�process�called�Surface�Optimization�and�then�
simplified�through�a�process�called�Decimation.���

� Texturing���Finally,�the�masked�images�are�used�again�to�project�
color�and�texture�onto�the�outside�surface�of�the�3D�model.���

Each�of�these�processes�has�a�Wizard�tool�that�greatly�simplifies�the�work�
involved�in�modeling�most�objects.��The�remainder�of�this�chapter�covers�
each�of�these�process�wizards�in�greater�detail.���

5.2.  Starting a New Project  

To�create�a�new�Foto�3D�Project,�upload�a�set�of�photos�to�your�computer,�
launch�the�Foto�3D�software,�then�select�the�File > New�menu�item�or�
click�the� New project...  button.��A�dialog�box�for�opening�files�will�
appear�for�you�to�select�image�files�to�add�to�the�new�project.���

Figure 5.2.1.  The Image Selection and Loading Dialog Box. 

STRATA FOTO 3D - Chapter 5
Creating A Model - The Workflow

66



Note: Multiple�files�may�be�selected�in�the�dialog�by�holding�down�the�
Shift�key�to�select�a�range.��The�Ctrl�key�may�also�be�used�to�add�or�
remove�clicked�files�to�or�from�the�selection.��Use�the�drop�down�file�type�
filter�to�show�only�images�of�a�particular�file�type.�
�

Try It Out! 

Foto�3D�is�supplied�with�several�sets�of�sample�photos�for�you�to�learn�
the�software,�such�as�those�in�the�Examples\Oblith�directory�included�
with� your� installation.� � You� can� add� all� the� photos� found� in� this�
directory�to�a�new�project.��The�photos�of�the�bottom�of�an�object�that�do�
not� include� the� calibration mat� will� automatically� be� marked� as�
"rejected"�(just�click�OK�to�accept�this).��Any�photos�of�the�bottom�that�
also�have�the�mat�will�need�to�be�marked�"rejected"�by�you�before�you�
build�a�wireframe�(as�a�reminder,�their�filenames�will�have��rejectme��in�
them).� � These� bottom� photos� will� be� used� later� as� described� in� the�
section�Adding Texture to the Bottom of an Object�found�in�Chapter�8.���

�

TIP: Once�a�project�has�been�created,�you�can�drag�and�drop�
additional�image�files�from�Windows�Explorer�into�Foto�3D.��
Alternatively,�use�the�Images > Add Images...  menu�item.

After�selecting�the�desired�images,�Foto�3D�will�load�them�and�try�to�
determine�the�camera�location�for�each�image.��Once�the�camera�
information�has�been�calculated,�each�image�is�shown�rotated�so�that�it�
appears�right�way�up.���
�

Lens Calibration 

If�Foto�3D�does�not�recognize�the�camera�lens�you�are�using,�you�will�be�
asked� if� you�wish� to� launch� the� Lens� Calibration�Wizard.� � Standard�
zoom� lenses� and� wide�angle� lenses� may� exhibit� significant� lens�
distortion.� �The�Lens�Calibration�Wizard�allows�you� to� take�additional�
photos� for� the� purpose� of� eliminating� lens� distortion� to� improve� the�
modeling� accuracy.� � (See� Calibrating the Lens� in� the� Appendix� for�
instructions�on�using�this�wizard.)�
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Figure 5.2.2.  A mixture of photos being loaded with landscape and portrait framing.  
Once analyzed, Foto 3D rotates images to display "right-side up". 

Note: The�image�files�as�stored�in�the�project�folder�must�all�be�in�the�
same�orientation�(landscape�or�portrait)�and�be�the�same�size�in�pixels.��
This�does�not�mean�the�photographer�cannot�shoot�all�the�photos�of�an�
object�in�a�combination�of�landscape�and�portrait�framing;�it�just�means�
to�wait�and�let�Foto�3D�handle�the�rotation�of�any�portrait�orientation�
images�as�they�are�loaded�in�the�project.��Rotating�any�files�in�advance�of�
loading�in�Foto�3D�will�cause�them�to�be��rejected.��

If�the�calibration mat�could�not�be�found�in�the�image,�or�if�sufficient�
areas�of�the�mat�are�not�clearly�visible,�then�the�image�will�be�marked�as�
"rejected"�and�an�error�message�displayed.��This�might�be�caused�by�
the�markings�being�too�light�or�blurred�for�Foto�3D�to�identify�the�pattern.������

TIP:TIP: Check�the�lighting�by�loading�a�few�test�photographs.��If�the�
images�are�being�rejected,�try�shooting�from�a�higher�angle�to�
ensure�a�good�view�of�the�calibration mat,�re�check�the�lighting�
and�be�sure�the�background�is�not�covering�too�much�of�the�mat.
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5.3.  Masking Photographs  

After�shooting�and�adding�photos�to�the�project,�the�first�stage�in�using�
Foto�3D�to�generate�a�model�is�to�mask�the�images.���Masking�the�images��
refers�to�the�process�of�identifying�the�object�and�separating�it�from�the�
background,�pedestal,�and�anything�else�that�appears�in�the�photo.��This�
section�of�the�User�Guide�explains�the�basic�process�for�automatically�
masking�images�within�Foto�3D�using�the�auto�masking�process�in�the�
Mask�All�Images�Wizard.���

The�reference�section�in�Chapter�3�about�The Mask Window and Palette�
explains�how�to�manually�edit�a�single�mask�within�Foto�3D.���

More�advanced�masking�tools�and�techniques�are�described�in�Chapter�7,�
including�...���

� Fine Tuning the Auto-Masking Process��
� Masking with the Shrink-Wrap tool��
� Using Clean Mask with Shrink-Wrap to Mask a Set of Images��
� Editing Masks with an External Application��

Using the Mask All Images Wizard  

Step 1 

If�you�want�to�automatically�mask�all�the�images�(or�all�the�unmasked�
images),�click�the� Mask all images...  button�to�launch�the�Mask
Wizard�to�guide�you�through�the�auto�masking�process.���

If�you�just�want�to�apply�auto�masking�to�a�few�of�the�images,�you�can�
select�them,�then�click�the�Masking > Mask Images... menu�item.��
This�opens�the�same�Mask Wizard�as�before,�but�only�affects�the�masks�of�
the�currently�selected�images.���

Try It Out! 

To� try� this� out,� follow� the� instructions� in� the� Starting a New Project�
section�to�create�a�new�project�from�the�images�in�the�Examples\Oblith�
directory�included�with�your�installation.���
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Step 2 

Before�the�masking�operation�starts,�you�may�modify�the�parameters.���

Figure 5.3.1.  Mask Generation Wizard - Settings Dialog. 

If�you�want�to�discard�all�the�existing�masks�on�your�images,�then�select�
the�"Replace any existing masks"�option.��If�some�images�have�had�
their�masks�manually�edited,�then�unselect�this�option�to�prevent�
Foto�3D�from�over�writing�these�edits.���

You�should�select�the�"Use color normalization"�option�if�you�think�
you�might�have�shadows�or�variations�in�lighting�on�the�backdrop.��
Foto�3D�will�attempt�to�compensate�for�the�shadows�and�avoid�treating�
them�as�part�of�the�object.���

The�"Background detection threshold"�field�lets�you�change�the�
threshold�that�is�used�to�separate�the�foreground�from�the�background.��
You�should�only�change�this�from�the�default�value�if�you�are�having�
problems�generating�the�masks�(see�Step�4,�below).���
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Step 2 

Before�the�masking�operation�starts,�you�may�modify�the�parameters.���

Figure 5.3.1.  Mask Generation Wizard - Settings Dialog. 

If�you�want�to�discard�all�the�existing�masks�on�your�images,�then�select�
the�"Replace any existing masks"�option.��If�some�images�have�had�
their�masks�manually�edited,�then�unselect�this�option�to�prevent�
Foto�3D�from�over�writing�these�edits.���

You�should�select�the�"Use color normalization"�option�if�you�think�
you�might�have�shadows�or�variations�in�lighting�on�the�backdrop.��
Foto�3D�will�attempt�to�compensate�for�the�shadows�and�avoid�treating�
them�as�part�of�the�object.���

The�"Background detection threshold"�field�lets�you�change�the�
threshold�that�is�used�to�separate�the�foreground�from�the�background.��
You�should�only�change�this�from�the�default�value�if�you�are�having�
problems�generating�the�masks�(see�Step�4,�below).���

Step 3 

Click�the�Next >�button�to�start�the�masking�process.���

Figure 5.3.2.  Mask Generation Wizard - Progress Bar -( Click "Back" to revise settings 
and restart.) 

�

TIP: If�you�have�an�image�displayed�in�the�Mask Window�when�you�
initiate�auto�masking,�you�will�see�each�image�displayed�as�it�is�
masked.

Step 4 

Check�through�the�masks�by�looking�at�the�thumbnails�in�the�Thumbnail 
Window�or�load�each�one�into�the�Mask Window�by�double�clicking�on�
each�thumbnail�or�by�dragging�the�thumbnail�into�the�display�area.���

It�is�important�that�no�part�of�the�object�becomes�covered�by�the�mask�in�
any�of�the�images;�otherwise�some�of�the�object�will�be�carved�away�
when�you�create�the�3D�wireframe�model.��It�is�less�important�that�all�of�
the�background�is�masked,�since�Foto�3D�will�often�be�able�to�use�masks�
from�several�other�images�to�define�the�shape�of�the�object.���

STRATA FOTO 3D - Chapter 5
Creating A Model - The Workflow

71



Figure 5.3.3.  Mask Examples - Left mask with unmasked pedestal is OK,  
Center mask is overmasked causing deformity in model shown at right. 

Shown�above�are�a�couple�examples�of�masking.��In�the�first�example,�
this�mask�is�OK�as�long�as�the�shape�of�the�base�of�the�object�is�either�
masked�clearly�in�another�image�or�the�Clipping Plane�tool�is�used�to�
remove�the�pedestal.��In�the�second�example,�this�mask�must�be�altered;�
otherwise,�the�result�will�be�the�model�on�the�right�that�has�a�gash�cut�
through�it.��This�overmasking�by�the�auto�masking�process�is�caused�by�a�
reflection�of�the�background�onto�the�object�s�glossy�surface�being�
masked�as�a�continuation�of�the�background.���

TIP: The�automatic�masking�process�requires�good�contrast�between�
the�background�and�the�object.��A�good�choice�of�background�
color�will�result�in�much�better�automatic�masking.��Lighting�
can�also�affect�the�results.�

If�the�masks�do�not�look�right�as�they�are�being�generated,�click�the�Back�
button�to�return�to�the�Mask Generation Window�and�either�try�changing�
the�parameters�or�use�Interactive�Masking�to�determine�the�best�
parameters�(Interactive�Masking�is�described�in�Chapter�7).���

If�areas�of�the�background�are�consistently�not�being�masked�then�
increase�the�"Background detection threshold".��If�regions�of�the�
object�are�being�incorrectly�included�in�the�mask,�then�reduce�this�
number.���

You�can�try�adjusting�this�setting�through�trial�and�error�by�changing�it�
by�about�a�tenth�at�a�time.��The�range�of�permitted�values�is�0.1���10.0.��
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The�value�is�used�as�a�multiplier,�so�a�one�tenth�change�has�a�more�
profound�effect�at�the�lower�end�of�the�scale.���

TIP: We�find�applying�the�interactive�masking�process�in�Chapter�7�
to�a�representative�side�view�image�to�be�a�much�more�
expedient�way�to�determine�the�optimum�threshold�setting�to�
use�on�the�project�as�a�whole.��Once�that�optimum�threshold�has�
been�determined,�this�wizard�can�be�re�launched�to�mask�all�of�
the�images�using�that�optimum�setting.��For�convenience,�the�
setting�is�automatically�inserted�as�the�new�default�value�for�this�
threshold.�

It�is�also�better�to�under�mask�(use�a�lower�value)�rather�than�risk�having�
the�mask�accidentally�penetrate�the�object�in�one�or�two�images�(as�
shown�in�the�previous�example)�and�then�apply�the�Shrink-Wrap tool�
described�in�the�section�Masking with the Shrink-Wrap tool�in�Chapter�7�
to�improve�some�of�the�masks�if�the�resulting�wireframe�does�not�
conform�well�to�the�object.���

Step 5 

When�you�are�finished,�click�the�Finish�button�to�close�the�Mask Wizard.���

In�some�cases�the�automatic�masking�of�an�image�may�not�be�perfect;�but�
this�is�not�a�problem�as�the�masked�images�can�be�improved�individually�
as�explained�in�the�sections�on�Fine Tuning the Auto-Masking Process�
and�Masking with the Shrink-Wrap tool�in�Chapter�7.���

TIP: It�can�be�useful�to�save�masks�associated�with�a�set�of�images�in�
order�to�use�them�in�another�Foto�3D�Project.��Use�the�
Masking > Save Masks...  menu�item�to�do�this.��Each�mask�
is�saved�using�the�same�filename�as�the�photo�it�corresponds�
with,�but�with�a�different�file�extension.��This�makes�it�easy�to�
select�and�load�the�masks�into�a�new�project.
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5.4.  Building the Wireframe Model  

Generating�a�3D�wireframe model�is�the�second�stage�in�completing�a�
Foto�3D�model.��The�wireframe�model�represents�the�shape�of�the�object�
reproduced�as�a�triangle�mesh.��Foto�3D�uses�the�mask�associated�with�
each�of�the�images�to�deduce�the�shape�of�the�object�from�its�silhouettes.���

The�following�basic�operations�for�producing�a�wireframe model�are�
described�in�this�section�...���

� Using the Wireframe Generation Wizard��
� Adjusting Decimation��
� Clipping Away the Pedestal��

More�advanced�techniques�can�be�found�in�Chapter�7:��

� Optimizing Surface Geometry��
� Improving the Model By Adding Silhouettes��
� Modeling Parts of an Object��

Using the Wireframe Generation Wizard  

Starting Point 

You�should�create�masks�for�a�sufficient�number�of�images�before�you�do�
this�operation.��The�minimum�requirement�is�three�masked�images,�but�
you�will�usually�need�between�10�and�30�masked�photos�to�capture�the�
shape�of�most�objects.���

�

Try It Out! 

To� try� this� out,� load� the� oblith.som� project� from� the� Examples\Oblith�
directory� with� your� installation� which� already� has� masked� images.��
It�already�has�a�mesh�created,�but�you�can�generate�a�new�one.���
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Step 1 

The�wireframe model�is�generated�with�the�help�of�the�Wireframe�
Generation�Wizard�which�is�launched�by�clicking�on�the� �Generate
Wireframe... button�or�selecting�the�Processing > Generate 
Wireframe... menu�item.���

Figure 5.4.1.  Launching the Wireframe Generation Wizard  
to create a wireframe model from masks. 

When�the�Wireframe Generation Wizard�is�opened,�choose�the�first�
option,�"Generate Wireframe"�to�create�the�initial�mesh�and�then�click�
the�Next�button�to�proceed�to�the�next�page�of�the�wizard.��(The�other�
option�is�described�in�the�section�on�Optimizing Surface Geometry�in�
Chapter�7.)���

STRATA FOTO 3D - Chapter 5
Creating A Model - The Workflow

75



Step 2 

You�can�alter�various�parameters�before�generating�the�wireframe.��You�
will�find�that�the�default�values�will�be�sufficient�in�most�cases.���

Figure 5.4.2.  Parameters for generating a wireframe. 

The�"Silhouette decimation threshold"�setting�affects�the�complexity�
of�the�triangle�mesh�generated�from�the�silhouettes�and�saved�in�the�
project�file,�before�it�has�had�any�decimation�applied.��This�threshold�can�
be�set�from�1�to�100�and�represents�the�number�of�pixels�of�distance�that�
is�allowed�between�the�closest�triangle�s�outer�edge�and�the�masked�edge�
of�the�object.��A�small�value�improves�the�model�s�accuracy�in�terms�of�
how�closely�it�conforms�to�each�silhouette�by�causing�mesh�edges�to�be�
broken�into�many�smaller�line�segments�and�therefore�more�triangles�are�
used�to�more�closely�track�to�a�silhouette.��A�very�low�value�combined�
with�masks�having�very�jagged�edges�may�also�create�geometry�that�
exceeds�the�memory�of�your�computer�and�require�extremely�long�
processing�times�to�compute.��Also,�the�masks�for�these�key�edges�must�
be�of�similar�accuracy�to�truly�have�any�benefit�derived�from�the�extra�
complexity�and�processing�required�the�higher�accuracy�requirement.���
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If�you�are�using�images�larger�than�about�4�megapixels�and�have�turned�
off�the�"Use sub-sampled images"�option�in�the�Strata Foto 3D 
Settings Window,�then�you�will�most�likely�want�to�use�a�higher�number�
of�pixels�in�this�setting,�in�proportion�to�the�larger�dimensions,�in�pixels,�
of�the�photos.��Setting�this�value�in�the�2���5�pixel�range�generally�
produces�the�best�results.���

The�default�value�for�the�"Default number of triangles"�setting�is�set�
in�the�Strata Foto 3D Settings Window�and�is�usually�left�unchanged�in�
this�window�since�the�interactive�decimation�slider�in�the�Model�Palette�
allows�the�triangle�count�to�be�changed�at�any�time.��This�setting�simply�
determines�the�default�complexity�of�the�triangle�mesh�when�it�is�first�
displayed�in�the�Model�Window.���

These�default�values�for�these�two�options�are�set�in�the�Strata Foto 3D 
Settings Window,�and�also�described�in�the�reference�section�on�The
Strata Foto 3D Settings Window�in�Chapter�3.���

Step 3 

Click�the�Next�button�to�start�generating�the�wireframe.���

Figure 5.4.3.  Progress screen for generating a wireframe. 
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You�won�t�see�any�results�until�the�process�has�completed,�but�you�can�
cancel�part�way�through�if�it�seems�to�be�taking�an�excessively�long�time.��
To�reduce�processing�time�or�minimize�the�number�of�unexpected�stripe�
like�artifacts�in�the�mesh,�try�clicking�the�Back�button,�then�increase�the�
"Silhouette decimation threshold".���

When�the�process�is�complete,�clicking��Finish��will�close�this�window�
and�the�model�will�be�made�ready�for�the�next�step,�adjusting�decimation.���

TIP: If�you�are�experimenting�with�changing�parameters,�you�can�
return�to�the�last�wireframe�you�generated�by�closing�the�
Wireframe Generation Wizard�then�using�the��

Undo model or mask change�button

Adjusting Decimation  

Figure 5.4.4.  Effect of the Decimation Slider. 
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The�model�is�stored�as�a�triangle mesh�and�a�technique�known�as�
decimation�is�used�to�allow�the�number�of�triangles�in�the�mesh�to�be�
varied�interactively.���

It�is�possible�to�adjust�the�decimation�of�the�wireframe�model�using�the�
slider�in�the�Model�palette.��Moving�the�slider�to�the�left�decreases�the�
model�s�polygon�count�(reducing�the�definition�of�the�final�model);�
moving�the�slider�to�the�right�increases�the�model�s�polygon�count�
(improving�the�definition�and�fine�detail�in�the�model�s�mesh).���

Note: If�a�Decimate�button�is�displayed�in�the�place�of�the�slider,�then�
click�the�button�and�wait�for�the�decimation�information�to�be�calculated.��
(This�can�occur�as�a�result�of�canceling�certain�operations.)�

Internally,�Foto�3D�retains�all�of�the�mesh�detail�captured�from�the�
silhouettes�when�the�wireframe�is�generated.��This�allows�you�to�change�
the�number�of�triangles�used�for�display�at�any�time,�even�after�a�texture�
map�has�been�created.��Remember,�however,�that�the�following�
operations�will�use�just�the�triangles�currently�displayed�in�the�mesh:��

� Exporting�the�model�will�only�export�the�displayed�triangles.���

� Generating�a�texture�map�will�upwardly�limit�the�number�of�
triangles�to�those�currently�displayed�at�the�time�it�was�generated.��
(To�display�more�triangles,�discard�and�regenerate�the�texture.)��

�

TIP: Use�as�many�triangles�as�you�require�to�model�the�object�and�no
more.��The�best�way�to�choose�an�appropriate�number�is�to�
view�the�model�in�either�View textured model�(F7)�mode�or�
View flat shaded model�(F6)�mode�and�then�reduce�the�
number�of�triangles�until�you�see�unacceptable�distortion�of�the�
model�surface�due�to�over�simplification.���

There�are�several�reasons�to�minimize�the�number�of�triangles:��

� Models�with�large�numbers�of�triangles�are�slower�to�
download�over�the�web�and�require�more�processing�power�
to�display.��An�overly�complex�model�can�exceed�the�64Mb�
memory�limit�for�Java�based�viewer�software�like�
Strata�Live�3D.���
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� If�you�plan�to�include�the�model�in�a�larger�scene�using�
modeling�software�like�Strata�3D�CX,�simpler�models�reduce�
the�total�memory�required�to�manipulate�and�display�scenes;�
particularly�those�with�many�objects.��The�complexity�also�
significantly�impacts�the�rendering�time�required�for�scenes�
and�animations.���

� Finally,�advanced�modeling�tools�like�sub�division�surface�
(SDS)�modeling�in�Strata�3D�CX�are�more�effective�with�a�
simpler�starting�mesh.���

Clipping Away the Pedestal  

Sometimes�there�will�be�unwanted�geometry�that�looks�like�a�dome�or�
cone�at�the�base�of�the�object.��This�is�usually�due�to�photos�not�being�
taken�from�a�low�enough�angle�to�shape�the�bottom�surface�of�the�object�
(a�consequence�of�shooting�side�view�shots�from�a�higher�angle,�closer�to�
midline�of�the�object,�to�ensure�the�calibration mat�is�fully�visible).���
Also,�the�auto�mask�process�may�have�considered�the�pedestal�to�be�part�
of�the�object�and�not�the�backdrop�(usually�due�to�shadows).���

�

Figure 5.4.5.  Steps for clipping off an unmasked portion of the pedestal. 
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Step 1 

Select�a�side�view�of�the�object�where�you�can�clearly�see�the�geometry�
you�want�to�remove.���

Select�the� Move clip plane�button�on�the�Model�Palette�and�you�will�
see�the�clipping�plane�displayed�below�the�model.���

Step 2 

With�the�left�mouse�button�pressed,�drag�the�mouse�upwards�to�move�
the�clipping�plane�up�until�it�is�placed�at�the�desired�location�to�trim�the�
bottom�off�of�the�model.��All�geometry�below�the�plane�will�be�removed.���

Step 3 

At�this�point,�a�quick�way�to�rotate�the�model�to�see�the�clipping�plane�
from�a�different�angle�is�to�hold�down�the�Ctrl�key�to�temporarily�switch�
to�the�rotate�model�tool.���

Step 4 

Click�the� Clip model�button�to�complete�the�process.��It�will�take�a�
moment�for�Foto�3D�to�reconstruct�the�mesh�without�the�clipped�
geometry.���

You�can�use� �Undo model or mask change�button�to�return�to�the�
previous�geometry�if�you�have�removed�too�much.���

If�you�decide�not�to�complete�the�clipping�operation,�you�can�hide�the�
clipping�plane�by�dragging�it�off�the�bottom�of�the�screen.���
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5.5.  Adding Surface Texture  

Generating�a�surface�texture�to��paint��the�model�is�the�third�stage�of�
completing�a�model�in�Foto�3D.��This�section�explains�how�to�create�a�
texture map�for�the�model.���

The�process�of�generating�a�texture map�uses�the�wireframe�model�and�
the�original�photos�to�determine�how�each�triangle�should�be�colored.��
The�information�from�these�images�is�blended�together�to�provide�a�
seamless��baked�on��texture.���

More�advanced�texturing�operations�are�described�in�Chapter�8:��

� Adding Texture to the Bottom of an Object��
� Editing the Surface Texture��
� Removing Texture Artifacts��

Using the Texture Generation Wizard  

Starting Point 

Load�and�mask�a�set�of�photos�and�generate�a�wireframe�mesh.���

�

Try It Out! 

To� try� this� out,� load� the� oblith.som� project� from� the� Examples\Oblith�
directory� with� your� installation.� � Although� it� already� has� a� texture�
created,�you� can�generate�a�new�one.� �To� see� this� clearly,� click�on� the��

Generate Wireframe...  button�or�select�the�Processing > Generate 

Wireframe...  menu� item� to� regenerate� the�wireframe,�which�will�also�
discard�the�existing�texture.�����

Step 1 

Open�the�Texture Wizard�by�clicking�the� �Generate texture map...  
button.���
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Step 2 

Figure 5.5.1.  Parameters for generating a surface texture. 

Before�you�start�generating�the�texture,�you�can�alter�the�settings��
(these�options�are�described�in�more�detail�in�the�reference�section�on��
The Strata Foto 3D Settings Window�in�Chapter�3):��

� Use�"Texture map size"�to�set�the�dimensions�of�the�final�texture�
map�in�pixels.��The�maximum�size�is�1600�pixels�for�Foto�3D�(up�to�
4096�pixels�for�the�Professional�version).��Use�a�value�of�512�pixels�for�
an�object�with�little�detail�or�1024�pixels�for�an�object�with�more�detail.���

� The�"Tone correct textures"�option�is�used�to�enhance�the�color�of�
the�images�and�compensate�for�uneven�lighting.��This�option�
normalizes�the�unmasked�areas�of�each�image�so�that�images�blend�
more�consistently.��Turn�this�option�off�for�photo�sets�shot�in�a�
controlled�lighting�environment.���

� The�"Texture boosting"�option�emphasizes�a�small�set�of�key�
images�when�building�the�textures.��When�turned�off,�all�images�are�
used.���

�
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TIP: With�"Texture boosting"�turned�on,�Foto�3D�automatically�
selects�the�key�images�according�to�Project�Order�and�the�
spacing�of�images�around�the�object.��You�can�manually�select�
an�image�as�high�priority�and�override�the�automatic�image�
ordering�by�switching�the�Thumbnail Window�to�details�mode�
and�using�the�Images > Image Order�menu.

Step 3 

Click�the�Next�button�to�start�the�texture�generation�process.���

Figure 5.5.2.  Progress screen for generating a texture. 

As�each�image�is�processed,�the�model�is�updated�to�reflect�the�current�
texture�map.��You�can�stop�texture�generation�when�you�are�satisfied�
with�the�results,�or�leave�it�to�finish�processing�the�remaining�images.���

If�you�are�trying�different�settings,�you�can�use�the� Undo model or 
mask change�button�to�return�to�the�previous�state�of�the�texture�for�
comparison.��Click�the�Back button�to�stop�processing,�change�settings�
and�restart�the�process.���

�
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Masking Out Reflections in Textures 

Foto�3D�excludes�masked�(background)�regions�from�the�textures.���
If�there�are�specular�highlights,�reflections,�or�other�undesirable�
features�on�an�image,�you�can�manually�mask�these�regions�prior�to�
building�the�textures.��(Do�this�after�generating�the�wireframe�or�by�
using�an�image�marked��texture�only�;�otherwise�the�mask�changes�will�
affect�the�shape�of�the�model�the�next�time�a�wireframe�is�generated.)���

�
5.5.3.  1) Reflection in final texture,   2) Step 1 - Locate photo having reflection,  

3) Step 2 - Use mask tools to hide reflection (set image type to "texture only"), and  
4) Step 3 - Regenerate Texture (another photo will fill in the masked area). 

In�the�alternative,�you�can�load�two�copies�of�the�same�photo�and�use�it�
with�one�mask�for�generating�geometry�and�with�another�mask�for�
generating�texture.��Select�the�already�loaded�image�and�click�the�Image

Type > Geometry Only�menu�item�so�that�this�image�and�it�s�mask�are�
used�only�to�create�the�wireframe�mesh.��Use�the�menu�item�to�select�the�
same�photo�in�the�project�folder�and�load�a�second�instance�of�it.��With�
this�second�copy�selected,�click�the�Image Type > Texture Only�menu�
item�so�that�this�duplicate�copy�of�image�and�it�s�mask�are�used�only�to�
create�the�texture�map.��Then�create�a�mask�to�hide�the�unwanted�
highlights�and�reflections.��This�two�mask�approach�allows�you�the�
flexibility�to�regenerate�the�wireframe�model�at�any�time�using�the�
original�mask�and�regenerate�the�texture�using�the�“texture�only”�mask.��
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Note: In�the�event�you�create�two�masks�using�the�same�photo�and�
choose�to�Save�Masks,�because�masks�are�named�according�to�the�photo�
they�are�associated�with,�the�second�mask�to�be�saved�will�overwrite�the�
first�one�without�warning.��Solve�this�by�saving�the�masks�individually�
using�two�different�directories.��Avoid�this�by�copying�the�source�photo�
in�Windows�Explorer�and�giving�it�a�different�name�before�going�to�the�
step�of�adding�the�second�image.��This�causes�the�second�mask�to�be�
saved�using�the�different�file�name.��If�you�are�not�concerned�about�
saving�the�masks�individually�to�use�in�another�project,�then�the�
procedure�suggested�in�this�Tip�works�just�fine.�

5.6.  Exporting the Finished Model

Now�that�your�Foto�3D�model�is�completed,�this�section�describes�how�to�
export�your�model�for�viewing�outside�Foto�3D��

Refer�to�Chapter�9�for�additional�details�about�using�your�new�model�
with�other�applications�and�viewers.���

Figure 5.6.1.  The Foto 3D Export Window with the Export Type drop-down list displayed. 
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Foto�3D�can�export�models�in�one�of�3�formats�by�using�the��
�Export model...  button�or�the�File > Export...  menu�item.���

� WRL���VRML�2.0��

� WRZ���Compressed�VRML�2.0��

� 3DS���3D�Studio�Max�compatible�object�file��

Many�of�the�output�formats�create�several�different�files.��During�export,�
you�will�be�prompted�before�overwriting�any�existing�files.��Canceling�
will�cancel�the�export�but�may�leave�some�already�exported�files�in�the�
selected�export�directory.���

Export Dialog Options 

"Use current orientation":�this�checkbox�applies�to�VRML�exports�
(WRL�and�WGZ)�and�rotates�the�exported�model�so�that�it�will�initially�
appear�facing�the�same�direction�as�currently�displayed�in�the�Model 
Window.��If�left�unchecked,�the�front�view�is�determined�by�the�tick�mark�
on�the�calibration�mat�and�the�object�will�appear�in�the�same�orientation�
as�it�does�after�clicking�the�Reset View�menu�item�button.���

"Texture quality":�controls�the�size�of�the�texture�map�by�changing�the�
JPEG�compression�level�to�produce�a�smaller�file�size�at�the�expense�of�
reducing�the�texture�quality�and�creating�artifacts.��This�field�accepts�a�
value�between�1�(lowest�quality)�and�100�(highest�quality).��A�value�
between�65�and�95�is�usually�recommended.���

"Auto-launch viewer":�when�this�checkbox�is�selected,�Foto�3D�will�
attempt�to�open�the�exported�file�in�an�external�application.��The�file�
associations�setup�in�the�operating�system�determine�which�application�
(if�any)�is�launched.���

Exporting to VRML 2.0  

These�options�export�the�model�to�VRML�2.0�format�for�viewing�directly�
with�a�VRML�viewer�or�for�importing�into�other�applications�such�as�
Strata�3D�CX.��Two�files�are�produced�by�this�export�option:��

� WRL�or�(WRZ)�file�containing�the�model�itself.���

� JPG�file�containing�the�texture�map.���
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The�WRZ�file�is�just�the�WRL�file�but�compressed�using�ZIP�for�faster�
transmission.��It�can�be�read�by�most�viewers�that�handle�VRML.���

The�WRL�format�is�preferred�for�maximum�compatibility�with�the�
highest�level�of�model�detail.��The�WRL�format�is�imported�seamlessly�by�
Strata�3D�CX,�Silo�and�Strata�Live�3D.���

Exporting a 3D Studio Max Object  

This�option�exports�the�model�to�a�file�suitable�for�reading�by�software�
that�accepts�the�3D�Studio�Max�file�format.��The�following�files�are�
produced�by�this�export�option:��

� 3DS�file�containing�the�model��

� JPG�file�containing�the�texture�map.���

The�3DS�Format�is�an�older,�less�sophisticated�object�file�format.��If�given�
a�choice,�use�the�more�feature�rich�VRML�format.���
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6.1.  Lighting and Camera Setup

Lighting Advice for Professional Studios ...

� Use�diffused�light�sources�such�as�softboxes.���

� Flood�the�scene�evenly�from�all�sides;�avoid�hotspots.���

� Avoid�or�cover�point�lights�that�will�cause�speculars.���

� Use�a�matte�white�reflector�above�the�object.���

� Minimize�shadows�cast�from�the�object.���

Figure 6.1.1.  Professional studio setup. 
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Tips for Experienced Photographers  

� Experienced�photographers�should�use�their�camera�in�manual�mode.��
Use�manual�exposure�and�F�stop�to�ensure�all�the�photographs�are�
taken�under�the�same�conditions.��(Or�use�a��lock�exposure��feature.)��

� Use�the�smallest�aperture�(as�large�an�F�stop)�as�possible�in�order�to�
maximize�the�depth�of�field�so�that�the�entire�object�and�calibration 
mat�are�in�sharp�focus.���

� Experiment�with�the�exposure�settings�until�the�correct�exposure�is�
achieved,�or�use�a�standard�grey�chart�and�light�meter.���

� Adjust�the�white�balance�manually�and�lock�it�for�the�series�to�
prevent�unevenness�or�shifts�in�white�balance.���

� If�you�have�an�even�exposure�and�consistent�white�balance�in�a�series�
of�photos,�be�sure�that�the�"Tone correct textures"�checkbox�is�not�
checked�in�the�Strata Foto 3D Settings Window.��Also,�if�you�upload�
using�a�third�party�photo�editor,�disable�any�automatic�correction�
features.���

6.2.  Taking the Right Photos  

Figure 6.2.1.  Generated Model with "Camera View" turned "on" to show the  
camera positions and angles of the "included" project photos. 
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In�general,�Foto�3D�will�produce�very�good�models�using�the�
recommended�pattern�for�photos,�as�shown.��Exceptionally�accurate�
models�can�be�produced�if�a�large�number�of�photos�(as�many�as�30�to�50)�
are�taken�from�a�range�of�different�angles�and�precise�masks�are�applied.��
However,�you�may�use�fewer�photos�and�obtain�equal�or�better�results�if�
the�photos�are�taken�from�some�carefully�selected�strategic�angles.���

By�analyzing�the�type�of�object�being�modeled�you�can�determine�the�
right�number�of�photographs�to�take�and�which�viewing�angles�are�most�
suitable.��This�Chapter�gives�some�examples�for�different�types�of�objects.���

Box-like Cubic Objects 

When�photographing�objects�that�have�flat�faces,�such�as�the�cube�shown�
below,�it�is�recommended�that�photographs�be�taken�from�a�very�slight�
angle�such�that�one�face�is�minimally�visible.��In�the�case�of�a�cube,�this�
would�require�taking�photographs�with�the�front�face�facing�directly�at�
the�camera�and�one�side�just�slightly�visible;�and�repeating�for�the�
opposite�side.���

�

�
�

The�reason�for�this�lies�in�how�Foto�3D�generates�wireframe�models,�and�
the�problem�faced�by�Foto�3D�can�be�best�illustrated�in�the�following�
diagram.���

�

�

�
�

�

The�diagram�shows�the�actual�object,�a�cube,�with�two�photographs�
shown�of�the�cube.��The�actual�cube�is�shown,�along�with�the��shadow��
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that�is�hidden�from�view�in�the�photographs.��The�region�of�space�
represented�by�the��shadow��cannot�be�seen,�and�therefore�Foto�3D�can�
make�no�judgment�regarding�whether�this�region�is�filled�by�the�object,�
or�not.���

When�building�a�wireframe,�Foto�3D�works�by,�in�effect,�carving�away�
parts�of�the�object�using�silhouettes.��By�taking�photographs�that�are�
orientated�to�glance�down�the�edge�of�a�face,�Foto�3D�is�able�to�carve�that�
face�more�precisely.���

�

�

�

�

�

�

The�following�diagrams�show�this�technique�in�practice.��These�are�two�
examples�of�a�rectangular�box�object.��One�was�created�using�
photographs�taken�at�various�angles�around�the�object;�the�other�had�
four�additional�photographs�taken�at�glancing�angles�down�each�side�of�
the�object.���

Figure 6.2.2.  Results from the usual 15 
equally-spaced side view photos. 

Figure 6.2.3.  Results from eight 
glancing side-view photos. 
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While�the�model�on�the�left�appears�mostly�cubic�in�shape,�there�is�a�
visible�ridge�on�the�face�of�each�side.��The�faces�of�the�cube�are�almost�flat,�
but�due�to�the�angles�that�the�photographs�were�taken,�the�ridge�remains�
visible.��Once�textured�with�the��baked�on��textures�generated�by�Foto�3D,�
these�ridges�will�hardly�be�noticeable.��Still,�the�two�halves�of�the�faces�
will�reflect�light�slightly�differently�in�a�lighted�scene�and�it�will�be�
particularly�noticeable�if�the�object�is�animated.���

By�comparison,�the�model�on�the�right�has�very�sharp�edges�since�the�
photographs�were�taken�from�an�angle�almost�parallel�to�each�face.��Their�
masks�have�allowed�Foto�3D�to�carve�very�smooth�faces�and�sharp�
corners.���

Cylindrical Objects 

When�photographing�objects�that�have�a�cylindrical�shape,�it�is�essential�
to�provide�Foto�3D�with�numerous�photographs�around�the�periphery�of�
the�cylinder.���

�

�

�
�

�

While�Foto�3D�can�carve�away�at�the�shape�with�each�photo,�it�can�only�
do�so�using�what�could�be�imagined�as�a�virtual�knife.��This�is�very�good�
for�straight�edges�and�cubes,�but�when�presented�with�a�cylindrical�object,�
the�process�can�result�in�squared�sides�rather�than�round�curves.��This�
problem�is�alleviated�using�a�geometry�optimization�tool�in�Foto�3D�that�
smoothes�the�surface�where�there�is�no�evidence�of�sharp�edges.��When�
the�angle�between�two�surfaces�is�the�same�as�the�angle�the�camera�
shifted�between�the�two�photos�that�formed�the�silhouettes�that�make�up�
the�two�faces,�this�tool�presumes�that�the�surface�between�these�two�faces�
is�a�smooth�curve.��See�Optimizing Surface Geometry�in�Chapter�7.���

Even�with�the�optimization�tool,�the�user�should�still�provide�Foto�3D�
with�a�reasonable�number�of�images,�taken�at�various�angles,�around�the�
periphery�of�the�cylindrical�shape.��While�Foto�3D�will�continue�to�create�
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the�initial�wireframe�by�slicing�off�straight�edges,�the�number�of�straight�
edges�may�be�increased�to�the�point�that�when�the�cylindrical�shape�is�
produced,�especially�after�optimization,�it�will�appear�round�and�smooth.���

The�following�diagram�shows�the�suggested�maximum�spacing�between�
camera�views�taken�of�a�typical�cylindrical�object.���

�

�

�

�

�

�

�

�

�

�

�

The�following�two�models�demonstrate�the�difference�between�taking�6�
photographs�and�30�photographs�of�a�cylindrical�object�(without�
optimization).���
�

�

�

Figure 6.2.4.  Difference in modeling a jar from 6 and 30 photographs  
(before smoothing). 
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The�following�two�models�demonstrate�the�difference�between�taking�6�
photographs�and�30�photographs�of�a�cylindrical�object�(without�
optimization).���
�

�

�

Figure 6.2.4.  Difference in modeling a jar from 6 and 30 photographs  
(before smoothing). 

Mixed Objects - Cubic and Cylindrical 

When�dealing�with�objects�that�have�both�flat�and�curved�surfaces,�as�
would�be�the�case�for�many�objects,�then�care�should�be�taken�to�ensure�
that�a�suitable�set�of�photographs�are�taken�by�applying�both�of�these�
principles���shoot�along�flat�faces,�shoot�all�around�the�periphery�of�
cylindrical�surfaces.���

�

�

�
For�example,�if�the�camera�illustrated�above�is�modeled�from�
photographs�taken�just�from�the�side,�then�Foto�3D�cannot�see�a�correct�
silhouette�of�the�camera�from�above,�and�therefore�would�not�be�able�to�
correctly�model�the�lens.���

The�flat�sides�and�cylindrical�lens�need�to�be�taken�into�account.��The�flat�
surfaces�require�photographs�to�be�taken�glancing�down�each�of�the�flat�
surfaces�to�ensure�a�clean�edge�is�obtained.��The�cylindrical�lens�also�
needs�a�number�of�photographs�taken�around�it,�to�ensure�that�Foto�3D�is�
able�to�correctly�model�the�curved�surface�correctly.���

�

�

�
�

TIP: An�object�like�this�camera�might�achieve�a�better�result�if�it�was�
shot�on�it�s�back�so�that�the�lens�is�pointing�up,�as�shown�in�the�
second�illustration.��This�would�allow�the�usual�15�side�view�
photos�to�define�the�cylindrical�lens�well.��Another�eight�photos�
would�make�sure�the�flat�faces�were�captured�from�each�end.���
A�bottom�shot�would�texture�the�back�surface.�

The�following�models�show�the�effects�of�not�taking�enough�suitable�
photographs�compared�to�a�more�carefully�chosen�set�of�photographs.���
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�
Figure 6.2.7.  Models from a poorly planned and a well planned set of photos. 

�

Figure 6.2.5.  Precisely capturing the 
left and right edges. 

Figure 6.2.6.  Precisely capturing the  
crescent's silhouette. 

These�three�photographs�nearly�completely�define�the�shape�of�the�
crescent�shaped�wood�bottle�holder.��The�left�and�right�edge�shots�define�
the�uniform�thickness�of�the�crescent.��The�side�photo�defines�the�inside�
and�outside�shape�for�much�of�the�right�hand�portion�of�the�object.���

Additional Photos for Texturing 
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The�best�photos�for�texturing�a�
surface�are�those�taken�from�a�
nearly�front�on�angle,�
perpendicular�to�the�surface.��
Usually�the�same�photos�that�
produce�a�well�defined�silhouette�
also�capture�the�surface�facing�the�
camera.��For�example,�the�photo�
that�glances�down�the�side�of�a�
cube�also�clearly�captures�detail�
on�the�front�face�of�the�cube.���

Figure 6.2.8.  Side View with silhouette 
that perfectly "slices" the back of this 

jewelry box. 

Note�that�this�photo�for�capturing�
the�back�side�of�a�jewelry�box�(flat�
face�at�the�right)�also�fully�
captures�the�texture�on�the�side�of�
the�box�facing�the�camera.��To�
avoid�the�need�for�precision�
alignment�of�the�camera�and�
object�as�in�this�photo,�shooting�
the�same�edge�from�opposite�sides�
will�ensure�that�the�corners�of�the�
final�shape�are�square.���

Sometimes�additional�photos�will�improve�the�resulting�texture�for�
objects�that�have�flat�surfaces,�but�may�not�be�cubic.��For�example,�a�
triangular�or�five�sided�object�or�an�abstract�shape�like�the�Oblith�
example.��Sometimes�a�slight�change�in�camera�angle�will�reduce�the�
severity�of�objectionable�reflections.���

For�these�odd�shaped�or�reflective�objects,�it�helps�to�shoot�photos�from�a�
camera�angle�that�is�front�on�to�each�face�(preferably�including�the�
calibration�mat,�though�these�photos�can�also�be�aligned�manually).��
Additional�photos�taken�specifically�for�texturing�can�be�marked�
�rejected��or��texture�only��until�the�wireframe�model�is�completed,�then�
used�as�described�in�Chapter�8�to�improve�a�texture.���
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7.1.  Fine Tuning the Auto-Masking Process  

For�many�objects�and�lighting�conditions,�the�auto�masking�process�
produces�excellent�results.��Sometimes�the�simple�process�of�auto�
masking�a�set�of�images�using�the�default�settings�produces�an�
unsatisfactory�mask.��Determining�a�single�threshold�to�use�for�all�the�
photo�angles�in�a�complete�image�set,�or�even�for�the�entire�area�of�a�
single�image�with�uneven�lighting,�can�require�a�lot�of�trial�and�error.��
Different�thresholds�may�be�required�for�different�areas�of�an�image.���

To�solve�this�problem�while�still�avoiding�the�tedious�and�time�
consuming�process�of�manual�masking,�a�couple�of�interactive�auto�
masking�capabilities�are�provided�which�allow�the�settings�to�be�varied�
and�the�resulting�mask�to�be�displayed�in�real�time.��The�interactive�tools�
can�also�be�applied�to�just�a�selected�region,�in�addition�to�the�entire�
image.���

The�first�of�these�interactive�tools�is�Auto�Masking�and�it�uses�the�Mask�
Slider�on�the�Model�Palette.���

Starting Point 

After�you�have�loaded�a�set�of�photographs�of�an�object�(including�the�
calibration�mat)�and�attempted�using�the�Mask All Images Wizard�for�
masking,�select�one�of�the�images�by�double�clicking�the�desired�
thumbnail.���
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Figure 7.1.1.  Double-click a thumbnail to display and edit its mask. 

Step 1 

Click�the� �Regenerate mask�button�in�the�Mask�palette�to�initialize�
interactive�auto�masking.���

�
Figure 7.1.2.  Mask Buttons and 

Interactive Slider. 

TIP:

�

If�you�wish�to�use�color�
normalization�so�that�
shadows�on�a�colored�
backdrop�are�more�likely�to�
be�ignored,�then�make�sure�
the�"Shadows"�checkbox�is�
selected�before�initializing�
interactive�masking.
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Step 2 

Drag�the�mask�slider�to�vary�the�background�detection�threshold�until�
the�desired�result�is�obtained.��Move�the�slider�to�the�right�to�increase�the�
threshold�and�create�more�mask�colored�area�or�to�the�left�for�the�
opposite�effect.���

Figure 7.1.3.  Examples of under-, proper and over-masking with the Interactive Slider. 

�

TIP: If�the�mask�display�updates�too�slowly�as�you�drag�the�slider�for�
large�images,�try�changing�the�mask�to�the�solid�display�mode�
using�the�Display Mask > Solid Mask�menu�item.��With�the�
mask�slider�selected,�you�can�also�use�the�left�and�right�arrow�
cursor�keys�to�change�the�value�in�small�steps.

Applying the masking settings to other images 

If,�by�dragging�the�slider,�a�good�result�is�obtained�on�the�current�image,�
you�can�try�the�same�settings�on�all�the�other�images�in�the�project,�or�just�
selected�ones,�using�the� Mask all images...  button.��On�opening,�the�
wizard�s�settings�will�automatically�be�updated�to�the�threshold�set�with�
the�slider.���

Step 3 

Select�or�deselect�the�allow�"Holes"�checkbox�to�allow�or�disallow�holes�
in�the�object.��If�this�option�is�selected,�then�regions�that�appear�similar�to�
the�background�color�seen�inside�the�object�boundary�are�treated�as�holes�
in�the�object�and�added�to�the�background�mask.��Clicking�this�button�
will�instantly�update�the�mask.���
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Figure 7.1.4.  Examples of adjusting the allow "Holes setting for a region or entire image. 

Note: If�you�wish�to�change�the�color�normalization�setting�with�the�
"Shadows"�checkbox,�it�does�not�apply�immediately�(the�way�the�
Holes�setting�does).��You�will�need�to�re�initialize�auto�masking�using�
the�� Regenerate mask�button�to�re�mask�with�the�new�setting.�

Step 4 

You�can�use�the� region select�button�to�drag�out�a�rectangular�
marquee.��The�auto�masking�tools�and�options�will�change�just�the�
portion�of�the�mask�that�is�within�the�selected�region.��

� �

�

Figure 7.1.5.  Examples of under-, proper and over-masking set within a region. 
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Step 5 

finer�control�you�can�also�modify�the�"background detection 

ve�the�slider�to�modify�the�masking�within�the�currently�selected�
region�without�affecting�the�mask�elsewhere.���

Like�most�masking�tools,�the�"Holes"�checkbox
�Holes��attribute�on�and�off�for�just�the�portion�of�the�image�that�is�wit
the�selected�region�(or�you�can�just�use�the�Fill�tool�to�fill�a�hole.)��

For�
threshold"�within�just�a�rectangular�region�of�the�image.��Click�the��
�region select�button,�then�drag�out�a�selection�marquee�around�
ired�portion�of�the�image�by�dragging�with�the�left�mouse�button.��To�

deselect�a�selected�region,�just�click�on�the�image�without�dragging.���

�

the�
des

Interactive Masking Within a Selection Box 

There�is�no�feathering�of�the�effect�of�any�slider�changes�near�the�edges�
of�a�selected�region.��To�avoid�a�jagged��stair�step��in�the�mask�edge�and�
a�resulting�ridge�in�the�model,�use�a�combination�of�the�following:��

Align� the� selection� rectangle� so� that� it�does�not� cross� the� edge� of� the�
object�in�the�middle�of�a�flat�face;�instead,�align�with�an�existing�feature�
in�the�silhouette�like�a�groove,�corner�or�ridge.���

Minimize�the�height�of�the�step�by�avoiding�a�single�large�movement�of�
the� slider� �� use� several� selections� offset� from� each� other� to�make� a�
sequence�of�smaller�gradual�changes.���

Increase�the�setting�for�the�Silhouette Decimation Threshold�in�the�
Wireframe�Generation�Wizard�to�a�number�of�pixels�that�is�larger�than�
more� than�half�of� the� �step��height,�probably�3� to�5�pixels,� so� that� the�
jaggedness�will�be�ignored�(treated�as�noise�instead�of�important�detail).���

Use�the�manual�masking�tools,�particularly�the�straight�edge�formed�by�
drawing�a�polygon,�or�use�a�large�diameter�brush,�to�trim�off�any�ridge�
left�by�using�a�selection�box.���
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7.2.  Masking with the Shrink-Wrap Tool  

Sometimes�it�is�difficult�to�set�up�a�suitable�backdrop�and�stand�to�allow�
either�automatic�masking�or�interactive�masking�to�work�well�(for�
example,�the�stand�is�a�different�color�than�the�backdrop).���

The�Shrink�Wrap�tool�is�another�semi�automatic�tool�to�make�masking�
easier.��To�use�it,�simply�sketch�a�rough�outline�around�the�object.��By�
growing�this�masked�area�using�a�process�of�selecting�contiguous�areas�
of�similar�color,�the�mask�can�be��shrink�wrapped��onto�the�object�for�
quick�and�accurate�masking.���

Starting Point 

Load�one�or�more�photographs�of�the�object�for�masking.��Select�one�of�
the�images�by�double�clicking�the�desired�thumbnail�or�by�dragging�it�
into�the�Mask Window�display�area.���

Figure 7.2.1.  Selecting an image to mask by double-clicking. 

Step 1 

If�you�choose,�remove�any�existing�mask�using�the� Unmask image�
button�from�the�Mask�palette.��If�the�existing�mask�does�not�penetrate�the�
object,�there�is�no�harm�and�there�may�be�some�benefit�to�using�it�as�a�
starting�point.���

Figure 7.2.2.  Selected image with mask removed. 
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Starting Point 

Load�one�or�more�photographs�of�the�object�for�masking.��Select�one�of�
the�images�by�double�clicking�the�desired�thumbnail�or�by�dragging�it�
into�the�Mask Window�display�area.���

Figure 7.2.1.  Selecting an image to mask by double-clicking. 

Step 1 

If�you�choose,�remove�any�existing�mask�using�the� Unmask image�
button�from�the�Mask�palette.��If�the�existing�mask�does�not�penetrate�the�
object,�there�is�no�harm�and�there�may�be�some�benefit�to�using�it�as�a�
starting�point.���

Figure 7.2.2.  Selected image with mask removed. 

Step 2 

Either�start�with�a�mask�that�includes�the�background�and�stand,�but�
doesn�t�penetrate�the�object,�or�select�the� Paint mask�button�to�paint�
the�mask�color�and�select�a�round�brush�using�the� Round Brush�
button.��Adjust�the�brush�slider�to�select�a�thick�brush�(around�20�pixels).��
Paint�a�rough�outline�around�the�object�that�is�reasonably�close�to�but�not�
touching�the�object.���

TIP: The�outline�can�be�very�rough��
� but�make�sure�you�don�t�touch��
�� the�object�you�are�trying�to�mask.���
� If�there�are�holes�contained��
� within�the�object�s�outline�as��
� seen�from�the�camera�s�vantage��
� point,�you�may�paint�inside��
� these�areas�to�initiate�masking��
� the�hole.

Figure 7.2.3.  Selected image with 
outline painted using the brush

Step 3 

�
Figure 7.2.4.  Mask Buttons  

and Interactive Slider. 

�

Click�the� Shrink-Wrap Mask�
button,�then�drag�the�masking�slider�
to�interactively�shrink�wrap�the�
mask.��Move�the�slider�to�the�right�to�
create�more�mask�area�and�to�the�left�
to�create�less�mask.

�
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Figure 7.2.5.  Examples of under-, proper and over-masking with Shrink-Wrap. 

�

� �

The�slider�has�a�similar�effect�to�the�tolerance�setting�for�the�magic�wand�
in�Photoshop�except�that�there�are�two�factors�that�control�the�shrink�
wrap,�similarity�in�color�and�distance�from�the�edge�of�the�rough�mask.��
(The�tolerance�gets�lower�for�areas�that�are�further�away�from�the�rough�
mask�so�that�similar�color�areas�that�are�a�long�distance�from�the�starting�
mask�are�more�likely�treated�as�if�they�are�reflections�of�the�background�
on�the�object�and�masked�as�object�as�opposed�to�background.)��

Step 4 

For�finer�control,�you�can�further�modify�the�shrink�wrap�threshold�in�a�
rectangular�region�of�the�image.��Click�the� region select�button,�
then�select�the�desired�image�region�by�dragging�with�the�left�mouse�
button.��Once�the�region�is�selected,�move�the�masking�slider�to�
interactively�set�a�different�threshold�for�just�the�selected�region.���

Note: There�is�no�feathering�of�the�effect�of�a�slider�change�near�the�
edges�of�a�selected�region.��To�avoid�a�jagged��stair�step��in�the�mask,�
follow�the�recommendations�in�the�previous�section�on�Interactive 
Masking within a Selection Box.

Step 5 

Select�or�deselect�the�"Holes"�checkbox�to�allow�or�disallow�holes�in�the�
object.��Clicking�this�button�will�instantly�update�the�mask.��(Note:�The�
color�normalization�setting�has�no�effect�when�shrink�wrapping.)��
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TIP: At�any�stage,�you�can�re�run�the�shrink�wrapping�using�the�
current�mask�as�a�starting�point.��This�can�be�helpful�for�fine�
tuning�the�mask�in�a�selected�region.��The�tool�must�be�re�
selected�in�order�to�reinitialize�it�to�use�any�changes�made�to�the�
mask�since�it�was�last�initialized.�

�

Figure 7.2.6.  A reminder that a slight under-masked fringe may be preferred on larger 
objects or lower-resolution photos to produce a smoother model surface without causing 
significant texture misalignment (seams).  The effect of these edge irregularities can also 
be minimized by a high Silhouette Decimation setting in the Wireframe Generation wizard. 
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7.3.  Using Clean Mask with Shrink-Wrap  
 to Mask a Set of Images  

Sometimes�a�set�of�photographs�will�not�be�suitable�for�auto�masking�for�
one�or�more�of�the�following�reasons:��

� no�pedestal�or�stand�was�used...���

� the�backdrop�does�not�fully�surround�the�object...���

� the�backdrop�was�not�sufficiently�plain...���

� no�backdrop�was�available...���

If�there�are�a�large�number�of�images,�accurate�manual�masking�could�
take�a�long�time.��For�this�situation,�Foto�3D�provides�a�number�of�semi�
automatic�tools�for�more�rapid�masking�of�multiple�images�by�improving�
the�workflow.���

Starting Point 

Start�with�a�project�consisting�of�a�large�number�of�challenging�images.��
Remove�any�existing�masks�that�penetrate�the�object�or�are�otherwise�
inaccurate�using�the�Masking > Unmask Images�menu�item.���

Figure 7.3.1.  Photos with any masks removed. 

Step 1 

First,�put�the�thumbnails�in�a�special�prioritized�order�called�“Project�
Order”.��View�the�thumbnail�in�details�mode�by�clicking�the� View
image details�button.��Click�the��Order��tab�so�that�the�thumbnails�are�
displayed�sorted�in��project�order��which�automatically�sequences�the�
images�so�that�the�first�few�images�are�from�widely�differing�viewpoints.���
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�
Figure 7.3.2.  Thumbnail View in detailes mode sorted in Project Order. 

Step 2 

With�the�Mask�Window�displayed,�double�click�the�first�thumbnail.��
Create�a�mask�using�the�appropriate�masking�tool,�such�as�the�Shrink�
Wrap�tool�(see�Masking with the Shrink-Wrap tool).���

�

�

���

Figure 7.3.3.  A hand-painted outline plus the shrink wrap tool are applied  
to create a mask for the first image in the "project order" list 

Step 3 

Repeat�the�process�for�the�first�3�or�4�images�in�the�ordered�list.���

Figure 7.3.4.  Masks created for the next three images. 
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Step 4 

Generate�a�rough�3D�wireframe�model�using�these�few�images.��Click�the�
�Generate Wireframe... button�to�launch�the�Wireframe�

Generation�Wizard.��Select�the�"Generate wireframe"�option�and�click�
the�Next�button.��Use�the�default�parameters�and�click�the�Next�button�to�
create�an�initial�3D�model.��When�finished,�close�the�Wizard.���

Figure 7.3.5.  Rough wireframe model from four viewpoints. 

Note: Don�t�optimize�the�surface�at�this�stage���we�just�want�a�rough�
oversized�estimate�of�the�space�in�which�the�object�must�lie.�

Step 5 

Return�to�the�Mask Window�clicking�the�Mask�tab.���

In�the�Thumbnail�Viewer,�select�and�load�the�next�un�masked�thumbnail�
for�editing�by�double�clicking�it.���

Figure 7.3.6.  Selecting next thumbnail to mask. 
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Step 6 

We�can�now�project�the�3D�model�into�the�selected�image�to�get�an�initial�
estimate�for�the�maskby�clicking�the� Clean Mask�button.���

There�shouldn�t�be�any,�but,�if�necessary,�unpaint�any�areas�of�the�object�
that�have�been�incorrectly�shown�as�masked.��(This�can�happen�and�be�of�
concern�with�a�complex�object�if�there�is�a�slight�amount�of�uncorrected�
lens�distortion,�the�object�has�moving�or�flexible�pieces,�there�is�a�slight�
bend�or�curl�in�the�calibration�mat,�during�the�shoot�there�was�a�slight�
shift�of�the�object�on�the�pedestal�and�mat,�the�zoom�setting�was�changed�
mid�project,�or�there�are�similar�inaccuracies�in�the�photographs.)��

Figure 7.3.7,�below,�shows�an�initial�mask�derived�from�the�wireframe�
model�by�using�the�Clean Mask�tool.���

Step 7 

Shrink�wrap�the�mask�to�the�object.��Click�the� Shrink-Wrap Mask�
button�and�drag�the�masking�slider�until�the�desired�mask�is�obtained.���

Figure 7.3.7.  Mask generated by Clean Mask tool as initial silhouette. 
Figure 7.3.8.  Mask shrink-wrapped from the initial silhouette.

�

TIP: For�improved�workflow�the�last�two�steps�can�be�combined.��
Clicking�the� Shrink-Wrap Mask�button�for�an�un�masked�
image�will�automatically�perform�a�clean�mask�operation�
followed�by�shrink�wrapping.
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Step 8 

You�can�fine�tune�the�shrink�wrapping�(see�Masking with the Shrink-
Wrap tool)�and�manually�edit�any�remaining�problem�areas�with�the�
brush�and�it�s�related�tools.���

Step 9 

Repeat�for�the�remaining�un�masked�images.���

�

�

Figure 7.3.9.  Optimized wireframe produced using this technique. 
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7.4.  Editing Masks with an External Application  

Foto�3D�provides�an�extensive�set�of�automatic,�semi�automatic�and�
manual�masking�tools.��In�addition,�for�users�that�would�prefer�to�use�
any�additional�tools�provided�by�their�favorite�image�editing�program,�
such�as�Adobe�Photoshop,�Foto�3D�also�provides�methods�for�importing�
externally�edited�masks.���

Using Pre-Masked Images 

Images�having�a�mask�in�their�alpha�channel�can�be�loaded�into�Foto�3D�
in�TIFF�format.��This�is�only�recommended�for�image�editors,�such�as�
Adobe�Photoshop,�that�preserve�camera�setting�metadata�(EXIF�data)�
found�in�the�source�files�when�saving�the�masked�version�of�these�files.���

Photoshop�(or�similar)�users�can�create�an�alpha�channel�mask�for�all�
images�and�save�them�in�TIFF�format�(4�channel�RGBA).��These�images�
can�then�be�loaded�directly�into�Foto�3D�using�the� New project...  
button�or�the�Images > Add Images...  menu�item.��Make�sure�the�
RGB�channels�have�not�been�modified�so�that�the�calibration�mat�can�be�
correctly�detected�and�analyzed.���

Note: If�you�find�Foto�3D�asking�you�to�calibrate�your�lens�when�loading�
pre�masked�files,�it�is�because�the�EXIF�data�is�being�lost�in�the�masking�
process.��Use�the�technique�in�the�next�section�to�create�masks�keeping�
the�EXIF�data�intact.�

Note�that�if�you�choose�to�use�this�workflow,�we�recommend�that�all�
masking�is�performed�in�Photoshop.��If�you�wish�to�edit�a�mask�simply�
edit�the�TIFF�image�and�then�refresh�the�masks�in�Foto�3D�using�the�
Masking > Load Masks...  menu�item.���

Preparing Images for External Masking 

Alternatively,�after�an�image�file�has�been�imported�and�the�camera�
details�in�the�EXIF�metadata�have�already�been�added�to�the�project�
database,�an�image�file�with�mask�data�can�be�exported�from�Foto�3D�as�a�
4�channel�(RGBA)�image�in�TIFF�(or�PNG)�format�for�editing�in�a�larger�
selection�of�third�party�image�editors�without�concern�over�whether�they�
preserve�the�metadata.��Edited�masks�can�then�be�imported�back�into�
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Foto�3D�for�use�in�3D�model�generation�by�using�the�Images > Import 
Masks�menu�item.���

Step 1 

If�you�are�not�using�pre�masked�images,�then�load�a�set�of�photos�into�a�
new�project.��Run�the�Mask All Images Wizard�to�generate�initial�
masks.���

Figure 7.4.1.  Save Masks context menu (right-click menu). 
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Step 2 

In�the�Thumbnail Window,�select�the�masked�thumbnails�that�you�wish�to�
edit�in�a�third�party�image�editor�either�by�clicking�on�a�thumbnail,�using�
the�Shift�key�to�select�a�range,�or�holding�down�the�Ctrl�key�to�add�or�
remove�clicked�thumbnails�to�or�from�the�selection.���

Step 3 

Select�the�Masking > Save Masks...  menu�item�to�save�the�masks�to�
disk�as�image�files.��You�will�be�offered�the�choice�of�a�number�of�mask�
export�formats.��For�compatibility�with�most�popular�image�editors�and�
to�limit�compression�losses,�we�recommend�that�you�select�the�TIFF�file�
format.���

�

File formats for saving and loading masks: 

Tagged�Image�File�Format�(TIFF):�The�lens�distortion�corrected�original�
image�will�be�saved�with�the�mask�saved�in�the�alpha�channel�(four�
channels���RGB�&�transparency).��This�is�the�recommended�format�since�
it�is�read�by�most�image�editing�applications,�saved�without�
compression�losses�and�keeps�the�source�image�and�it�s�mask�in�the�
same�file.���

Portable�Network�Graphic�(PNG):�The�lens�distortion�corrected�
original�image�will�be�saved�with�the�mask�saved�in�the�alpha�channel.��
If�the�original�images�were�PNG�files,�no�information�is�lost�if�the�masks�
overwrite�the�original�images.���

Portable�Gray�Map�(PGM):�In�this�format,�only�the�mask�is�saved�as�a�
grayscale�image.��The�original�image�is�not�saved�as�part�of�the�PGM�
file.��When�using�this�format�for�saving�masks,�it�is�important�that�the�
original�images�are�NOT�in�PGM�format�so�that�they�are�not�
overwritten.��(This�format�is�dated�and�is�supported�for�compatibility�
with�older�software.��It�is�no�longer�being�widely�used.)�

�
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Figure 7.4.2.  Save Masks dialog with File Type drop-down expanded. 

It�is�recommended�that�mask�files�be�saved�in�the�same�directory�as�the�
source�photos�by�selecting�the�"Masks in same folder as each 
image"�option�and�clicking�the�OK�button.���

The�names�used�for�mask�files�must�match�the�source�image�files’�name.�
Mask�file�names�cannot�be�renamed�or�changed�once�the�source�images�
files�have�been�added�to�a�project;�but�mask�files�can�always�be�saved�
into�a�different�directory�to�avoid�overwriting�a�similarly�named�file.���

Note: In�the�Save�dialog,�files�that�already�exist�in�a�directory�and�will��
be�overwritten�by�the�save�are�marked�with�an�asterisk.�

Step 4 

Open�your�third�party�image�editor.��Open�the�mask�files�that�Foto�3D�
created.��(Usually�found�in�the�same�directory�as�the�source�photographs�
but�having�a�.TIF�extension.)��
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Step 5 

The�mask�information�is�stored�in�the��alpha��channel�which,�initially,�
may�not�be�visible.���

To�display�the�current�mask�in�Photoshop,�select�the�Channels�tab�
(Window > Show Channels�menu�item).��Then�click�on�the�checkbox�
next�to�the��Alpha��channel�to�turn�on�the�visibility�for�this�channel.���

To�display�the�current�mask�in�Paint�Shop�Pro,�you�need�to�first�load�the�
mask�using�the�Masks > Load From Alpha Channel�menu�item.��Then�
select�the�Masks > View Mask�menu�item.���

Figure 7.4.3.  The Channels Tab in Photoshop 

In�these�and�other�applications,�it�is�advisable�to�stick�to�using�the�two�
colors�normally�used�for�masking�in�the�alpha�channel�—�white�(255)�for�
the�visible�object�and�black�(0)�for�the�invisible�background.���

For�pre�masked�objects�or�imported�masks,�Foto�3D�applies�a�50%�
luminosity�threshold�to�separate�masked�from�unmasked�areas�using�the�
following�convention...���

Alpha Channel Conversion Convention 

pixel�label� alpha�value� color�
object� 127�255� white�
background� 0�127� black�

STRATA FOTO 3D - Chapter 7
Improving The Wireframe Model

117



Step 6 

You�can�use�the�usual�editing�tools�in�your�image�editing�application�to�
edit�the�mask�channel.��When�you�are�done�editing,�Save�the�file�using�
the�original�filename�and�extension.���

TIP: If�you�are�editing�a�mask�in�Paint�Shop�Pro,�be�sure�to�save�the�
result�back�to�the�alpha�channel�using�the�Masks > Save To 
Alpha Channel�menu�item.��

Figure 7.4.4.  Mask Selected, to be transferred to Alpha Channel. 

General Masking Tips  

When�using�a�Paintbrush�Tool�to�paint�in�the�alpha�channel,�make�sure�
you�use�a�hard�edged�brush.��Click�on�the�brush�and�drag�the�hardness�
slider�to�100%.��Use�white�for�painting�the�object�regions�and�black�for�
painting�the�background.���

� You�can�select�part�of�the�object�(or�backdrop)�and�update�the�mask�
using�the�Select > Save Selection�menu�item.��Choose�the��Alpha�
1��channel�and�select��Add�to�Channel��to�mask�the�selected�region�
as�object�(or��Subtract�from�Channel��to�mask�as�backdrop).���

�

STRATA FOTO 3D - Chapter 7
Improving The Wireframe Model

118



General Masking Tips  

� Alternatively,�you�can�select�part�of�the�object�(or�backdrop)�and�
update�the�mask�by�selecting�the�Alpha�1�channel�under�the�
Channels�tab�and�filling�the�selected�area�with�white�or�black�
using�the�Edit > Fill�menu�item.���

� If�you�are�selecting�an�area�using�the�Select > Color Range�
menu�item,�make�sure�you�have�selected�the�RGB�channels�in�
the�Channel�tab�when�making�the�selection.���

� If�you�wish�to�use�Photoshop�s�image�extraction�tool,�click�the�
RGB�channel�in�the�Channels�tab,�then�select�the�Image > 

Extract�menu�item�to�perform�the�extraction�of�the�object.��This�
will�create�a�transparency�channel.��To�update�the�mask�use�the�
Select > Load Selection�menu�item�and�choose�the�transparency�
channel.��Then�use�the�Select > Save Selection�menu�item�and�
choose�to�replace�the�alpha�channel.���

When�you�are�finished,�save�as�a�TIFF�file�with�alpha�channel�enabled�
and�without�layers�or�compression�using�the�original�filename.���

�

Step 7 

Once�you�have�edited�the�mask�image�files,�they�can�be�loaded�back�into�
Foto�3D�by�selecting�the�corresponding�image�thumbnails�(or�all�
thumbnails)�and�selecting�the�Masking > Load Masks...  menu�item.��
This�process�will�ignore�any�images�that�do�not�have�a�similarly�named�
mask�file�in�the�directory;�these�files�are�displayed�in�the�list�of�filenames�
without�being�marked�with�an�asterisk.���
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7.5.  Optimizing Surface Geometry  

The�initial�wireframe�generated�from�the�silhouettes�may�have�visual�
features�or�irregularities,�such�as�sharp�corners,�that�are�unwanted�
geometry�resulting�from�not�having�taken�sufficient�photographs�from�
the�best�angles.��If�the�model�is�to�be�lit�using�a�virtual�light�source,�these�
irregularities�may�introduce�shading�artifacts.��(see�Figure 7.5.1).���

The�surface�smoothing�feature�of�the�Wireframe Generation Wizard�
can�be�used�to�optimize�the�mesh.��This�will�smooth�the�mesh�in�regions�
where�there�is�no�information�in�the�photos�suggesting�it�should�have�
sharp�edges,�but�keeps�any�sharp�corners�that�can�be�seen�in�the�
silhouettes.���

Starting Point 

Although�not�essential,�it�is�usually�better�to�have�an�initial�surface�
generated�from�which�the�optimizer�can�start.��You�will�also�need�to�have�
all�of�your�images�masked�accurately�since�the�model�will�be�optimized�
to�fit�every�one�of�these�masks.���

TIP: You�might�want�to�use�the�Automask > Clean Mask�menu�
item�to�clean�up�your�masks���this�will�mask�out�previously�
unmasked�portions�of�each�image�that�lie�outside�the�current�
geometry.��More�importantly,�it�will�demonstrate�any�
irregularities�that�using�the�"Constrain smoothed mesh to 
lie inside current geometry"�option�might�produce�as�a�
result�of�any�distortion�or�mis�alignment�of�the�images�due�to�
uncorrected�lens�distortion,�blurry�photos,�slight�movement�of�
the�object�on�the�mat,�or�any�bending�or�curling�of�the�mat.���

The�"Constrain smoothed mesh to lie inside current 
geometry"�option�produces�an�equivalent�result,�but�does�so�
by�using�an�internal�copy�of�the�masks�that�cannot�be�viewed�or�
edited�in�the�masks�window.���

You�can�also�create�additional�silhouette�images�and�edit�these�
if�you�want�to�capture�particular�features�as�described�in�the�
section�Improving the Model By Adding Silhouettes�found�later�
in�this�Chapter.��

STRATA FOTO 3D - Chapter 7
Improving The Wireframe Model

120



Note: Optimization�will�discard�any�generated�surface�texture,�but�it�
will�keep�in�place�any�clipping�you�have�performed.��It�is�better�to�clip�
away�the�stand�before�starting�the�optimization�process.���

� �
Figure 7.5.1.  Two initial wireframes displayed in flat shaded mode.   

Note the sharp edges that are visible.   

Step 1 

Open�the�Wireframe�Generation�Wizard�by�clicking�the� �Generate
Wireframe... button�and�choose�"Optimize Surface"�then�click�the�
Next >�button�to�go�to�the�Surface Optimization Window.���

Figure 7.5.2.  Launching the Wireframe Generation Wizard in Surface Optimization mode. 
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Step 2 

Figure 7.5.3.  Setting the Surface Optimization parameters. 

Figure 7.5.4.  Effect of the Surface Optimization quality level slider. 

STRATA FOTO 3D - Chapter 7
Improving The Wireframe Model

122



� The�following�Surface�Optimization�Parameters�can�be�set:��
Set the Quality Slider  

If�you�have�a�smooth,�organically�shaped�object,�choose�"smooth
approximation"�to�generate�a�smoothed�mesh�with�few�corners.��
Otherwise,�either�leave�the�"reasonable accuracy"�default�setting�or�
choose�"exact fit"�if�you�are�confident�that�your�masks�are�very�
accurate�and�you�want�the�surface�to�fit�all�the�details�in�their�silhouettes.���

Set Mesh Constraint

If�you�have�edited�the�masks�to�remove�unwanted�regions�in�just�a few��
of�the�images�(e.g.��the�stand�or�a�subpart�of�the�object)�you�will�need�to�
make�sure�the�"Constrain smoothed mesh to lie inside current 
geometry"�option�is�selected.��This�will�prevent�the�non�edited�masks�
affecting�the�geometry�(and�growing�back�any�portions�of�the�mesh�
removed�by�another�mask�in�the�set).���

Set Image Limit  

If�you�have�a�lot�of�images�in�your�project�or�the�silhouettes�are�
particularly�complex,�optimization�can�be�slow,�so�it�is�a�good�idea�to�
limit�the�number�of�images�used�at�each�optimization�step�by�setting�the�
"Maximum number of images to use during optimization"�
parameter.���

Click�the�Next�button�to�start�the�optimization�process.���

Figure 7.5.5.  Surface Optimization progress window. 
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Step 3 

After�some�initialization,�Foto�3D�will�start�to�modify�the�surface,�
gradually�smoothing�it�while�ensuring�the�features�on�the�silhouettes�are�
captured.���

During�this�process,�you�can�see�the�current�geometry�and�look�around�
the�model�by�rotating�it�in�the�Model Window�as�usual.��At�this�stage,�the�
mesh�will�be�displayed�with�the�maximum�number�of�triangles,�and�will�
not�be�displayed�reduced�to�the�selected�decimation�level�until�
optimization�finishes.���

Use�the�Pause�button�to�halt�the�optimization�while�you�look�at�the�
results�and�then�click�the�Continue�button�to�resume�optimization.���

If�you�want�to�change�the�parameters,�click�the�< Back�button�at�any�
point�to�return�to�the�previous�step�and�edit�them�(for�instance�if�the�
optimization�is�proceeding�too�slowly,�you�could�reduce�the�number�of�
images�being�used).���

Step 4 

You�can�either�allow�the�optimization�to�finish�completely,�or�interrupt�it�
if�the�current�surface�appears�sufficiently�optimized.��Click�the�Finish�
button�to�leave�the�Surface Optimization Wizard,�keeping�the�partially�
optimized�mesh�as�it�is�currently�displayed.���

When�the�Wizard�is�closed,�decimation�will�be�initialized,�which�may�
take�a�few�seconds.��The�model�will�be�re�displayed�with�the�number�of�
triangles�previously�specified�by�the��Number of Triangles��
decimation�setting.���
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7.6.  Improving the Model By Adding Silhouettes

Sometimes,�after�taking�the�photographs�and�starting�to�build�the�model,�
you�may�realize�that,�to�improve�the�final�geometry,�you�needed�to�use�
an�image�from�a�different�angle.���

Three�options�are�available�in�this�situation:��

� If�you�have�not�moved�the�object�and�it�is�still�aligned�with�the�
calibration�mat,�you�can�simply�take�additional�photographs�and�add�
them�to�the�project�using�the�Images > Add Images...  menu�item.���

� If�you�have�moved�the�object,�you�can�still�take�more�photographs,�
but�you�would�need�to�align�each�new�image�as�described�in�the�
section�on�Adding Texture to the Bottom of an Object�in�Chapte�8.���

� If�you�no�longer�have�access�to�the�object,�do�not�want�to�take�any�
more�photographs,�or�simply�want�to�refine�an�area�of�the�model,�
you�can�create�a�synthetic view�as�described�below,�edit�the�mask�to�
correct�the�silhouette�from�this�viewpoint,�and�then�re�generate�the�
wireframe�using�this�silhouette.���

TIP: See�the�preceding�section�on�Optimizing Surface Geometry�for�
another�automatic�tool�for�improving�the�surface,�which�might�
be�just�as�effective�or�which�would�produce�further�enhanced�
results�with�the�benefit�of�an�additional�silhouette.

Starting Point 

Before�creating�a synthetic view,�a�3D�wireframe�model�has�to�be�
generated�and�it�is�highly�recommended�that�you�also�generate�an�initial�
texture�map.���

Step 1 

In�the�Model Window,�rotate�and�position�the�model�until�you�are�looking�
at�it�from�an�angle�that�shows�as�much�of�the�unwanted�geometry�on�the�
edge�or�silhouette�of�the�model�as�possible.���
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� �
Figure 7.6.1.  The model rotated to show as much unwanted geometry as possible.

Figure 7.6.2.  A photo from another angle showing intended shape.

Note: If�you�cannot�find�a�single�view�angle�from�which�all�of�the�
unwanted�geometry�is�visible,�you�may�need�to�repeat�this�procedure�to�
create�silhouettes�from�several�viewpoints.�

Step 2 

Click�the� Create silhouette�button.��If�you�have�a�texture�map�
generated,�you�will�be�prompted�whether�to�save�the�virtual�image�of�the�
model�as�an�image�file�for�editing�the�mask.��Choose�a�filename�for�the�
synthetic�image�and�save�it�in�the�project�folder.���

Note: Make�sure�that�the�entire�object�is�visible�in�the�new�image,�
otherwise�your�geometry�may�get�clipped.��If�the�image�is�clipped,�delete�
the�new�image,�zoom�out�a�bit�and�create�the�image�again.�

Figure 7.6.3.  Thumbnail View showing new synthetic images.
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The�new�synthetic�image�will�appear�in�the�Thumbnail Window�with�an�
initial�mask�generated�from�the�current�geometry.��Synthetic�images�are�
not�used�for�texturing�and�are�indicated�as�type�"silhouette".���

Step 3 

Load�the�new�mask�into�the�Mask Window�by�double�clicking�on�its�
thumbnail.��Edit�the�mask�so�that�the�geometry�is�corrected.���

Figure 7.6.4.  The synthetic image 
and mask ready for editing.

Figure 7.6.5.  The mask after editing 
to improve the shape.

Step 4 

Re�generate�the�wireframe�model��
by�clicking�the�� �Generate
Wireframe... button�and��
following�the�normal�procedure.���

Figure 7.6.6.  The model after being regenerated, showing the corrected geometry. 
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7.7.  Modeling Parts of an Object  

For�a�complex�object,�or�one�that�you�may�wish�to�animate�as�separate�
pieces�or�assemble�with�other�parts�in�a�3D�modeling�application�like�
Strata�3D�CX,�it�can�be�helpful�to�build�a�separate�textured�3D�model�of�a�
single�part�of�an�object.��This�can�also�result�in�improved�modeling�
accuracy.���

Foto�3D�allows�you�to�build�a�3D�textured�model�of�just�part�of�an�object�
by�manually�editing�selected�masks.���

In�our�example�we�will�model�just�the�lens�from�images�of�a�camera�with�
attached�lens.��The�lens�model�can�then�be�assembled�to�the�camera�body�
and�placed�into�a�3D�scene�and�rendered�using�3D�modeling�and�
animation�software�such�as�Strata�3D�CX.���

Starting Point 

Load�in�the�photographs�of�a�complex�object�(in�this�case�a�camera).���

Step 1 

Using�the�automatic�masking�tools,�build�a�set�of�masks�of�the�combined�
object.��These�will�be�used�later�to�build�masks�for�just�the�lens.���

Figure 7.7.1.  Masked images of a camera. 

Note:��It�is�a�good�idea�to�save�the�project�at�this�point.��In�our�example�
we�will�call�this�project��camera_with_lens.som�.���
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Step 2 

Next,�concentrate�on�building�the�geometry�for�the�lens.��To�do�this,�
select�a�number�of�key images�and�edit�the�corresponding�masks�so�that�
they�only�include�the�lens�and�not�the�body.��The�key images�should�
ideally�show�the�entirety�of�the�lens�portion�of�the�camera�without�any�
other�parts�partly�obscuring�it.���

Figure 7.7.2�shows�suitable�key�images�and�their�edited�masks.��Figure
7.7.3�shows�an�unsuitable�image�where�large�areas�of�the�lens�are�hidden�
behind�the�body�and�hence�the�mask�of�the�lens�outline�would�have�to�be�
a�very�rough�estimate;�inadequate�for�determining�the�silhouette�of�the�
hidden�portion�of�the�lens.���

Figure 7.7.2.  Key masks for modeling the lens. 
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Figure 7.7.3.  Unsuitable views for modeling the lens – major portions are obscured. 

�

TIP: In�general,�only�a�few�key�masks�need�to�be�edited�in�order�to�
isolate�a�sub�part.��The�remaining�masks�should�still�be�included�
as�they�still�help�define�the�shape.�

Step 3 

Now�save�the�edited�masks�in�a�new�project.��Use�the�File > Save As...  
menu�item�to�save�and�rename�the�project.��A�good�name�in�this�case�
would�be��lens_only.som�.���

Step 4 

The�next�step�is�to�build�the�texture�map�for�the�lens.��Care�needs�to�be�
taken�here�as�you�will�need�to�ensure�that�image�data�from�the�camera�
body�is�not�incorporated�into�the�textures.���

Select�a�subset�of�the�images�that�you�wish�to�use�to�texture�the�subpart�
and�reject�the�remaining�images�(or�set�to�"geometry only").��Then,�for�
each�included�image,�edit�the�masks�to�ensure�that�any�portions�of�the�
camera�body�that�obscure�areas�of�the�lens�are�masked�out�so�that�they�
are�not�included�in�the�texture.���

Figure 7.7.4�shows�the�initial�mask�for�the�top�down�view�and�the�edited�
mask�used�prior�to�building�the�textures.���
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Figure 7.7.4.  Initial edited masks for geometry (mask excludes hidden parts  
of lens covered by other overlapping camera pieces) and for texturing  
(mask excludes overlapping pieces that are not part of the lens itself). 

Step 5 

Once�the�masks�have�been�edited,�the�wireframe�model�and�texture�map�
are�generated�as�usual�by�clicking�the� Generate Wireframe...

button�and�then�the� Generate texture map...  button.���

Figure 7.7.5.  Smoothed wireframe and final textured part. 

The�texture�mapped�3D�model�of�the�lens�can�now�be�exported�for�use�in�
a�larger�model�or�a�3D�scene.���
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8.1.  Adding Texture to the Bottom of an Object

Because�the�object�is�placed�on�a�stand�and�pictures�are�taken�with�the�
calibration mat�visible�in�the�frame,�normally�the�bottom�of�the�object�is�
not�included�in�any�of�the�usual�photos.��When�you�build�the�textured�
model,�by�default�the�bottom�of�the�model�is�textured�with�a�plain�color�
fill�copied�from�the�surrounding�geometry.���

In�many�cases�the�plain�texture�(as�seen�in�Figure 8.1.1)�is�adequate�since�
you�may�not�be�concerned�with�the�bottom�of�the�object�or�it�may�be�
plain.��If�you�want�to�add�texture�detail�to�the�bottom�surface,�the�
simplest�solution�with�Foto�3D�is�to�turn�the�object�over�or�on�it�s�side�
and�take�one�or�two�images�of�the�bottom�of�the�object,�preferably�with�
the�calibration�mat�in�the�frame,�and�add�these�to�the�project.���

� �
Figure 8.1.1.  Model with no bottom images. 

Figure 8.1.2.  Final texture using an aligned bottom image. 
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Figure 8.1.3.  An additional image from underneath the “doll” figurine.   

Since�Foto�3D�cannot�locate�the�camera�position�for�these�shots,�the�Align
Wizard�is�used�to�manually�position�and�align�each�of�these�additional�
images�relative�to�the�wireframe�model�so�that�they�can�be�used�when�
generating�the�texture map.���

TIP: Experienced�users�have�found�that�after�they�have�their�lighting�
optimized,�it�is�helpful�to�shoot�the�bottom�shots�first�so�they�are�
available�for�use,�and�then�position�the�object�on�the�pedestal�
and�calibration�mat�to�shoot�the�rest�of�the�photo�set.��This�
allows�the�object�and�mat�to�remain�aligned�as�a�unit�for�the�
remainder�of�the�project�in�case�additional�photos�are�needed�to�
refine�the�geometry�or�texture�from�another�vantage�point.�

�

Try It Out! 

To� try� out� aligning� an� image,� follow� the� instructions� in� the� Starting a 

New Project� section� to� create� a� new� project� from� the� images� in� the�
Examples\Doll�directory� included�with� your� installation.� � �Loading� all�
images�will�include�bottom�photos�that�will�be�marked�“rejected”.�
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Starting Point 

When�you�create�a�new�project�and�load�in�all�the�photographs,�any�
images,�such�as�bottom�photos�taken�without�the�calibration�mat�will�
automatically�be�marked�as�"rejected".��Alternatively,�you�can�select�
and�load�all�the�images�except�the�bottom�ones,�and�then�add�them�to�the�
project�later,�after�the�wireframe�model�is�complete.���

Note: If�bottom�photos�do�include�the�calibration�mat�(or�any�shots�were�
taken�after�the�object�was�accidentally�moved�on�the�mat,)�remember�to�
mark�them�as��rejected��before�generating�a�wireframe�to�avoid�
corrupting�the�generated�mesh.�

Generate�masks�and�build�the�geometry�as�normal.��Generate�an�initial�
surface�texture�(excluding�the�bottom�photos)�to�help�with�the�alignment.���

Step 1 

If�the�bottom�images�have�not�been�loaded,�load�them�using�the�
Images > Add Images...  menu�item��

Select�the�first�image�that�needs�to�be�aligned�(it�doesn�t�matter�if�it�is�
currently�marked�as�rejected)�and�choose�the�Images > Align Image...  
menu�item.��This�will�open�the�Align Wizard�and�update�the��
Thumbnail Window.���

Note: Each�additional�image�will�need�to�be�aligned�separately�by�
repeating�this�process.�

Figure 8.1.4.  Bottom photo found in the Thumbnail Viewer, masked and ready to align. 
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Step 2 

The�Model�Display�in�the�Model Window�now�displays�the�current�model�
semi�transparently�over�the�selected�additional�image.���

TIP: It�might�help�to�use�the�wireframe�display�mode�and�change�the�
color�of�the�wireframe�using�the�Strata Foto 3D Settings 
Window.��

Using�the� �Rotate model,� �Move model,� �Zoom model�and�
�Spin model�buttons,�position�and�orient�the�model�so�that�it�aligns�

with�the�image�displayed�behind�it.���

Figure 8.1.5.  Wireframe before 
aligning to the image. 

Figure 8.1.6.  Wireframe after 
aligning to the image. 

Step 3 

Once�the�model�is�roughly�in�position,�fine�tune�the�positioning�in�one�of�
two�ways.���

� One�method�is�to�use�the�Alignment Wizard,�which�attempts�subtle�
shifts�of�position,�rotation,�spin�and�zoom�to�get�the�bottom�photo�s�
mask�to�better�align�with�the�wireframe�s�silhouette.��The�wizard�may�
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be�confused�by�subtle�inaccuracies�in�masks.��If�the�Wizard�is�
unsuccessful,�simply�Undo�the�change�and�use�the�manual�method.���

� The�second�method�is�to�manually�zoom�in�on�the�detail�in�the�image�
and�try�subtle�shifts�of�position,�rotation,�spin�and�zoom�to�improve�
the�visual�alignment.��Use�the� �Magnify View�button�and� �Pan
View�button�to�zoom�in�on�and�move�the�background�image�while�
you�position�the�model.��These�two�buttons�move�the�model�and�
background�as�a�synchronized�unit�so�that�you�can�check�all�edges�of�
the�alignment�without�throwing�the�alignment�off.���

Using "Optimize Alignment"

You�can�use�the�automatic�alignment�feature�of�Foto�3D�as�a�shortcut�for�
final�fine�tuning�of�the�alignment�of�an�image.��In�order�to�do�so,�you�will�
need�to�have�created�an�accurate�mask�for�the�additional�image�before�
opening�the�Align Wizard.��Ideally�this�mask�is�made�with�the�same�
thresholds�and�settings�as�the�rest�of�the�model�so�that�the�amount�of�
anti�alias�fringe�is�consistent.���

TIP: The�Interactive�Mask�process�will�not�work�on�additional�
images�that�do�not�include�the�calibration�mat�in�the�frame.���
It�does�not�matter�that�the�object�does�not�align�with�the�mat��
(it�is�positioned�on�it�s�side�or�upside�down),�Foto�3D�still�uses�
the�mat�to�identify�where�the�object�is�located�in�the�image�and�
to�select�regions�of�background.��Without�the�calibration�mat�in�
the�frame,�the�only�semi�automatic�masking�tool�available�is�
Shrink�Wrap�starting�from�a�hand�drawn�rough�outline.���

Figure 8.1.7.  Masking a bottom view photo that does not include a calibration mat. 
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During�Optimize Alignment,�the�mask�is�used�by�the�Alignment�Wizard�
to�test�whether�slightly�rotating�or�scaling�the�wireframe�mesh�will�
produce�a�better�alignment�of�the�silhouettes�of�the�mesh�with�that�of�the�
new�photo.��It�attempts�to�find�a�best�fit�of�the�two�silhouettes,�but�
inconsistent�masking�or�unusual�geometry�can�confuse�the�wizard.�

Figure 8.1.8.  Alignment Wizard settings. 

The�Alignment�Wizard�has�three�options�for�alignment.��Use�the��both�
fairly�accurate��setting�when�the�masks�have�been�made�consistently.��
If�the�masks�for�the�bottom�image�is�more�closely�masked�than�the�
masking�method�used�to�make�the�masks�used�to�construct�the�
wireframe,�then�choose�the��current�geometry�too�big��option.���
If�the�opposite�is�true,�that�the�new�photo�s�silhouette�has�a�shrink�wrap�
fringe�when�the�rest�of�the�model�is�more�tightly�masked,�then�choose�the�
�new�silhouette�is�too�big��option.��At�the�conclusion�of�the�masking�
process,�if�the�alignment�is�only�lightly�off,�try�the�scale�tool�to�lightly�
enhance�or�reverse�the�effect�of�this�option�setting.���

After�rough�positioning�the�model�and�selecting�your�alignment�option,�
click�the�Start�button�and�wait�for�the�model�to�be�adjusted.���
(Click�the�Stop�button�at�any�point�to�abort�without�finishing.)��
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During�Optimize Alignment,�the�mask�is�used�by�the�Alignment�Wizard�
to�test�whether�slightly�rotating�or�scaling�the�wireframe�mesh�will�
produce�a�better�alignment�of�the�silhouettes�of�the�mesh�with�that�of�the�
new�photo.��It�attempts�to�find�a�best�fit�of�the�two�silhouettes,�but�
inconsistent�masking�or�unusual�geometry�can�confuse�the�wizard.�

Figure 8.1.8.  Alignment Wizard settings. 

The�Alignment�Wizard�has�three�options�for�alignment.��Use�the��both�
fairly�accurate��setting�when�the�masks�have�been�made�consistently.��
If�the�masks�for�the�bottom�image�is�more�closely�masked�than�the�
masking�method�used�to�make�the�masks�used�to�construct�the�
wireframe,�then�choose�the��current�geometry�too�big��option.���
If�the�opposite�is�true,�that�the�new�photo�s�silhouette�has�a�shrink�wrap�
fringe�when�the�rest�of�the�model�is�more�tightly�masked,�then�choose�the�
�new�silhouette�is�too�big��option.��At�the�conclusion�of�the�masking�
process,�if�the�alignment�is�only�lightly�off,�try�the�scale�tool�to�lightly�
enhance�or�reverse�the�effect�of�this�option�setting.���

After�rough�positioning�the�model�and�selecting�your�alignment�option,�
click�the�Start�button�and�wait�for�the�model�to�be�adjusted.���
(Click�the�Stop�button�at�any�point�to�abort�without�finishing.)��

Step 4 

If�you�are�satisfied�with�the�new�alignment�of�the�image,�click�the�
"Accept"�button�to�commit�and�use�the�new�alignment.���
Click�the�Cancel�button�to�return�to�your�initial�alignment.���

Step 5 

After�repeating�the�alignment�process�for�each�additional�image,�repeat�
the�Generate�Wireframe�and�Generate�Texture�processes�as�desired�to�
produce�improved�geometry�and�textures�using�these�images.���

TIP: If�you�have�already�created�an�edited�texture�map,�you�can�
merge�in�the�additional�aligned�images�without�losing�your�
revisions�by�selecting�the�new�images�in�the�Thumbnail Window�
and�pasting�them�into�the�texture�using�the�Images >  
Paste Into Model�menu�item.��(Alternatively,�hold�down�the�
Ctrl�key�while�dragging�the�thumbnail�onto�the�Model Window).��

8.2.  Editing the Surface Texture  

The�automatically�generated�texture�may�need�to�be�edited�to�clean�up�
minor�artifacts�and�blemishes,�or�to�remove�supporting�structures�used�
to�hold�the�object�in�place�when�taking�photographs.��The�texture�editing�
tools�allow�you�to�touch�up�the�surface�texture�using�your�preferred�2D�
image�editor.��The�texture�can�also�be�edited�to�paint�a�new�color�onto�a�
region�or,�as�in�the�following�example,�to�superimpose�a�company�logo�
onto�the�model.��An�easy�to�use�intuitive�interface�is�provided�utilizing�
the�Windows�clipboard�to�transport�images�to�and�from�an�image�editor.���

Starting Point 

Create�or�open�a�textured�3D�model�from�a�set�of�photographs.���

Step 1 

In�order�to�make�a�company�logo�appear�as�a�decal�on�the�model�surface,�
orient�the�model�so�that�the�face�you�want�to�edit�is�centered�in�the�
display�window.��In�this�example,�rotate�the�model�by�using�the��

Rotate model�button�until�the�face�to�edit�is�fully�“front�on”�visible.���
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To�ensure�accurate�editing�without�loss�of�resolution,�make�sure�the�
model�is�filling�most�of�the�Model�display�area�by�zooming�in�using�the�

Zoom model�button.���

Figure 8.2.1.  Rotated and zoomed model clearly showing the area to be edited. 

Step 2 

Click�the� Copy View�button�from�Model�palette�to�copy�the�image�of�
this�view�of�the�textured�model�onto�the�clipboard.���

Step 3 

Paste�the�clipboard�image�as�a�new�image�into�your�preferred�2D�photo�
and�image�editor�such�as�Adobe�Photoshop�or�Corel�Paint�Shop�Pro.���
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Figure 8.2.2.  Opening New Image and Pasting texture into Photoshop. 

Note: Be�sure�the�image�is�not�resized�in�the�process.�
�

Pasting into Adobe Photoshop 

In� Photoshop,� care� is� required� to� ensure� the� image� dimensions� are�
preserved�when�pasting�from�the�clipboard.��First,�copy�the�image�onto�
the�clipboard�as�described.��Then,�create�a�new�image�file�using�the�File 

> New�menu� item.� �The�width�and�height� fields�will�be�automatically�
filled�in�by�default�with� the�dimensions�of� the� image�currently�on� the�
clipboard.� �These�should�not�be�changed.� �Click�OK� to�create� the�new�
image,�then�select�the�Edit > Paste�menu�item.���

Step 4 

Locate�and�open�an�image�of�the�logo�into�the�image�editor.��Select�the�
desired�region,�copy�and�paste�it�as�a�new�layer�onto�the�image�of�the�
textured�model.��Scale�and�position�the�logo�as�desired.���
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Figure 8.2.3.  Final edited texture with logo ready to drag from Photoshop onto Foto 3D. 

Step 5 

When�the�revisions�are�complete,�the�modifications�can�be�incorporated�
into�the�texture�map�in�Foto�3D.��To�do�this,�select�the�edited�image�using�
the�Select All�menu�item�and�copy�the�merged�layers�onto�the�clipboard�
as�a�single�layer.��Make�sure�the�edited�image�is�a�single�layered�image.��
In�Photoshop�either�select�Edit > Copy Merged�menu�item�and�then�
Paste�the�merged�image�as�a�new�layer,�or�select�the�Layer > Flatten 
Image�menu�item.��In�Paint�Shop�Pro�use�the�Layers > Merge > 
Merge All�menu�item.���

Return�(Alt�Tab)�to�Foto�3D�and�paste�the�copied�image�using�the��
�Paste View�button.���

Note: Photoshop�users�may�experience�difficulty�using�the�clipboard�for�
this�step�and�may�need�to�use�drag�and�drop�instead.�(see�below)�

�
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Pasting an Edited Image from Adobe Photoshop 

Photoshop�will�not�place�large�images�onto�the�clipboard.��Instead�you�
can�use��drag�and�drop�.��Flatten�the�image,�select�the�entire�image�area�
with�the�Select All�menu�item,�select�the��Move��tool�from�the�toolbar,�
then�simply�drag� the� image� from�Photoshop� into� the�Model Window� in�
Foto�3D.��(Do�not�click�the�Paste�button.)��

Note�when�using��drag�and�drop��you�can�drag�over�the�Foto�3D�icon�
in�the�Windows�Taskbar�to�bring�up�the�Foto�3D�application�and�then�
drop�the�image�onto�the�Model Window.���

Figure 8.2.4.  Edited view pasted back into Foto 3D 

Step 6 

Once�the�edited�image�is�pasted�(or�dropped)�into�Foto�3D�the�textures�
will�be�updated.��Foto�3D�will�examine�the�differences�between�the�
copied�and�pasted�images�and�will�only�update�areas�(triangles)�that�
have�had�pixels�changed�by�the�editing.��This�helps�preserve�the�texture�
image�quality�on�surfaces�not�affected�by�the�edit.���

Important Note: There�is�no�requirement�to�rebuild�the�textures�and,��
in�fact,�doing�so�would�replace�all�your�previous�texture�edits.�
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Editing Oblique Views 

The�texture�paste�function�has�a�protective�mechanism�that�prevents�you�
from�accidentally�editing�the�surface�textures�from�very�oblique�
viewpoints�(where�model�surfaces�tilt�steeply�away�from�the�viewpoint�
and�resolution�would�be�poor�due�to�foreshortening).��It�is�preferable�to�
rotate�the�model�so�that�the�surface�being�edited�is�nearly�parallel�with�
the�viewpoint.��If�you�are�nevertheless�trying�to�edit�the�surface�texture�
using�a�very�oblique�view�(e.g.��if�the�desired�surface�region�is�hidden�or�
steeply�angled�when�viewed�front�on)�then�you�will�need�to�turn�off�this�
protection�mechanism�before�pasting�your�edits.��From�the�right�click�
context�menu�in�the�Model View�display�area,�select�the�Texture

Editing > Protect oblique triangles�menu�item�to�toggle�the�protection�
state��Off�.��For�highest�quality,�we�recommend�that�you�leave�this�
feature��On��whenever�possible.��

You�can�rotate�the�model�to�see�how�your�edits�look�from�new�
viewpoints.��If�you�are�not�satisfied�with�the�changes,�simply�use�the��

Undo model or mask change�button�to�restore�a�previous�texture.�

Figure 8.2.5.  Two Views of edited model texture. 

In�this�example�we�chose�to�edit�the�side�of�the�model.��However�the�
same�process�can�be�used�to�edit�or�paint�the�textures�from�any�
viewpoint�and�repeated�for�several�view�angles.���
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8.3.  Removing Texture Artifacts  

Sometimes�there�are�artifacts�in�the�textures�that�are�generated�by�the�
automatic�texturing�process.��This�can�be�due�to:��

� inaccuracies�in�masking�and�the�resulting�geometry�of�the�
wireframe�mesh��

� camera�registration�errors�/�movement�of�the�object�on�the�mat��

� uneven�lighting�causing�changes�in�brightness�or�color�on�
surfaces�as�an�object�is�rotated��

� reflected�environments�appearing�on�shiny�objects��

Avoiding Seams  

Depending�on�the�settings�used,�in�a�well�masked�project�producing�
good�geometry,�automatically�generated�textures�will�generally�not�have�
noticeable�seams.��Seams�occur�when�an�area�of�the�mesh�is�not�directly�
in�front�of�the�camera�in�any�of�the�photos�used�for�texturing,�so�two�
different�photos�are�blended�using�a�technique�called��feathering��to�fade�
from�one�photo�to�the�next�where�the�angle�of�the�surface�shifts�away�
from�one�photo�and�toward�the�next.��This�fade�can�be�noticeable�on�large�
smooth�surfaces�or�reflective�objects�where�the�two�photos�have�
significantly�different�lighting�or�different�reflections�on�the�same�faces.��
Turning�on�color normalization�is�the�first�step�to�minimizing�lighting�
related�issues.��Seams�also�appear�when�there�is�some�inaccuracy�in�the�
photography�such�as�the�object�shifting�slightly�on�the�pedestal�during�
the�shoot,�an�errant�change�of�zoom�setting�during�the�shoot,�or�a�slight�
lens�calibration�error.���

The�default�setting�to�use�Texture Boosting�usually�helps�to�eliminate�
seams�by�attempting�to�texture�the�object�using�as�few�photos�as�practical�
to�reduce�the�number�of�blends�or�seams.��For�shapes�that�tend�to�be�
cubic,�this�can�be�highly�effective�as,�for�example,�only�six�photos�are�
needed�to�paint�the�six�sides�of�a�cube�and�with�sharp�corners,�the�blend�
area�is�on�the�extremely�narrow�bend�of�each�corner.��For�shapes�that�
have�flat�faces,�but�those�faces�may�not�be�square�to�one�of�the�side�views,�
such�as�an�abstract�shape�like�the�oblith,�or�faces�that�are�reflective�and�
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the�reflections�are�less�objectionable�in�some�photos�than�they�are�in�
others,�it�helps�to�have�taken�additional�photos�just�for�texturing�as�
described�in�Chapter�6�and�then�to�help�the�software�know�to�use�those�
photos�instead�of�others�when�texturing.���

For�cylindrical�surfaces,�it�may�help�to�have�several�smaller�photos�
blending�together�around�the�periphery�so�that�there�are�many�slight�
transitions�instead�of�fewer�major�transitions.��This�is�particularly�true�if�
there�are�lighting�hotspots�and�surface�tonality�changes�as�the�object�is�
rotated.��For�these�smooth�shapes,�particularly�if�even�lighting�is�a�
problem,�it�may�be�best�to�leave�Texture Boosting�off�so�that�all�of�the�
images�are�used�according�to�which�image�has�a�camera�angle�closest�to�
surface�normal�at�that�point�(perpendicular�to�the�surface�of�the�mesh.)�If�
there�was�any�movement�of�the�object�on�the�mat�or�similar�camera�
registration�problems,�this�setting�can�make�the�object�look�blurred�due�
to�extensive�feathering�of�several�slightly�mis�registered�images.���

Steps to Minimize Seams  

If�seams�are�apparent,�here�are�some�techniques�to�try:��

� Use�Color�Normalization���If�it�s�not�on,�turn�it�on�and�regenerate.���

� Try�Texture�Boosting�Off���If�an�object�was�textured�with�Texture�
Boosting�on,�try�turning�it�off�to�see�if�blending�more�photos�will�re�
texture�the�problem�area.���

� Try�Texture�Boosting�On���If�an�object�was�textured�with�Texture�
Boosting�off,�try�turning�it�on�to�see�if�having�fewer�feathered�edges�
eliminates�the�problem�feather.���

� Disable�Problem�Photos���Look�at�the�photos�that�are�being�used�to�
generate�the�texture�(either�the�first�six�or�so,�or�all�of�them).��If�one�of�
the�photos�has�an�area�of�objectionable�reflections�or�the�surface�is�
out�of�focus,�mark�that�photo��geometry�only��and�regenerate�the�
texture.��(Foto�3D�will�identify�another�photo�to�use�for�texturing�
from�that�camera�angle.)��
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� Prioritize�Better�Photos���If�Texture�Boosting�is�on�and�the�first�six�
photos�are�just�not�the�best�ones�to�use�because�of�lighting�effects,�
reflections�or�sharp�focus,�change�the�Order�to�increase�the�
importance�of�other�photos�that�would�be�better�to�use.���

� Spot�Repair�Problem�Areas�with�a�Better�Photo���If�you�need�just�a�
spot�repair�for�one�or�two�faces�of�the�object�and�it�otherwise�looks�
good,�try�looking�through�the�images�for�a�photo�that�would�produce�
a�better�result�for�the�face�(less�reflection�/�better�lighting)�and�use�
that�photo�to�repair�the�face�as�described�below.���

Performing Spot Repairs  

Sometimes�a�texture�needs�to�be�spot�edited�to�remove�a�seam�from�a�face�
or�to�restore�structured�features�such�as�lines�and�text�that�were�broken�
up�by�two�images�being�feathered�in�the�middle�of�the�feature.���

A�powerful�suite�of�texture�editing�tools�is�provided�that�allow�users�to�
eliminate�most�texturing�artifacts.��These�tools�allow�image�data�from�a�
single�photograph�in�your�project�to�be�used�to�replace�the�texture�for�a�
problematic�region�on�the�object.���

Three�techniques�are�available�to�do�this:��

� Simple Overlay��
� Overlay Using a Mask��
� Using an Image Editor for Spot Editing��

For�all�three�techniques�the�starting�point�is�the�same.���

Starting Point 

Create�a�textured�3D�model�from�a�set�of�photographs.��Identify�any�
problematic�regions�where�the�texture�could�be�improved�using�one�of�
the�original�photographs.��Try�the�suggestions�in�the�preceding�section�to�
get�to�the�best�starting�texture�attainable.���

If�the�problem�still�persists,�find�a�good�view�of�the�problem�area�from�
the�photographs�in�your�project.��This�should�ideally�be�close�to�a��front�
on��view�of�the�region�that�needs�touching�up.��Double�click�the�selected�
thumbnail�to�verify�the�best�image�has�been�found.���
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Figure 8.3.1.  Textured model with  
a seam along the front edge.

Figure 8.3.2.  Textured model with  
an artifact circled.

Figure 8.3.3.  “Best View” thumbnail being selected.

Simple Overlay  

The�simplest�solution,�assuming��
� 1)�no�other�edits�will�be�overwritten�and��
� 2)�the�selected�image�does�not�have�any�problem�areas�of�it�s�own,��
is�to�overlay�the�area�with�the�selected�photo.��Instead�of�selecting�a�
specific�region�in�the�selected�photo,�this�method�uses�the�entire�
photograph.��Simply�control�drag�the�selected�thumbnail�image�onto�the�
3D�view�(i.e.��while�holding�down�the�Ctrl�key,�drag�the�thumbnail�with�
the�left�mouse�button�down)�or�select�the�Images > Paste Into Model�
menu�item�and�the�texture�will�be�updated�by�this�photo.���
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Figure 8.3.3.  Using Ctrl-drag to paste the masked image onto the model. 

�

TIP: You�can�even�Ctrl�drag�a�thumbnail�onto�an�untextured�model!�

�

On�oblique�surfaces�(ones�that�tilt�away�from�this�front�on�view),�some�
feathering�will�be�applied�to�try�to�avoid�noticeable�seams.��Turning�on�
the�feature�to�protect�oblique�surfaces�may�prevent�the�reflection�on�the�
lower�side�of�the�oblith�from�appearing�in�the�final�texture�because�the�
surface�tilts�steeply�away.��To�turn�on�the�oblique�triangle�protection�
feature,�open�the�right�click�context�menu�in�the�Model�Display�area�and�
select�the�Texture Editing > Protect oblique triangles�menu�item�to�
toggle�the�protection�state�to��On�.���

Concerning�the�new�reflection�appearing�on�the�ridge�in�the�upper�left�of�
Figure 8.3.4,�it�would�have�to�be�masked�out�of�the�image�before�this�
image�was�pasted�onto�the�texture.��As�in�this�case,�if�the�result�is�not�to�
your�satisfaction�use�the� Undo model or mask change�button�or�
press�Ctrl�Z�to�Undo�it�and�try�the�next�technique.���

�
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Figure 8.3.4.  Overlay Repair of Seam - Repaired, but reflections added. 

�

Figure 8.3.5.  Simply Overlay Repair of Artifact - Successful repair. 

In�this�second�example,�artifacts�are�found�in�features�on�the�lid�of�this�
teapot.��The�top�down�photo�shows�that�the�handle�of�the�teapot�covered�
this�area�of�the�top�surface.��The�software�naturally�determines�that�the�
top�down�photo�is�the�best�one�to�use�to�paint�the�many�upward�facing�
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surfaces�of�the�teapot,�so�it�is�used�everywhere�on�the�top�surface�and�lid�
except�where�the�handle�blocks�the�view.��Because�Foto�3D�has�to�fill�in�
the�covered�area�from�another�photo�and�viewpoint�and�the�remaining�
photos�are�not�that�high�angle,�it�s�easy�to�understand�why�a�slight�
mismatch�between�the�mesh�and�the�object�would�cause�the�patched�area�
across�the�lid�to�be�misaligned.��The�easy�solution�is�to�locate�the�photo�
that�can�patch�the�covered�area�and�use�it�to�simply�texture�the�entire�top�
surface.��The�fourth�image�shows�the�entire�lid��repainted��and�the�
feathered�transitions�now�occurring�in�less�noticeable�areas�of�the�surface.���

TIP: This�repair�could�have�easily�been�avoided�with�another�top�
down�photo�strategically�shot�just�a�few�degrees�to�the�side�so�
that,�between�the�two�of�them,�the�entire�top�surface�was�visible�
despite�the�handle.��Their�viewpoints�would�be�so�similar�that�
any�mis�registration�would�be�at�most�an�unnoticeable�pixel�or�
two�of�offset.��Also,�increasing�the�importance�in�Project�Order�
of�the�photo�used�for�this�repair�might�avoid�the�need�for�a�
repair�if�the�texture�is�regenerated.�

Overlay Using a Mask  

The�next�solution�is�to�overlay�the�area�with�only�a�portion�of�the�selected�
photo.��Start�by�loading�another�instance�of�the�selected�photo�so�that�you�
can�apply�a�different�mask.��If�you�don�t�need�to�save�your�masks�for�use�
in�another�project,�simply�use�the�menu�item�to�load�an�additional�
instance�of�this�image�and�than�set�it�s�Image Type�to�"texture only".��
Select�the�Mask�tab�to�display�the�Mask�View�and�double�click�the�
thumbnail�to�display�the�photo.��If�it�is�not�already�masked,�create�an�
initial�mask�with�the�Auto�mask�button.��Now,�using�the�mask�painting�
tools,�set�the�mode�to�paint�mask,�select�a�brush�shape�and�a�brush�size,�
and�paint�a�mask�that�reveals�only�the�portion�of�the�photo�you�wish�to�
use�as�a�patch�to�spot�repair�the�problem�area.���
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Figure 8.3.6.  Photo masked to allow image to cover seam but not add new reflections. 

When�being�used,�all�of�the�mask�tools�produce�a�hard�edge,�but�when�
pasting�onto�a�texture,�Foto�3D�feathers�the�area�just�inside�the�mask�
edge�to�avoid�producing�a�seam.��You�may�find�it�best�to�paint�the�mask�
in�such�a�way�that�the�edges�of�the�mask�are�in�dark�or�recessed�surfaces,�
or�align�the�mask�edges�just�inside�the�nearest�edges�of�features�in�the�
image�so�the�features�are�not�feathered.��(If�more�precise�control�is�
needed,�use�the�external�editor�technique�described�in�the�next�section.)��

Once�the�image�is�masked,�switch�back�to�Model View�and�simply��
Ctrl�drag�the�selected�thumbnail�image�onto�the�Model�display�window,�
or�select�the�Images > Paste Into Model�menu�item,�and�the�texture�
will�be�updated�by�this�photo.���
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Figure 8.3.7.  Masked copy of photo being
Ctrl-dragged onto texture.

Figure 8.3.8.  Result: Seam repaired; 
no reflections added.

If�the�result�is�not�to�your�satisfaction,�Undo�it�and�try�the�next�technique.��
(This�technique�does�not�give�you�the�fine�control�you�might�achieve�
using�an�external�2D�image�editor,�but�it�can�be�very�useful�for�quickly�
fixing�problem�regions.)��

TIP: If�you�expect�you�will�want�to�save�this�new�mask�as�a�file�to�use�
in�another�project,�then�instead�of�loading�a�second�instance�of�
the�same�image�file,�make�a�copy�of�this�photo�s�file�in�the�
project�folder�using�Windows�Explorer�and�give�it�a�different�
file�name.��Once�you�are�done,�use�the�Images > Add Images 
menu�item�to�load�this�image�file�and�proceed�as�above�to�set�it�
to�"texture only",�mask�this�additional�photo�as�desired�and�
Ctrl�drag�it�onto�the�texture�map.��The�mask�for�this�copy�of�the�
photo�can�then�be�saved�using�the�Images > Masks >  
Save Masks�menu�item.
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Using an Image Editor for Spot Editing  

In�this�case,�we�will�show�how�spot�editing�can�be�achieved�using�the�
�Layers��capability�of�standard�image�editing�tools�such�as�Corel�Paint�
Shop�Pro�and�Adobe�Photoshop.���

Step 1 

As�before,�identify�the�best�photo�to�use�as�a�source�for�spot�repairs.��
Transfer�the�selected�photo�into�a�2D�image�editor�application.��This�is�
best�achieved�using�the�clipboard�so�that�a�properly�distortion�corrected,�
color�normalized�and/or�downsampled�image,�that�is�ready�to�be�
patched�into�the�texture�map,�is�used�for�editing.��To�do�this,�right�click�
on�the�thumbnail�and�select�the�Images > Copy Image�menu�item.���

Figure 8.3.9.  Copying a source image to the clipboard by using Images > Copy Image. 

Paste�the�clipboard�image�as�a�new�image�into�your�2D�image�editor�
application.��(In�Photoshop,�create�a�new�image�while�the�copied�image�is�
on�the�clipboard�to�make�sure�the�copied�image�s�size�is�used�as�the�
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dimensions�of�the�new�image,�then�Paste.)�Take�care�that�the�image�is
resized�(See�Photoshop�techniques�in�

�not�
Editing the Surface Texture).���

Step 2 

ch�to�Model View�by�clicking�on�the�"Model"�tab.��Change�the�
ted�

 display area  
to rotate and scale the model to match the camera’s viewpoint.

Now�copy ing�the�

Swit
viewpoint�of�the�3D�model�to�match�the�copied�photo.��Drag�the�selec
thumbnail�image�into�the�3D�view�and�the�model�will�be�rotated�so�that�
the�correct�viewpoint�is�automatically�displayed.���

Figure 8.3.10.  Drag Thumbnail onto Model View

�this�view�of�the�textured�model�onto�the�clipboard�us
�Copy View�button�found�on�the�Model�Palette.���

Step 3 

rn�to�the�2D�image�editor�(Alt�Tab)�and�paste�the�clipboard�image�as�

�from�the��Edit��menu.��In�

oint�was�aligned�to�match�the�selected�photo,�the�
�

Retu
a�new��Layer��on�top�of�the�existing�image.���

In�Photoshop�simply�select�the��Paste��option
Paint�Shop�Pro�select�the��Paste��option�from�the��Edit��menu�and�click�
on��As�New�Layer�.���

Note: Since�the�viewp
clipboard�image�and�the�image�already�in�the�2D�image�editor�should�be
perfectly�aligned.���
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Figure 8.3.11.  Pasted as base layer is the
selected source photograph. 

Figure 8.3.12.  Pasted to a new layer is 
the textured model from same viewpoint. 

Step 4 

To�replace�the�problem�region,�we�will�create�a�mask�for�the�new�layer�
and�mask�out�the�problem�area�to�reveal�the�underlying�original�image.���

Create�an�opaque�mask�for�the�layer.��In�Photoshop�select��Add�Layer�
Mask��from�the��Layer��menu�and�click��Reveal�All�.��In�Paint�Shop�Pro�
select��New��from�the��Masks��menu�and�click��Show�All�.���

Step 5 

By�carefully�editing�the�mask�we�can�mask�away�the�problem�areas�to�
reveal�the�pixels�from�the�original�photograph.��A�soft�brush�is�
recommended�to�ensure�there�are�no�obvious�seams.���

Figure 8.3.13.  Mask painted to reveal underlying photo layer with clearer features. 

STRATA FOTO 3D - Chapter 8
Improving The Surface Texture

156



TIP: To�edit�the�mask�in�Paint�Shop�Pro,�select�the��Edit��option�from�
the��Mask��menu.��In�Photoshop�make�the�mask�active.��Then�
select�black�as�the�foreground�color�and�the��Paintbrush��tool.�
From�the�tool�options�choose�a�suitably�sized�brush�and�select�a�
low�value�for��hardness�.��Paint�over�the�problem�areas�to�reveal�
the�underlying�photo.��Switch�the�paint�color�to�white�to�undo�
or�restore�areas�of�the�upper�layer.��

Step 6 

The�edited�image�can�now�be�transferred�back�via�the�clipboard�or��drag�
and�drop�.��Before�you�do�so,�the�image�needs�to�be�a�single�layer.���
In�Paint�Shop�Pro�the�flattened�image�can�be�copied�on�to�the�clipboard�
and�pasted�into�Foto�3D�using�the� Paste View�button.���

In�Photoshop,�either�choose�the�Flatten Image�menu�item�or,�to�keep�
your�layers�intact�for�further�editing,�use�the�Edit > Select All�menu�
item�to�select�the�entire�image,�the�Edit > Copy Merged�menu�item�to�
place�the�flattened�image�on�the�clipboard,�and�then�the�Edit > Paste�
menu�item�to�insert�the�flattened�image�as�a�new�layer.��With�this�new�
flattened�layer�active,�select�the��Move�Tool��and�drag�the�flattened�
image�onto�the�Model Window�in�Foto�3D.���

Figure 8.3.14.  Completed spot repair to Foto 3D model. 
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9.1.  Using Foto 3D's VRML Exports  

Now�that�your�Foto�3D�model�is�completed,�this�section�suggests�a�few�
ways�to�display�and�use�your�model�outside�Foto�3D.��

Figure 9.1.1.  A completed model displayed on a web page using Strata Live 3D. 

159

Chapter 9

Displaying and Using 

The Final Model



Displaying VRML Models and Worlds

Follow�the�steps�in�Chapter�5�to�export�your�model�as�a�VRML�(.WRL)�
file.��This��Virtual�Reality�Markup�Language��file�and�its�companion�
texture�map�comply�with�the�industry�standard�VRML�97�/�VRML�2�
specification�for�defining�3D�objects�and�textures.��Any�VRML�2�
compliant�browser�plug�in�or�application�should�be�capable�of�importing�
and�displaying�your�model.��If�you�exported�your�model�with�the�
�Launch�Viewer��option�enabled,�you�will�discover�whether�you�already�
have�a�suitable�viewer�or�browser�plug�in�available�on�your�computer.���
If�you�don�t,�perform�an�internet�search�for�the�latest�VRML�plug�ins�and�
viewers;�many�are�free.��(One�open�source�browser�plug�in�we�have�used�
is�Cosmo,�found�at�http://cic.nist.gov/vrml/cosmoplayer.html�)�

Displaying in Strata Live 3D 

Figure 9.1.2.  Several completed models displayed using Strata Live 3D. 

Strata�provides�an�exciting�product,�Strata�Live�3D,�that�will�open,�light,�
and�display�your�Foto�3D�models�either�locally�or�on�the�web�with�an�
elegant�set�of�interactive�controls�that�allow�your�model�to�be�rotated,�
moved�and�even�zoomed�to�see�the�fine�details.���
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Strata�Live�3D�also�has�a�new�feature�that�allows�these�interactive�models�
to�be�embedded�in�an�Adobe�PDF�file�and�displayed�using�the�new�3D�
features�built�into�Adobe�s�free�Acrobat�Reader�(version�7.0�or�higher)�
without�the�use�of�plug�ins.��This�powerful�combination�allows�one�PDF�
document,�such�as�a�product�catalog,�to�be�printed�with�beautifully�
rendered�3D�models�on�the�page,�and�also�viewed�on�a�computer�with�
your�choice�of�interactive�controls�on�the�PDF�page�that�allow�the�user�to�
rotate�and�zoom�into�each�of�the�products�on�the�page.���

If�the�object�has�been�modeled�with�moving�parts,�such�as�a�cell�phone�
flipping�open,�or�the�camera�has�been�animated�to�follow�a�specific�fly�by�
path,�controls�for�replaying�these�movements�can�be�included�as�well.��
Combining�Strata�Live�3D�with�other�Strata�products�allows�very�
effective�marketing�graphics�and�impressive�displays�to�be�prepared.���

TIP: To�best�prepare�your�models�for�Live�3D,�orient�them�to�what�
would�be�considered��front��view�in�the�Foto�3D�software�
(similar�to�a�side�view�photo)�and�save�them�with�the��
"Use Current Orientation"�checkbox�turned�on.���
This�orientation�helps�the�drop�shadow�produced�in�Live�3D�to�
be�correctly�oriented�from�the�outset.��You�can�then�reorient�to�
the�preferred�display�angle�for�the�initial�view�when�the�model�
is�first�displayed�and�add�any�desired�lighting.

Photo Realistic Renders and Animations 

The�ultimate�in�combining�ease�of�use�with�sophisticated�photo�realistic�
3D�modeling�comes�from�joining�together�Foto�3D,�to�quickly�create�
models�of�parts�with�photo�realistic�textures,�with�a�3D�modeling�
software�package,�such�as�Strata�3D�CX,�to�create�the�rest�of�the�scene.���

Putting�together�a�set�of�parts�modeled�in�Foto�3D,�in�Strata�3D�CX�you�
can�form�a�very�detailed�and�complex�final�assembly.��Apply�a�simple�
kinematic�skeleton�and�those�parts�move�and�rotate�as�if�they�were�
hinged�together.��A�myriad�of�tools�can�be�used�to�place�these�models�in�
an�environment�such�as�a�living�room�and�add�lights�and�views�out�the�
window.��An�entire�scene�can�be�crafted�and�rendered�with�one�of�the�
fastest�and�most�sophisticated�rendering�engines�available�in�the�
personal�computer�market,�producing�stunningly�realistic�renders.���
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TIP: The�performance�of�all�modeling�software,�including�
Strata�3D�CX,�is�affected�by�the�complexity�of�the�modeling�
tasks�it�is�asked�to�perform,�which�is�dictated�in�part�by�the�
complexity�of�the�models�placed�in�the�scene.��If�several�
complex�models�are�being�combined�in�a�scene�or�a�Foto�3D�
model�is�being�positioned�far�from�the�camera,�you�do�not�need�
the�processing�overhead�of�providing�very�precise�and�complex�
models�with�lots�of�polygons�and�large�texture�maps�with�more�
detail�than�can�be�seen�from�that�distance.��The�excess�detail�
only�slows�down�the�software�as�you�setup�the�scene�and�
increases�rendering�time.��Use�the�Decimation slider�to�
minimize�the�number�of�triangles�to�a�few�thousand�or�even�into�
the�hundreds,�and�set�the�texture�map�size�to�1024�or�768�instead�
of�1280�or�1600.���
(Note�that�a�perfect�cube�is�made�with�only�12�triangles!)�

Putting It All Together 

As�a�final�note,�remember�the�first�tool�mentioned;�the� Make all�
button.��With�a�controlled�lighting�environment,�using�Interactive�
Masking�to�find�the�conservative�side�of�the��just�right��Background 
Detection Threshold,�and�setting�an�optimum�default�Number of 
Triangles for Decimation�appropriate�to�your�display�media,�you�can�
be�producing�sophisticated�photo�realistic�models�for�use�in�virtual�
scenes�and�renders�or�online�catalogs�and�galleries�with�minimal�effort.���

Enjoy Foto 3D 

The�folks�at�Strata�hope�you�are�pleased�with�the�models�you�make�with�
Foto�3D�and�are�satisfied�with�this�product.��If�you�have�questions�or�
suggestions,�please�contact�us�at�support@strata.com.�

Thank�you�for�purchasing�Strata�Foto�3D.���
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Troubleshooting and Support

Strata�is�proud�of�its�exceptional�support.��Help�is�just�an�e�mail�away.���

As�a�quick�first�step,�look�at�the�many�support�resources�available�in�the�
support�section�of�Strata’s�website�at�www.Strata.com��

Also�visit�our�user�community�site,�the�Strata�Cafe�at�www.StrataCafe.com�
and�register�to�participate�in�the�Strata�User�Forums.��Chances�are,�others�
in�the�Strata�community�have�come�across�the�same�issue.��Some�very�
experienced�graphic�artists,�3D�designers�and�animators�frequent�the�
Strata�Café’s�forums�and�are�quick�to�respond�with�suggestions�and�
solutions�to�your�modeling�challenges.���

If�a�review�of�the�Forums�and�FAQs�don�t�solve�the�problem,�drop�us�a�
note.��To�keep�our�support�free,�it�is�limited�to�e�mail�requests�only.���
Send�your�questions�and�requests�to�support@strata.com�and�please�put�
�Foto�3D��in�the�subject�line�with�your�topic.��If�you�are�experiencing�
errors,�please�include�details�of�your�computer,�including�CPU,�memory�
and,�most�importantly,�your�graphics�card.��We�ll�get�back�to�you�quickly.���

�

�
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Upgrading to Pro

Strata�is�very�excited�and�proud�to�be�collaborating�with�3DSOM�and�
adapting�their�patented�technologies�to�compliment�and�extend�the�
Strata�Suite�of�3D�modeling�software�products.���

This�edition�of�Foto�3D�is�designed�to�meet�the�needs�of�most�online,�
catalog�and�photo�realistic�model�creation�requirements;�however�there�
are�some�applications�that�would�benefit�from�even�more�advanced�
features�that�are�available�in�the�Professional Edition.���

The�Professional�Edition�offers:��
� Up�to�a�six�times�increase�in�Texture�map�resolution���Texture�files�

can�be�saved�at�4096x4096�pixels�instead�of�1600x1600�pixels.���
� An�unlimited�number�of�triangles�in�the�undecimated�wireframe�

(Foto�3D�is�limited�to�16,000)��
� The�ability�to�merge�models�and�textures�from�two�photo�sets�of�

the�same�object���you�can�turn�it�over�and�model�the�bottom.���
� The�ability�to�export�the�mesh�to�a�modeling�program�like�

Strata�3D�CX�to�enhance�shapes�and�import�the�result�for�texturing.���
� Improved�modeling�power�and�usability,�including�additional�

advanced�modeling�tools�such�as�subdivision�surface�modeling.���
� Improved�texturing�tools,�including�View�Dependant�Textures.���
� A�Java�based�browser�for�displaying�models�(similar�to�Live�3D).���
� Additional�export�formats�including�Macromedia�Shockwave�3D�

and�HI�Corp.��Mascot�Capsule.���

Additional�features�and�details�are�listed�on�the�product�web�page.���

Strata�is�proud�to�offer�a�discounted�upgrade�through�it�s�website�at�
www.strata.com.��While�at�the�Strata�store,�don�t�miss�the�opportunity�to�
upgrade�to�the�full�suite�of�Strata�3D�modeling�products.��These�include�
Strata�Live�3D�for�displaying�your�Foto�3D�models�in�an�elegant�online�
viewer�or�in�PDF�documents,�and�Strata�s�flagship�product,�Strata�3D�CX�
for�creating�and�animating�scenes�that�incorporate�your�Foto�3D�models,�
and�rendering�with�Raydiosity,�Strata�s�powerful�rendering�engine�that�
includes�soft�shadows�and�reflections,�powerful�lighting�options�and�a�
whole�host�of�tools�for�creating�photo�realistic�renders.���
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Calibrating the Lens  

Standard�zoom�and�wide�angle�lenses�can�produce�significant�distortion�
of�an�image.��Straight�lines�at�the�edges�of�an�image�can�become�curved.��
These�lens�distortion�effects�can�impact�the�accuracy�of�the�model.���

Foto�3D�can�automatically�recognize�many�standard�cameras�and�their�
lenses�using��EXIF�data��found�in�TIFF�and�JPEG�images.���
This�information,�sometimes�called��metadata�,�is�included�in�the�image�
file�by�the�majority�of�digital�cameras�and�identifies,�among�other�things,�
the�camera�and�its�lens�settings.��For�lenses�found�in�the�database,�
Foto�3D�will�automatically�correct�for�lens�distortion.��There�is�no�
advantage�to�manually�calibrating�a�lens�if�Foto�3D�is�successful�at�
automatically�calibrating�the�lens�from�the�EXIF�data�and�a�set�of�photos.���

For�unrecognized�cameras,�older�cameras�that�do�not�write�EXIF�data,�
cameras�with�changeable�lenses,�and�some�zoom�lenses,�Foto�3D�
provides�a�Lens�Calibration�Wizard�for�automatically�calibrating�the�lens�
based�on�taking�additional�photos�of�a�special�lens�calibration�target.��
Once�the�lens�has�been�calibrated,�new�photos�will�automatically�be�
distortion�corrected�when�they�are�loaded�in�the�software.���

Here�is�the�calibration�procedure.���

Step 1 

Launch�the�Lens�
Calibration�Wizard�using�
the�File > Calibrate 
Lens... menu�item.��
When�the�Lens Calibration 
Wizard Window�opens,�if�
you�have�already�profiled�
your�lens,�then�select�the�
second�option�to�load�your�
saved�profile.��Otherwise,�
choose�the�first�option,�
"New calibration",�to�
calibrate�from�photos.���
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Step 2 

The�first�step�is�to�print�
out�the�lens�calibration�
grid�(a�regular�grid�of�
dots)�onto�a�plain�sheet�of�
white�paper.��Click�the�1.
Print calibration grid�
button�to�open�the�print�
dialog.���

Ideally,�you�should�try�to�
print�out�a�lens�calibration�
grid�roughly�the�same�size�
as�a�typical�object�and�mat�
you�will�be�modeling.��
That�way�you�can�take�photos�of�the�grid�at�a�similar�distance�and�zoom�
setting�as�you�will�use�with�your�objects.��(However,�this�is�not�essential.)��

Click�the��Change...��button�to�modify�the�page�setup�and�margins,�
allowing�you�to�print�larger�grids�over�multiple�pages.��Generally,�
selecting�a�paper�size�and�selecting��Fit�to�Page��is�most�convenient.��
Click�the�OK�button�to�print.���

Step 3 

Place�the�lens�calibration�grid�onto�a�flat�surface�such�as�a�rigid�piece�of�
card�stock.��If�the�grid�is�printed�over�multiple�sheets,�be�careful�to�line�
up�the�sheets�accurately�using�the�guides.���

To�calibrate�a�fixed�focal�length�lens�you�need�to�take�up�to�three�“front�
on”�shots�from�slightly�different�angles�(at�an�angle�less�than�10�degrees�
off�of�surface�normal�/�nearly�perpendicular�to�the�surface).���

To�calibrate�a�zoom�lens�you�need�to�take�“front�on”�shots�of�the�grid�at�a�
range�of�zoom�settings.���

Note: If�your�camera�does�not�export�JPEG�or�TIFF�images�with�EXIF�
data,�you�will�need�to�calibrate�for�and�use�a�single�fixed�zoom�setting�for�
all�photos�and�treat�it�as�a�fixed�focal�length�camera.�
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General�points�to�note...���

� Use�a�tripod�if�available.���

� Make�sure�the�grid�pattern�is�flat.���

� Make�sure�the�camera�view�is�reasonably�front�on�or�perpendicular�
to�the�target�so�that�there�is�minimal�perspective�distortion.���

� Make�sure�the�dots�fill�the�whole�image.���

� You�don�t�need�to�see�the�whole�grid�but�make�sure�each�visible�
row�or�column�includes�at�least�6�dots.���

� To�calibrate�a�zoomed�in�lens�setting,�you�may�need�to�move�the�
camera�away�from�the�grid�pattern.���

� Take�one�shot�for�each�zoom�setting�you�plan�to�use�(for�cameras�
that�do�not�allow�you�to�set�a�repeatable�zoom�setting,�try�using�it�s�
power�on�default�setting,�it�s�fully�zoomed�setting,�or�it�s�fully�wide�
angle�setting�for�all�projects;�or�reshoot�the�calibration�grid�with�
each�session�s�lens�setting.���

� �

Figure 10.3.1.  Photos of the calibration grid taken at different zoom settings 
with focal lengths of 5.8mm, 9.2mm, 18.4mm and 58.0mm. 

Step 4 

Once�you�have�taken�the�calibration�photos,�transfer�them�to�your�
computer�and�load�them�by�clicking�the�3. Load photos�button.���
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Step 5 

Once�Foto�3D�has�processed�the�photos�you�will�see�the�following�page.���

Figure 10.3.2.  Successful calibration - Lines added to show dots are now on straight rows. 

You�can�see�the�input�photos�and�the�distortion�corrected�images�
resulting�from�lens�calibration.��The�dots�should�now�appear�in�precise�
straight�lines.��(The�lines�may�be�tilted�as�this�reflects�any�off�axis�
perspective�of�the�camera.)��

You�can�save�the�calibration�data�for�future�projects�using�the�Save�
button.��To�reload�a�calibration�you�can�use�the�"Load existing 
calibration settings"�option�when�the�wizard�is�launched.���

Click�the�Finish�button�to�continue�with�your�project.��Imported�photos�
(using�the� New project...  button�or�the�Images > Add Images...  
menu�item)�will�now�be�automatically�corrected�using�the�results�of�this�
calibration.���
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Step 5 

Once�Foto�3D�has�processed�the�photos�you�will�see�the�following�page.���

Figure 10.3.2.  Successful calibration - Lines added to show dots are now on straight rows. 

You�can�see�the�input�photos�and�the�distortion�corrected�images�
resulting�from�lens�calibration.��The�dots�should�now�appear�in�precise�
straight�lines.��(The�lines�may�be�tilted�as�this�reflects�any�off�axis�
perspective�of�the�camera.)��

You�can�save�the�calibration�data�for�future�projects�using�the�Save�
button.��To�reload�a�calibration�you�can�use�the�"Load existing 
calibration settings"�option�when�the�wizard�is�launched.���

Click�the�Finish�button�to�continue�with�your�project.��Imported�photos�
(using�the� New project...  button�or�the�Images > Add Images...  
menu�item)�will�now�be�automatically�corrected�using�the�results�of�this�
calibration.���

Glossary of Terminology

alignment  
If�an�image�is�loaded�into�Foto�3D�that�doesn�t�include�the�calibration 
mat,�then�Foto�3D�cannot�use�it�until�the�camera�location�has�been�
defined.��This�process�is�called��alignment��and�can�also�be�used�to�adjust�
the�camera�position�for�other�images�that�do�include�the�mat�but�the�
object�has�accidentally�been�moved�or�has�been�turned�upside�down�to�
photograph�the�bottom.���

backdrop  
A�plain�colored�sheet�of�roll�paper,�card�stock�or�foam�core�placed�behind�
the�object�in�each�photograph�to�help�Foto�3D�automatically�separate�the�
object�from�its�background.���

calibration mat  
The�mat�is�a�flat�surface�with�special�pattern�of�dots�that�is�placed�under�
the�object�to�be�modeled�when�it�is�photographed.��This�mat�allows�
Foto�3D�to�automatically�determine�the�exact�position�of�the�camera�
relative�to�the�object�in�each�photograph.���

clipping  
Clipping�is�used�to�remove�unwanted�geometry�from�the�stand�under�the�
base�of�the�model.��A�horizontal�“clipping�plane”�can�be�moved�up�and�
down�to�choose�the�cut�off�point�and�then�all�wireframe�geometry�below�
that�plane�is�removed,�leaving�the�model�with�a�flat�bottom�surface.���

decimation
The�number�of�triangles�in�a�triangle�mesh�can�be�reduced�continuously�
by�a�technique�known�as��decimation�.��At�each�stage,�a�single�vertex�is�
removed�from�the�mesh�and�the�surface�re�triangulated�around�the�
missing�vertex�to�produce�a�closed�mesh�with�one�fewer�triangles.��
Which�vertex�to�remove�is�carefully�selected�by�the�software�to�minimize�
the�impact�on�the�shape�of�the�surface.��The�level�of�decimation�to�be�
used�is�a�compromise�between�having�a�sufficient�number�of�triangles�to�
define�the�fine�details�in�the�surface�of�an�object,�and�minimizing�the�
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complexity�of�the�exported�model,�which�in�turn�reduces�file�size,�
loading�time,�memory�requirements,�and�rendering�time�when�
displaying�the�model�online�or�using�the�model�in�a�scene.���

mask
Each�image�in�the�project�usually�needs�an�associated�mask�that�defines�
where�the�object�lies�within�the�image.��Foto�3D�uses�the�boundary�
between�the�masked�and�unmasked�regions�of�an�image�to�define�the�
outline�or�silhouette�of�the�object�as�seen�from�that�vantage�point.���
The�outlines�from�all�the�images�in�the�project�are�combined�to�define�the�
shape�of�the�object�in�3D�space.���A�mask�can�also�be�used�to�control�
which�areas�of�a�photo�are�to�be�used�to�texture�the�surface�of�the�model.�

model
The�virtual�representation�of�your�object�in�the�computer�as�opposed�to�
the�real�physical�object�you�photographed.��A�model�is�composed�of�a�
wireframe�mesh�wrapped�with�a�photo�realistic�image�or�texture�map.���

object
The�physical�item�that�will�be�photographed�and�modeled.��In�contrast,�
the��model��is�the�computer��generated�likeness�of�the�object�created�by�
Foto�3D.���

pedestal or stand  
A�pedestal�or�stand�is�highly�recommended�to�raise�the�object�up�above�
the�calibration�mat�when�taking�photographs,�so�that�the�bottom�portion�
of�the�object�appears�fully�surrounded�by�the�backdrop�in�most�views.���

rejected  
Images�can�be�marked�as�"rejected"�which�means�that�they�will�not�be�
used�for�subsequent�operations�such�as�creating�the�geometry�or�textures.��
Images�automatically�marked�as�rejected�by�Foto�3D�can�nevertheless�be�
used�to�add�texture�to�the�bottom�of�the�model,�or�for�other�purposes,�by�
aligning�them�to�the�model�using�the�alignment�process.���
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synthetic view  
A�photo�realistic�view�created�from�a�snapshot�of�the�virtual�model�
rather�than�by�taking�a�photograph�of�the�object�–�this�image�is�useful�for�
editing�the�shape�of�the�geometry�as�seen�from�viewpoints�which�were�
not�originally�photographed�or�were�inaccessible.���

texture map  
A�texture�map�reproduces�the�appearance�and�texture�of�the�original�
object.��It�is�a�color�image�that�is,�for�the�most�part,�wrapped�around�the�
model�surface.��It�is�called�a��map��because�portions�of�the�image�are�
mapped�to�specific�triangles�of�the�mesh�using�coordinates�in��U�V�
space��which�are�surface�coordinates�for�the�model.��Foto�3D�textures�are�
considered��baked�on��in�that�they�visually�simulate�the�effects�of�small�
surface�contours,�undulations�and�roughness�that�are�too�fine�to�be�
captured�in�the�wireframe�mesh�by�capturing�the�light�and�shadow�
normally�seen�on�the�surfaces�of�an�object.���

triangle mesh  
Foto�3D�creates�a�3D�model�as�a�continuous�surface�(possibly�in�several�
disconnected�pieces)�made�up�of�triangles,�called�a��triangle�mesh��(see�
“wireframe”.)���

VRML
An�acronym�for�Virtual�Reality�Markup�Language,�VRML�is�an�industry�
standard�format�for�files�that�construct�3D�objects�and�scenes�using�
vector�models�.��Many�software�packages�support�and�display�VRML.�

wireframe model  
The�3D�model�that�Foto�3D�creates�before�the�texture�is�applied�is�often�
referred�to�as�a��wireframe��model�or�mesh.���It�is�a�mathematical�
representation�of�the�object’s�shape�consisting�of�points�or�vertices,�lines�
connecting�those�vertices,�and�resulting�polygon�surface�faces�that�are�
collectively�expressed�as�vectors�in�3D�space.��For�Foto�3D,�all�faces�are�
triangular�and�so�the�wireframe�model�is�also�called�a�“triangle�mesh”.�
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Trademarks, Copyrights and Legal Notices  

Disclaimer 

While�every�precaution�has�been�taken�in�the�preparation�of�this�
document,�the�publisher�assumes�no�responsibility�for�errors�or�
omissions,�or�for�incidental�or�consequential�damages�resulting�from�the�
use�of�the�information�within�this�document.��The�publisher�reserves�the�
right�to�make�modification�to�this�document,�or�to�the�contents�of�this�
document,�at�any�time�without�notice.���

Trademarks 

Strata,�Strata�3D�CX,�Strata�Foto�3D�and�Strata�Live�3D�are�trademarks�of�
Corastar,�Inc.���

3DSOM�and�3DSOM�Pro�are�trademarks�of�Creative�Dimension�Software�
Ltd��

Microsoft,�Windows,�Windows�2000,�and�Windows�XP�are�registered�
trademarks�of�Microsoft�Corporation.���

Pentium�is�a�registered�trademark�of�Intel�Corporation.���

Adobe�and�Photoshop�are�registered�trademarks�of�Adobe�Systems�
Incorporated.���

Corel�and�Paint�Shop�Pro�are�registered�trademarks�of�Corel�Software,�
Inc.���

3ds�max�and�3D�Studio�Max�are�registered�trademark�of�Autodesk,�Inc.���

All�other�trademarks�mentioned�herein�are�trademarks�of�their�respective�
owner.���

Acknowledgements 

The�model�and�images�of�the��With�Love��figurine�were�reproduced�with�
permission�of�Christine�Haworth�and�the�Crisalis�Collection,�all�rights�
reserved.��www.crisalis.co.uk�or�Crisalis�Collectors�Club�Ltd,�Unit�B,�
Carmel,�Stockclough�Lane,�Feniscowles,�Blackburn,�BB2�5JR,�UK�

The�model�and�images�of�the�Tikimon�Kali�figurine�were�produced�with�
permission�of�Mezco�Toyz.��Kali�figure�©�Mezco�Toyz,�all�rights�reserved.�
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The�photography�and�Foto�3D�models�used�for�several�examples�in�this�
book�were�provided�courtesy�of�Michael�Luscombe�and�Duke�Speer,�both�
3D�Artists�in�the�Strata�User�Community.��Reproduced�with�permission.��
This�book�was�edited�for�Strata�by�Duke�Speer.���

Copyright Notice 

Software�developed�by�Strata�and�Creative�Dimension�Software�Ltd�as�a�
joint�venture�based�upon�an�original�design�and�product�developed�by�
Creative�Dimension�Software�Ltd.��Portions�Copyright�©�2006,�Corastar,�
Inc.,�Copyright�©�2006,�Creative�Dimension�Software�Ltd.���
All�rights�reserved.���

This�documentation�of�Strata�Foto�3D�is�based�upon�original�product�
documentation�developed�by�Creative�Dimension�Software�Ltd.���
Portions�copyright�©�2006,�Corastar,�Inc.��and�copyright�©�2006,�Creative�
Dimension�Software�Ltd.��All�rights�reserved.���

This�document,�either�in�whole�or�in�part,�may�not�be�reproduced�or�
transmitted�in�any�form�or�by�any�means�without�the�prior�written�
permission�of�the�publisher.���
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End User License Agreement (EULA) 

This�License�Agreement�(�Agreement�)�is�a�legal�agreement�between�Corastar,�Inc.��
(�Corastar�)�and�you,�the�user�of�this�Corastar�software�program�(�Software�).��You�
agree�to�be�bound�by�the�terms�of�this�Agreement�by�installing,�copying,�or�using�the�
Software.��If�you�do�not�agree,�do�not�install,�copy,�or�use�the�Software.��You�
understand�that�the�Software�is�licensed�to�you,�not�sold,�and�that�all�right,�title�and�
interest�in�and�to�the�Software�remains�vested�in�Corastar�and�its�licensors.���

1. Corastar�grants�you�the�following�rights�provided�that�you�comply�with�all�terms�
and�conditions�of�this�Agreement�and�that�you�make�payment�to�Corastar�of�the�
applicable�license�fees�for�the�Software.��This�grant�of�license�to�you�is�non�
exclusive:��

1.1�You�may:��
(a) install�the�Software�on�one�personal�computer�or�other�device�(or�on�a�network�

storage�device,�such�as�a�server�computer,�and�allow�one�access�device,�such�as�
a�personal�computer,�to�access�and�use�the�Software�over�a�private�network);��

(b) physically�transfer�the�program�from�one�computer�to�another,�provided�the�
program�is�installed�on�only�one�computer�at�a�time;��

1.2�You�may�not:��
(a) use�the�Software�in�any�service�bureau,�timesharing�or�rental�arrangement;��
(b) allow�use�of�the�Software�by�any�third�party�(except�for�reasonable�use�by�

third�party�service�providers�for�the�benefit�of�you,�the�licensee).���

2. Corastar�reserves�all�rights�not�expressly�granted�to�you�in�this�Agreement.��The�
Software�is�protected�by�copyright�and�other�intellectual�property�laws�and�
treaties.��Corastar�or�its�suppliers�own�the�title,�copyright,�and�other�intellectual�
property�rights�in�the�Software.��The�Software�is�licensed,�not�sold.��This�
Agreement�does�not�grant�you�any�rights�to�trademarks�or�service�marks�of�
Corastar�or�its�licensors.���

3. You�may�not�reverse�engineer,�decompile,�or�disassemble�the�Software,�except�
and�only�to�the�extent�that�such�activity�is�expressly�permitted�by�applicable�law�
notwithstanding�this�limitation.��You�may�not�rent,�lease�or�lend�the�Software,�or�
make�the�functionality�of�the�Software�available�as�a�hosted�service.���

4. Update�Policy:�In�order�to�be�able�to�obtain�updates�of�the�program�you,�the�
licensee,�must�complete�and�return�the�Registration�Card�included�in�the�
package�to�Corastar,�Inc.��or,�in�place�of�mailing�in�the�physical�registration�card,�
register�the�Software�at�the�Strata�website.��IF�THIS�SOFTWARE�IS�NOT�
REGISTERED�WITH�CORASTAR.,�CORASTAR,�INC.��IS�UNDER�NO�
OBLIGATION�TO�MAKE�AVAILABLE�TO�YOU�ANY�UPDATES�EVEN�
THOUGH�YOU�HAVE�MADE�PAYMENT�OF�THE�APPLICABLE�UPDATE�FEE.���
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5. You�acknowledge�that�the�Software�is�subject�to�U.S.��export�jurisdiction.��You�
agree�to�comply�with�all�applicable�international�and�national�laws�that�apply�to�
the�Software,�including�the�U.S.��Export�Administration�Regulations,�as�well�as�
end�user,�end�use,�and�destination�restrictions�issued�by�U.S.��and�other�
governments.���

6. You�may�transfer�your�copy�of�the�Software�to�two�different�computer�devices�
such�as�a�home�computer�and�an�office�computer.��However,�both�machines�
must�remain�under�your�control�and�the�licensed�copy�granted�to�you�herein�can�
only�be�used�by�you,�and�on�one�machine�at�a�time.��After�the�transfer,�and�in�the�
event�that�you�lose�control�of�one�of�the�devices�(such�as�the�sale�of,�or�
reassignment�of,�the�computer�device)�you�must�completely�remove�the�Software�
from�that�device.��However,�you�may�not�assign�this�Agreement�without�
Corastar�s�prior�written�consent.���

7. Without�prejudice�to�any�other�rights,�Corastar�may�terminate�this�Agreement�if�
you�fail�to�comply�with�the�terms�and�conditions�of�this�Agreement.��In�such�
event,�you�must�destroy�all�copies�of�the�Software�and�all�of�its�component�parts.��
This�license�is�effective�until�terminated.��You�may�terminate�it�by�destroying�the�
program�and�documentation�and�all�copies�thereof.���

8. Corastar�and�its�suppliers�provide�the�Software�AS�IS�AND�WITH�ALL�FAULTS,�
and�hereby�disclaim�all�warranties�and�conditions,�whether�express,�implied�or�
statutory,�including,�but�not�limited�to,�any�(if�any)�implied�warranties,�duties�or�
conditions�of�merchantability,�of�fitness�for�a�particular�purpose,�of�reliability�or�
availability,�of�accuracy�or�completeness�of�responses,�of�results,�of�workmanlike�
effort,�of�lack�of�viruses,�and�of�lack�of�negligence.��ALSO,�THERE�IS�NO�
WARRANTY�OR�CONDITION�OF�TITLE,�QUIET�ENJOYMENT,�QUIET�
POSSESSION,�CORRESPONDENCE�TO�DESCRIPTION�OR�NON�
INFRINGEMENT�WITH�REGARD�TO�THE�SOFTWARE.���

9. TO�THE�MAXIMUM�EXTENT�PERMITTED�BY�APPLICABLE�LAW,�IN�NO�
EVENT�SHALL�CORASTAR�OR�ITS�SUPPLIERS�BE�LIABLE�FOR�ANY�
SPECIAL,�INCIDENTAL,�PUNITIVE,�INDIRECT,�OR�CONSEQUENTIAL�
DAMAGES�WHATSOEVER�(INCLUDING,�BUT�NOT�LIMITED�TO,�DAMAGES�
FOR�LOSS�OF�PROFITS�OR�CONFIDENTIAL�OR�OTHER�INFORMATION,�
FOR�BUSINESS�INTERRUPTION,�FOR�PERSONAL�INJURY,�FOR�LOSS�OF�
PRIVACY,�FOR�FAILURE�TO�MEET�ANY�DUTY�INCLUDING�OF�GOOD�
FAITH�OR�OF�REASONABLE�CARE,�FOR�NEGLIGENCE,�AND�FOR�ANY�
OTHER�PECUNIARY�OR�OTHER�LOSS�WHATSOEVER)�ARISING�OUT�OF�OR�
IN�ANY�WAY�RELATED�TO�THE�USE�OF�OR�INABILITY�TO�USE�THE�
SOFTWARE,�THE�PROVISION�OF�OR�FAILURE�TO�PROVIDE�SUPPORT�OR�
OTHER�SERVICES,�INFORMATON,�SOFTWARE,�AND�RELATED�CONTENT�
THROUGH�THE�SOFTWARE�OR�OTHERWISE�ARISING�OUT�OF�THE�USE�OF�
THE�SOFTWARE,�OR�OTHERWISE�UNDER�OR�IN�CONNECTION�WITH�ANY�
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PROVISION�OF�THIS�AGREEMENT,�EVEN�IN�THE�EVENT�OF�THE�FAULT,�
TORT�(INCLUDING�NEGLIGENCE),�MISREPRESENTATION,�STRICT�
LIABILITY,�BREACH�OF�CONTRACT�OR�BREACH�OF�WARRANTY�OF�
CORASTAR�OR�ANY�SUPPLIER,�AND�EVEN�IF�CORASTAR�OR�ANY�
SUPPLIER�HAS�BEEN�ADVISED�OF�THE�POSSIBILITY�OF�SUCH�DAMAGES.���

IN�NO�EVENT�WILL�COMPANY�S�DIRECTORS,�OFFICERS,�EMPLOYEES,�OR�
AGENTS�(COLLECTIVELY��PERSONNEL�)�BE�LIABLE�TO�YOU�FOR�ANY�
CONSEQUENTIAL,�INCIDENTAL,�OR�INDIRECT�DAMAGES�(INCLUDING�
DAMAGES�FOR�LOSS�OF�BUSINESS�PROFITS,�BUSINESS�INTERRUPTION,�
LOSS�OF�BUSINESS�INFORMATION,�AND�THE�LIKE)�ARISING�OUT�OF�THE�
USE�OF,�OR�INABILITY�TO�USE,�THE�SOFTWARE�EVEN�IF�THE�PERSONNEL�
HAVE�BEEN�ADVISED�OF�THE�POSSIBILITY�OF�SUCH�DAMAGES.��
BECAUSE�SOME�STATES�DO�NOT�ALLOW�THE�EXCLUSION�OR�
LIMITATION�OF�LIABILITY�FOR�CONSEQUENTIAL�OR�INCIDENTAL�
DAMAGES,�THE�ABOVE�LIMITATIONS�MAY�NOT�APPLY�TO�YOU.���

IN�NO�EVENT�WILL�COMPANY�S�LICENSOR(S),�AND�THEIR�DIRECTORS,�
OFFICERS,�EMPLOYEES,�OR�AGENTS�(COLLECTIVELY��COMPANY�S�
LICENSOR�)�BE�LIABLE�TO�YOU�FOR�ANY�CONSEQUENTIAL,�INCIDENTAL,�
OR�INDIRECT�DAMAGES�(INCLUDING�DAMAGES�FOR�LOSS�OF�BUSINESS�
PROFITS,�BUSINESS�INTERRUPTION,�LOSS�OF�BUSINESS�INFORMATION,�
AND�THE�LIKE)�ARISING�OUT�OF�THE�USE�OF,�OR�INABILITY�TO�USE,�THE�
SOFTWARE�EVEN�IF�COMPANY�S�LICENSOR�HAS�BEEN�ADVISED�OF�THE�
POSSIBILITY�OF�SUCH�DAMAGES.��BECAUSE�SOME�STATES�DO�NOT�
ALLOW�THE�EXCLUSION�OR�LIMITATION�OF�LIABILITY�FOR�
CONSEQUENTIAL�OR�INCIDENTAL�DAMAGES,�THE�ABOVE�LIMITATIONS�
MAY�NOT�APPLY�TO�YOU.���

10. Notwithstanding�any�damages�that�you�might�incur�for�any�reason�whatsoever�
(including,�without�limitation,�all�damages�referenced�herein�and�all�direct�or�
general�damages�in�contract�or�anything�else),�the�entire�liability�of�Corastar�and�
any�of�its�suppliers�under�any�provision�of�this�Agreement�and�your�exclusive�
remedy�hereunder�shall�be�limited�to�the�amount�actually�paid�by�you�for�the�
Software.��The�foregoing�limitations,�exclusions�and�disclaimers�shall�apply�to�
the�maximum�extent�permitted�by�applicable�law,�even�if�any�remedy�fails�its�
essential�purpose.���

11. All�Software�provided�to�the�U.S.��Government�pursuant�to�solicitations�issued�
on�or�after�December�1,�1995�is�provided�with�the�commercial�license�rights�and�
restrictions�described�elsewhere�herein.��All�Software�provided�to�the�U.S.��
Government�pursuant�to�solicitations�issued�prior�to�December�1,�1995�is�
provided�with��Restricted�Rights��as�provided�for�in�FAR,�48�CFR�52.227�14��
(JUNE�1987)�or�DFAR,�48�CFR�252.227�7013�(OCT�1988),�as�applicable.���
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12. This�Agreement�is�governed�by�the�laws�of�the�state�of�Utah,�USA,�except�as�to�
copyright�and�trademark�matters,�which�are�covered�by�United�States�laws�and�
international�treaties.��This�License�Agreement�is�deemed�entered�into�at�St.��
George,�Utah.��This�License�Agreement�shall�inure�to�the�benefit�of�Corastar,�Inc.,�
its�successors,�administrators,�heirs�and�assigns.��This�Agreement�is�the�entire�
agreement�between�you�and�Corastar�relating�to�the�Software�and�supersedes�all�
prior�or�contemporaneous�oral�or�written�communications,�proposals�and�
representations�with�respect�to�the�Software�or�any�other�subject�matter�covered�
by�this�Agreement.���
If�any�provision�of�this�Agreement�is�held�to�be�void,�invalid,�unenforceable�or�
illegal,�the�other�provisions�shall�continue�in�full�force�and�effect.���

Legal Notices 

Software�developed�by�Creative�Dimension�Software�Ltd.���
Published�under�license�by�Corastar,�Inc.���

Copyright

Portions�Copyright�©�2006�Corastar,�Inc.,�Copyright�©�2005���2006,�Creative�
Dimension�Software�Ltd.��All�rights�reserved.���

No�parts�of�this�document,�either�in�full�or�in�part,�may�be�reproduced�or�transmitted�
in�any�form�or�by�any�means�without�the�prior�written�permission�of�the�publisher.���

Limited�portions�may�be�copyright�of�the�following�licensors:��
Adobe�Systems�Incorporated��
Apple�Computer�Inc.���
Microsoft�Inc.���
Sun�Micro�Systems�Inc.���

Disclaimer  

While�every�precaution�has�been�taken�in�the�preparation�of�this�document,�the�
publisher�assumes�no�responsibility�for�errors�or�omissions,�or�for�damages�resulting�
from�the�use�of�the�information�within�this�document.��The�publisher�reserves�the�
right�to�make�any�modification�to�this�document,�or�to�the�contents�of�this�document,�
at�any�time�without�notice.���

Limitations

Except�as�permitted�by�license,�no�part�of�this�manual�may�be�reproduced,�stored�in�a�
retrieval�system,�or�transmitted�in�any�form�or�by�any�means���electronic,�mechanical,�
or�otherwise���without�prior�written�permission�of�Corastar,�Inc.���

Files�provided�for�various�tutorial�examples�presented�in�this�manual�may�also�be�
protected�under�copyright�law.��The�unauthorized�use�of�such�artwork�or�images�in�
your�projects�could�be�a�violation�of�the�rights�of�the�authors.��Please�be�sure�to�obtain�
any�permission�required�from�such�authors.���
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Trademarks  

Strata,�Live�3D,�Foto�3D,�Strata�3D�CX,�Strata�3D,�Strata�3D�base,�Strata�3D�pro�,�
Raydiosity,�StudioPro,�Strata�DV,�Strata�FX,�Vision3d,�MediaPaint,�and�VideoShop�
are�trademarks�of�Corastar,�Inc.,�which�may�be�registered�in�some�jurisdictions.���

Adobe®,�Adobe�Photoshop®,�Adobe�Illustrator®,�ATM®,�Adobe�Acrobat®,�
Macromedia,�Flash�and�Macromedia�Flash�are�trademarks�of�Adobe�System�
Incorporated.���

Apple®,�Macintosh®,�Power�Macintosh,�QuickTime®,�and�QuickDraw�3D�are�
trademarks�of�Apple�Computer,�Inc.�

Windows®�is�a�trademark�of�Microsoft�Corporation.���

OpenGL�is�a�trademark�of�Silicon�Graphics,�Inc.���

3ds�max�and�3D�Studio�Max�are�trademarks�of�Autodesk,�Inc.���

Corel�and�Paint�Shop�Pro�are�trademarks�of�Corel�Software,�Inc.���

All�other�products�or�brands�are�trademarks�of�their�respective�holders.���

Restricted Uses

For�defense�agencies,�this�product�is�subject�to�use,�reproduction�and�disclosure�
restrictions�as�set�forth�in�sub�paragraph�(c)(1)(ii)�of�the�Right�in�Technical�Data�and�
Computer�Software�clause�at�252.227�7013.���

For�civilian�agencies,�this�product�is�subject�to�use,�reproduction�and�disclosure�
restrictions�set�forth�in�sub�paragraph�(a)�through�(d)�of�the�commercial�Computer�
Software�Restricted�Rights�clause�at�52.227�19�and�the�limitations�set�forth�in�Corastar,�
Inc.�s�standard�commercial�license�agreement�included�with�this�software.���

Unpublished�rights�reserved�under�copyright�laws�of�the�United�States.���

All�other�trademarks�and�registered�trademarks�are�trademarks�or�registered�
trademarks�of�their�respective�owner.���

Acknowledgements

The�JPEG�support�software�is�based�in�part�on�the�work�of�the�Independent�JPEG�
Group.���
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